Revision History:

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Purpose of Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>February 2008</td>
<td>4.6</td>
<td>GA release</td>
</tr>
<tr>
<td>March 31, 2008</td>
<td>4.6.0.1</td>
<td>Composite ODBC driver does support parameters in SQL prepared statements.</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Removing LDAP Users from Composite</td>
<td>96</td>
<td></td>
</tr>
<tr>
<td>Adding Users to Groups</td>
<td>97</td>
<td></td>
</tr>
<tr>
<td><strong>Chapter 5</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic Domain Administration</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>About Dynamic Domains</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Domain Administration</td>
<td>101</td>
<td></td>
</tr>
<tr>
<td>Enabling the Dynamic Domain</td>
<td>101</td>
<td></td>
</tr>
<tr>
<td>Group Administration</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>Granting Privileges to Dynamic Domain Users</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>User Administration</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>Adding Users to the Dynamic Domain</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>Removing Users from the Dynamic Domain</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Dynamic Users Group Membership</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td><strong>Chapter 6</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Monitoring with Composite Manager</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>About System Monitoring in Composite</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>Composite Manager Documentation</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>Studio Manager Documentation</td>
<td>110</td>
<td></td>
</tr>
<tr>
<td>Working with Composite Manager</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>Launching Composite Manager</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>Using Composite Manager</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Working with Studio Manager</td>
<td>119</td>
<td></td>
</tr>
<tr>
<td>Launching Studio Manager</td>
<td>119</td>
<td></td>
</tr>
<tr>
<td>Using Studio Manager</td>
<td>121</td>
<td></td>
</tr>
<tr>
<td>MANAGER HOME Page</td>
<td>126</td>
<td></td>
</tr>
<tr>
<td>SERVER INFO Panel</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>SERVER STATUS Panel</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>QUICK LINKS Panel</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>Composite Server Overview</td>
<td>132</td>
<td></td>
</tr>
<tr>
<td>Server Status Information</td>
<td>133</td>
<td></td>
</tr>
<tr>
<td>Session and Request Information</td>
<td>134</td>
<td></td>
</tr>
<tr>
<td>Privilege, User, and Repository Caches</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Server Status Indicators</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>Working with the SERVER OVERVIEW Page</td>
<td>138</td>
<td></td>
</tr>
<tr>
<td>Cached Resources</td>
<td>139</td>
<td></td>
</tr>
<tr>
<td>Working with the CACHED RESOURCES Page</td>
<td>140</td>
<td></td>
</tr>
<tr>
<td>The CACHED RESOURCES Table</td>
<td>140</td>
<td></td>
</tr>
<tr>
<td>Setting Up a MySQL Repository</td>
<td>298</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>System Requirements for Using MySQL with CIS</td>
<td>299</td>
<td></td>
</tr>
<tr>
<td>MySQL Version Support</td>
<td>299</td>
<td></td>
</tr>
<tr>
<td>MySQL Repository Size Recommendations</td>
<td>299</td>
<td></td>
</tr>
<tr>
<td>MySQL Repository Configuration Requirements</td>
<td>299</td>
<td></td>
</tr>
<tr>
<td>Configuring a MySQL Repository Database</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Configuring Composite Server for a MySQL Repository Database</td>
<td>301</td>
<td></td>
</tr>
</tbody>
</table>

**Appendix A**

<table>
<thead>
<tr>
<th>SNMP Traps</th>
<th>305</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP Log Settings in Composite Studio</td>
<td>306</td>
</tr>
<tr>
<td>SNMP Details</td>
<td>307</td>
</tr>
</tbody>
</table>

**Index** | 323 |
Administration Guide

This guide assumes that you are familiar with the concepts underlying Composite software and the software’s functionality as described in the CIS Getting Started Guide, a tutorial that illustrates a typical usage scenario. It also assumes that you are familiar with the information in the CIS User’s Guide which describes Composite Studio functionality and features.

Purpose

This book describes the administration concepts and tasks for Composite Information Server functionality and features. Composite Studio is the primary tool for modeling Composite resources for use with the Composite Information Server.

For information about Composite Manager, see the CIS Administration Guide.

Audience

This documentation is for information technology professionals who want to use Composite Studio to model data resources. Knowledge of relational data sources, hierarchical data sources, and data modeling is recommended.

Topics Covered

This book includes the following chapters.

Chapter 1, Post-Installation Tasks

Details licensing issues and JDBC / ODBC driver installation and configuration settings to support use of these drivers.

Chapter 2, CIS Configuration
An overview of the CIS configuration settings that affect Composite Information Server behavior. Settings changes may be useful for performance tuning and optimization in a production environment.

Chapter 3, Composite Domain Administration
Domain, Group, and User administration gives groups and users access to CIS defined resources. Discusses built-in users (anonymous, nobody, system, and admin) and their associated privileges. Discusses ownership and assignment of resources.

Chapter 4, LDAP Domain Administration
Describes use of LDAP directories for provisioning groups and users with rights and privileges.

Chapter 5, Dynamic Domain Administration
Describes dynamic domain support for the JDBC, ODBC, and Web service clients.

Chapter 6, System Monitoring with Composite Manager
Composite Manager enables run-time monitoring of system resources, cached resources, data resources, events, I/O, memory, requests, sessions, storage, transactions, triggers, and more.

Chapter 7, Utilities
Composite utilities enable backup, model and package export and import. Command line utilities to install, start, and stop services, and repository scripts to setup and change data source repositories.

Chapter 8, Setting Up an Oracle Repository
Chapter 9, Setting Up a Sybase Repository
Chapter 10, Setting Up a MySQL Repository
Appendix A, SNMP Traps
Links to event attributes and traps that can be used to monitor CIS activity.
**Product Documentation Set**

All the documents are available in PDF in the docs directory at the root level of the product installation directory, as in the following example for Windows:

\(\backslash\text{installation\_directory}\backslash\text{docs}\backslash\)

The following table lists the primary documents available for using the Composite Information Server (CIS):

**Table 1. Documentation Set for Composite Information Server Information Server (CIS)**

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Guide</strong></td>
<td>Provides instructions for installing Composite on Windows and UNIX systems.</td>
<td>In PDF</td>
</tr>
<tr>
<td><strong>Administration Guide (this manual)</strong></td>
<td>Provides instructions for administering Composite on Windows and UNIX systems.</td>
<td>In PDF</td>
</tr>
<tr>
<td><strong>Getting Started Guide</strong></td>
<td>Introduces the Composite software and provides quick steps for obtaining a unified view solution.</td>
<td>In PDF</td>
</tr>
<tr>
<td><strong>User’s Guide</strong></td>
<td>Describes how to use Composite Studio to work with data sources, build and publish resources, set up secure access, and maximize performance.</td>
<td>In PDF</td>
</tr>
<tr>
<td><strong>Reference Manual</strong></td>
<td>Contains reference information on the software technologies used in Composite. It is not a programming manual.</td>
<td>In PDF</td>
</tr>
<tr>
<td><strong>Help Topics</strong></td>
<td>Guides you through the Composite Studio UI and data modeling tasks.</td>
<td>On-line in Composite Studio</td>
</tr>
<tr>
<td><strong>Release Notes</strong></td>
<td>Provides updated information about the software.</td>
<td>Contact: <a href="mailto:support@compositesw.com">support@compositesw.com</a></td>
</tr>
</tbody>
</table>

Contact: support@compositesw.com
Getting Support

You can contact the Technical Support department at Composite Software, Inc. for assistance with using Composite products, filing bug reports, and submitting feature requests.

E-mail: support@compositesw.com

Before contacting Technical Support, be sure to have this information available:

- Type of request (help, bug report, or feature request)
- Product and current version
- Patch level
- Composite case number, if one has been assigned

For information about Composite Software, Inc. and its products, see www.compositesw.com.

Documentation Conventions

The following conventions are used in this manual:

Table 2. Documentation Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLUSTERS tab</td>
<td>Regular Arial typeface indicates text that appears in the user interface.</td>
</tr>
<tr>
<td>Enter</td>
<td>Bold type in Arial typeface indicates an action; a key to press, a button to click, or text to enter.</td>
</tr>
<tr>
<td>&lt;Value name or some description&gt;</td>
<td>Angle brackets indicate that a value must be provided to replace both the angle brackets and any textual description contained.</td>
</tr>
<tr>
<td>[Optional value name]</td>
<td>Square brackets indicate that an optional value may be provided replacing the brackets and any text, or it may be omitted entirely depending on the situation.</td>
</tr>
</tbody>
</table>
The pipe character is used to separate multiple options. Sometimes only a single value may be specified, but other times multiple options may be specified and the character is included in the specification.

Courier typeface indicates text that appears in a DOS window (on Windows) or UNIX terminal shell (UNIX). Courier typeface is also used for example code, pseudo code, code snippets, and literal inputs or values.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The pipe character is used to separate multiple options. Sometimes only a single value may be specified, but other times multiple options may be specified and the character is included in the specification.</td>
</tr>
<tr>
<td>-server</td>
<td>Courier typeface indicates text that appears in a DOS window (on Windows) or UNIX terminal shell (UNIX). Courier typeface is also used for example code, pseudo code, code snippets, and literal inputs or values.</td>
</tr>
</tbody>
</table>
Chapter 1

Post-Installation Tasks

This chapter describes some basic tasks that enable secure computing and client connections. These tasks must be performed sometime soon after installation of Composite Information Server before serious design and resources may be published.

The following topics are covered in this chapter:

- “Composite Information Server Licensing” on page 3
  Replace the temporary license installed by default with the Composite Information Server installation package with a valid license obtained from Composite Software.

- “SSL Management” on page 6
  Install a JKS or PKCS12 digital certificate for use with Composite.
  Note that this task does not need to be done immediately. However, it is strongly recommended that all CIS instances are configured with their own certificate prior to deployment with sensitive data.

- “Installing and Using Special JDBC Drivers” on page 8
  Make sure that you have installed the appropriate JDBC drivers for the relational data sources that you plan to use.
  You can use Composite’s JDBC driver (and edit it if necessary) or install a specific JDBC driver for your installation.

- “Configuring and Using the Composite ODBC Driver” on page 21
  Configure the Composite ODBC driver to connect with ODBC data sources and to receive connections from ODBC clients. If you installed the Composite Server ODBC Client with CIS then ODBC Client applications may utilize either a 64-bit or a 32-bit Composite driver to connect with CIS. The computer
on which the ODBC client application resides must be configured to use the Composite drivers to properly connect with CIS.

- “Configuring CIS for use of a JMS Broker” on page 31

By default CIS supports both Sonic and TIBCO JMS brokers, however some non-distributable JARs must be copied to the Composite installation directory from the JMS installation(s) that will be used.
Composite Information Server Licensing

Composite Information Server (CIS) and all associated Composite applications, options, tools, and services come with a default temporary license that can be used for a limited amount of time. To continue using Composite software, you must request a valid license from your Composite representative. Composite Software will then distribute your license via e-mail.

Adding a New License

Before the default license expires, you should install your new license as described here.

► To add a new license

1. Open Composite Studio, and select Administration > Launch Manager (Web) from the menu to open the Composite Manager Web interface.
2. Log in to Composite Manager.
3. Choose Licensing from the CONFIGURATION tab.
Composite Manager displays the LICENSE MANAGEMENT page.

4. Select the check box next to the product you are licensing and click the Add License(s) button.

5. In the Add a License window, copy/paste the license text you received from Composite and click OK.
Removing a License

You can remove an existing license as described here.

- To remove a license
  1. In Composite Manager, choose Licensing from the CONFIGURATION tab.
  2. Composite Manager displays the LICENSE MANAGEMENT page.
  3. Select the check box next to the product license that you want to remove and click the Remove License(s) button.
SSL Management

Composite Manager SSL Management page enables specification of the Java Key Store (JKS) used to initiate and establish SSL communications over both HTTPS ports used for secured web services and secured JDBC communications.

Viewing the SSL Management page using Composite Manager requires a user profile that has the Read All Resources right and change of any of the JKS digital certificate file location, type, or password requires the Modify All Resources right.

CIS ships with a generic JKS file so that development and testing of Web services and JDBC secured over HTTPS ports may proceed without need for immediate installation of a JKS file.

Composite Active Clusters also use certificate-based authentication. Communication between Composite Servers within an Active Cluster is secured using the X.509 digital certificate to identify and validate the source of the data transferred between each CIS instance in the cluster.

Best Practices Recommendation: It is strongly recommended that all CIS instances are configured with their own JKS certificate prior to deployment with sensitive data.

Obtain your JKS digital certificate(s) from a Certificate Authority (CA) or generate your own and install it using the Composite Server SSL Management page as outlined below.
To configure the Java keystore digital certificate for Composite

1. In Composite Manger, choose CONFIGURATION > SSL to display the SSL management page.

2. In the New Value column, enter the absolute path to the new JKS file (X.509 compliant certificate file) on the server and click APPLY.

   A dialog will warn that the new value will take effect only after server restart.
   Another prompt will notify of a successful change which then refreshes the page so that the new value just entered shows in the Value on Restart column.
   The REVERT button recovers the current value up until CIS restart makes the change more or less permanent.

3. Change the Java Keystore File Type and the Java Keystore Password values in the same way described above so that the values on server restart match the digital certificate being installed.

   CIS restart is required to apply the changes.
Installing and Using Special JDBC Drivers

The following relational data sources require additional JDBC drivers to enable Composite connection, introspection, and use.

- DB2 (type 2 and type 4) page 10
- DB2 (Mainframe) page 10
- Informix page 10
- Microsoft SQL Server page 11
- Netezza page 11
- Teradata page 12

These data source drivers must be installed separately from the Composite Software installation due to third party licensing restrictions.

You need to install the necessary driver(s) in the appropriate location(s) so that the Composite Server and the data source can interact. Each particular data source has a directory within the Composite installation directory which is specified below.

Composite ships with a JDBC interface and provides methods to connect to relational data sources that may not be formally supported. Custom jars may be
written to direct CIS to connect using the custom jar. Simply specify the JDBC driver and direct the server to upload it to the system.

One driver is sufficient to connect to any number of the same type of data sources. Once uploaded, the JDBC driver will function like any other JDBC driver, such as Oracle, SQL Server, or MySQL.

The Composite Server assumes that JDBC drivers conform to the JDBC 2.0 standard. The server does not make any accommodations for JDBC drivers that don’t supply correct metadata about the data source. The server does not retrieve result sets that are not consistent with the metadata supplied.
Obtaining Pre-Configured JDBC Drivers

This section describes how to obtain pre-configured JDBC drivers from specific locations for connecting to specific data sources.

▶ To obtain and install pre-configured JDBC drivers for DB2 v7 (Type 2 or Type 4) and DB2 v8 (Type 2 or Type 4)

1. Obtain db2java.zip for DB2 v7 or for DB2 v8 get db2jcc.jar, and put it (or them) in the CIS installation directory:
   \<installation directory>\apps\server\dlm\cis_ds_db2\lib
   The JDBC driver in db2java.zip is the same as the fix pack in DB2.
2. Restart the server.

▶ To obtain and install pre-configured JDBC driver for DB2 z/OS v8 (mainframe)

The driver for the mainframe DB2 z/OS v8 is the same as the driver for DB2 on UNIX.

1. Obtain db2jcc.jar and common.jar, and put them in the CIS installation directory:
   \<installation directory>\apps\server\dlm\cis_ds_db2_mainframe\lib
2. Restart the server.

▶ To obtain and install the pre-configured JDBC driver for Informix (9.x)

1. Visit the following URL, and download the appropriate driver version:
   IBM Software Downloads for Informix JDBC drivers
2. Obtain ifxjdbc.jar for Informix, and put it in the CIS installation directory:
   \<installation directory>\apps\server\dlm\cis_ds_informix\lib
3. Restart the server.
To obtain and install pre-configured **SQL Server 2000 JDBC Driver**

1. Visit the following URL: [SQL Server 2000 Driver for JDBC Service Pack 1](#)
2. Download the driver version for the appropriate platform.
3. Run the `setup.exe` installation program, and extract the following JAR files to some locally accessible folder: `msbase.jar`, `mssqlserver.jar`, and `msutil.jar`.
4. Put the JAR files in the Composite directory: `<installation_directory>/apps/server/dlm/cis_ds_mssql/lib`

---

To obtain and install the pre-configured **SQL Server 2005 JDBC Driver**

1. Visit the following URL, and download the driver version for the appropriate platform. You may need to scroll down the page to locate the links. [Microsoft SQL Server 2005 JDBC Driver 1.0](#)
2. Run the `setup.exe` installation program, and extract the `sqljdbc.jar` file to a local machine.
3. Put `sqljdbc.jar` in the following directory: `<installation_directory>/apps/server/dlm/cis_ds_mssql/lib`
4. Restart the server.

---

To obtain and install the pre-configured JDBC driver for **Netezza** (2.5 or 3.0)

You can obtain the JDBC driver for Netezza from the CDs that you received with the NFS system. Alternatively, you can contact the support group at Netezza to obtain the driver.

After obtaining the JDBC driver for Netezza (`nzjdbc.jar`), copy it to the Composite installation directory:

`<installation_directory>/apps/server/dlm/cis_ds_netezza/lib`
To obtain and install the pre-configured JDBC driver for Teradata

CIS is already pre-configured to utilize the drivers, but the drivers must be downloaded from Teradata and installed independently of our system.

1. Download the Teradata JDBC drivers which are packaged in a zip archive available for download here:
   Teradata Drivers and Connectivity Software TTU7.1 Windows i386

2. Extract and then add the following three drivers: tdgsconfig.jar, tdgsjava.jar, and terajdbc4.jar, to the Composite directory:
   <installation directory>/apps/dlm/cis_ds_teradata/lib

3. Restart CIS to initiate use of these new driver jars.

Connecting Through JDBC Drivers

The Composite Information Server connects to and introspects underlying data sources so that a virtual, integrated data layer may be created, selectively published, and queried as if the Composite Server were a single data source.

JDBC connection service requests are created and maintained between the end-user client applications and the Composite Server and from Composite Server to the underlying native data sources.

This administrative section describes the generic JDBC connection URLs between the Composite Server and the native data sources. The information could also be generally applied to the client-server JDBC connection, though the end-user JDBC client typically connects only to the Composite Server data source and not directly to the underlying data sources. There are exceptions such as test cases to specify additional attributes for complex transaction handling or to verify proper driver functionality.
Defining New Data Sources for Use with Composite Server

When the required data source driver is installed and ready for use, developers may create connections with the desired data sources using Composite Studio.

Define new data sources in the user home directory or in any appropriate shared Studio container. The JDBC driver connection URL is built dynamically according to a wizard driven configurator. The Add Physical Data Source wizard
enables selection of the data source driver to build the connection URL according to the URL format specifications of that driver class. Custom configurations, URL attribute additions, and implementation specific attributes may be set within the Add Physical Data Source configurator.

Each data source driver supports URL service requests with a specific binding format. The general JDBC connection URL format is:

```
jdbc:<jdbc-subprotocol>:[implementation specific URL attributes]
```

where, `<jdbc-sub-protocol>` identifies the JDBC implementation and typically identifies the JDBC driver vendor. The implementation specific URL attributes vary widely depending on the vendor data source and implementation specific configurations. A table listing the different data source driver JDBC URL formats and addressable driver class names is provided in “Sample JDBC Driver Connection URL Formats” on page 15.

**JDBC Driver Connection URL Format**

Knowing the connection URL format and driver class name also enables a direct connection to the underlying data source utilizing the drivers supported by the Composite Server. JDBC clients may connect directly with new data sources mediated by the Composite JDBC port.

The driver connection URL format is a template for data source definitions. It contains three literal strings:

```
<HOST>, <PORT>, and <DATABASE_NAME>
```

When you add a data source to Composite Server using this driver, the server substitutes the literals `<HOST>`, `<PORT>`, and `<DATABASE_NAME>` with the values you supply for the host name, port number, and database name respectively in the Add Physical Data Source window.

The complete syntax of the URL:

```
jdbc:compositesw:dbapi@<HOST>:<PORT>?domain=<domain>&dataSource=<DATASOURCE>[@&NAME=VALUE]*
```

where
HOST - valid host name or IP address
PORT - integer setting on which CIS and the host database will communicate
DOMAIN - user domain (composite is the default domain)
DATASOURCE - data source name

and zero or more optional NAME=VALUE pairs may be specified depending on
the target data source and driver. Refer to the next table to see the generic URL
format used by the Composite Server to connect to the data source.

Sample JDBC Driver Connection URL Formats

This table lists JDBC driver example URL formats and the corresponding driver
class names for Composite supported data sources.

<table>
<thead>
<tr>
<th>Database / Data Source</th>
<th>URL Format / Driver Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composite</td>
<td>jdbc:composite:dbapi@HOST:&lt;PORT&gt;?domain=&lt;DOMAIN&gt;&amp;datasource=&lt;DATABASE_NAME&gt;</td>
</tr>
<tr>
<td></td>
<td>Normally this is the only JDBC client connection used to establish client-server connections to CIS, where &quot;composite&quot; is the default &lt;DOMAIN&gt; value unless an LDAP or dynamic domain user is negotiating the connection.</td>
</tr>
<tr>
<td></td>
<td>Driver Name: cs.jdbc.driver.CompositeDriver</td>
</tr>
<tr>
<td>DataDirect Mainframe</td>
<td>jdbc:neon:;APP_NAME=;CATALOG_PREFIX=;DBTY=&lt;DBMS_TYPE&gt;;HOST=HOST;PORT=PORT;SUBSYS=&lt;DATABASE_NAME&gt;;TRLT=NO;DTFM=ODBC</td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.neon.jdbc.Driver</td>
</tr>
<tr>
<td>DB2 v7 (type_2)</td>
<td>jdbc:db2:&lt;DATABASE_NAME&gt;</td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.ibm.db2.jdbc.app.DB2Driver</td>
</tr>
<tr>
<td>DB2 v7 (type_4)</td>
<td>jdbc:DB2://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DATABASE_NAME&gt;</td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.ibm.db2.jdbc.net.DB2Driver</td>
</tr>
</tbody>
</table>
## Table 3. JDBC Driver URL Format and Name

<table>
<thead>
<tr>
<th>Database / Data Source</th>
<th>URL Format / Driver Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 v8 (type_2)</td>
<td>jdbc:db2:&lt;DATABASE_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.ibm.db2.jdbc.DB2Driver</td>
<td></td>
</tr>
<tr>
<td>DB2 v8 (type_4)</td>
<td>jdbc:db2://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DATABASE_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.ibm.db2.jdbc.DB2Driver</td>
<td></td>
</tr>
<tr>
<td>DB2 z/os v8 (type_4)</td>
<td>jdbc:db2://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DATABASE_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.ibm.db2.jdbc.DB2Driver</td>
<td></td>
</tr>
<tr>
<td>Informix</td>
<td>jdbc:informix-sqli://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DATABASE_NAME&gt;; informixserver=Informix instance name; user=&lt;user_name&gt;;password=&lt;password&gt;</td>
<td>The <code>informixserver</code> variable is the name of the Informix instance, and not the server host name, and <code>&lt;user_name&gt;</code> and <code>&lt;password&gt;</code> are recognized by the Informix server.</td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.informix.jdbc.IfxDriver</td>
<td></td>
</tr>
<tr>
<td>MySQL 3.x, 4.0, 4.1</td>
<td>jdbc:mysql://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DATABASE_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.mysql.jdbc.Driver</td>
<td></td>
</tr>
<tr>
<td>Netezza 2.5 and 3.0</td>
<td>jdbc:netezza://&lt;HOST&gt;:&lt;PORT&gt;/&lt;DATABASE_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: org.netezza.Driver</td>
<td></td>
</tr>
<tr>
<td>Oracle (thin) 8i, 9i, and 10g</td>
<td>jdbc:oracle:thin@$HOST:&lt;PORT&gt;/&lt;DATABASE_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: oracle.jdbc.driver.OracleDriver</td>
<td></td>
</tr>
<tr>
<td>Oracle type2 (OCI) 8i, 9i, and 10g</td>
<td>jdbc:oracle:oci:@&lt;DATABASE_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: oracle.jdbc.OracleDriver</td>
<td></td>
</tr>
<tr>
<td>SQL Server</td>
<td>jdbc:microsoft.sqlserver://&lt;HOST&gt;:&lt;PORT&gt;;databaseName=&lt;DATABASE_NAME&gt;;SelectMethod=&lt;SELECT_MODE&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Driver Name: com.microsoft.jdbc.sqlserver.SQLServerDriver</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1  Post-Installation Tasks

Adding, Editing, and Removing JDBC Drivers

Composite lets you install your own JDBC driver on the server. You can also edit or remove the driver you create.

**Note** You can only edit or remove user-installed drivers.

- **To add a new JDBC driver**

  The data source wizard lets you add your own JDBC driver to the Composite metadata environment. So, first you need to open the data source wizard if it’s not already opened.

  1. Right-click at an appropriate location in the resource tree, and select New Data Source.
2. In the Add Physical Data Source window, click the New Driver button.

![New Driver Information](image)

3. In the New Driver Information window, provide the driver information in the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>User-defined name for the driver. Type the name. This is a user-defined name for the driver. After adding it to the server, this name will be listed along with other data source drivers listed on the first window of the Add Physical Data Source wizard.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the JDBC driver. Accept Jdbc.</td>
</tr>
<tr>
<td>Jar File</td>
<td>Click the Browse button to locate the JAR file(s) where the driver class is stored. You can also type the name (with path) in the Jar File field. You can only upload a JDBC driver JAR file that is visible to Composite Server. For example: <code>&lt;CIS installation directory&gt;/apps/jdbc/lib&lt;jar_file&gt;</code></td>
</tr>
<tr>
<td>Driver Class Name</td>
<td>Fully-qualified name of the driver class. For example: <code>oracle.jdbc.driver.OracleDriver</code></td>
</tr>
</tbody>
</table>
Post-Installation Tasks

Composite Information Server 19 Administration Guide 4.6 Rev. 1

Note

JDBC drivers are installed in their respective directory, as described in the beginning of the section “Installing and Using Special JDBC Drivers” on page 8. For example, DB2 driver JAR files (db2java.zip for DB2 v7 or db2jcc.jar for DB2 v8) are installed in the following directory:

<CIS installation directory>/apps/dlm/ds_db2/lib/

4. Click OK.

When the driver is added successfully, its name is displayed along with other data source drivers in the first window of the Add Physical Data Source window. You can use this driver to add JDBC type data sources to the server.

To edit a Composite JDBC driver

You can only edit user-installed drivers. You cannot edit other drivers.

1. Open the data source wizard.

2. In the Select Data Source Driver section, select the user-installed driver whose details you want to edit.

3. Click the Edit Driver... button.

4. In the editing window, make the necessary changes, and click OK.

   Use the Browse button to locate the JAR file(s) if the location of the file(s) has changed. For example, DB2 driver JAR files are installed in the following directory:

   <CIS installation directory>/apps/dlm/ds_db2/lib/

To remove a data source driver

You can only remove user-installed drivers.

1. Open the data source wizard.
2. In the Select Data Source Driver section, select the driver which you want to remove.

3. Click the Delete Driver... button.
Configuring and Using the Composite ODBC Driver

If the option to install the ODBC driver is specified during the Composite software installation process, the driver is installed.

Using the ODBC Driver on Windows

The rest of this section covers the following topics:

- “Adding ODBC Data Sources on Windows” on page 21
- “Overriding the Configured Settings” on page 24
- “Code Sample for Connecting to Composite Server” on page 25
- “Supported/Non-Supported Features” on page 26

Adding ODBC Data Sources on Windows

The native Windows driver managers are supported by Composite.

To add an ODBC data source to a Windows machine

1. Run the ODBC Data Source Administrator from the Windows Control Panel by choosing Administrative Tools > Data Sources (ODBC).
Windows displays the ODBC Data Source Administrator.

2. Select the User DSN tab or the System DSN tab.
   A User DSN is accessible only to the current user. A System DSN is accessible to all the users on the system and requires special permission to create and modify.

3. Click the Add button.

4. In the Create New Data Source screen, select the Composite <version> driver, and click Finish.
Windows displays the Driver Configuration window for the selected version.

5. In the Driver Configuration window, enter the following information that is required for configuring the driver:

- **DSN Name**: Name of the data source to which the clients will refer. Once a DSN is created, its name cannot be changed.
- **Composite Host**: Server name (or IP address) on which CIS is running.
Use the Refresh button to retrieve the Catalogs available to this user on the server.

7. Use the Test button to test the settings in the configuration dialog box.

8. Click OK.

The configured settings you entered are saved, and the data source is added to your machine.

**Overriding the Configured Settings**

A client connecting to Composite Server through the ODBC driver can override the configured settings on a data source by adding the appropriate parameters in the connection string.

For example, the following connection string is valid with Composite Server:

```
DSN=<value>;UID=<value>;PWD=<value>;DOMAIN=<value>;HOST=<value>;PORT=<value>;DATASOURCE=<value>;CATALOG=<value>
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name, Password, and Domain</td>
<td>Must be valid within Composite Server. The Password is nullable.</td>
</tr>
<tr>
<td>Datasource</td>
<td>Name of the Composite data source that the ODBC connection will access. This entry sets the default scope of client queries to a particular datasource. Note that querying outside the scope of this data source requires super-qualified tables or stored procedures.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Connects with default data-source catalog.</td>
</tr>
</tbody>
</table>
Note that for these parameters:

- The original DSN value cannot be overridden.
- Upon creation of a DSN, you are prompted for a PWD entry.
- HOST is the host name where Composite Server is running.
- CATALOG is optional.

## Code Sample for Connecting to Composite Server

Here is a sample Visual Basic for Applications (VBA) Script for connecting to Composite Server from a Microsoft client (such as Excel) through ADO. The line rendered in **bold** type renders the connection string.

```vba
Sub demo()
    On Error Resume Next
    Err.Clear
    dsn = "DS-Composite"
    Set conn = CreateObject("ADODB.Connection")
    conn.Open "DSN=" & dsn
    If Err.Number <> 0 Then
        ' process error
        Exit Sub
    End If
    Err.Clear
    Set rs = CreateObject("ADODB.Recordset")
    rs.Open "SELECT * FROM CUSTOMER", conn
    If Err.Number <> 0 Then
        ' process error
        Exit Sub
    End If
    ' get column names
    For Each Column In rs.fields
        colname = Column.Name
        Next
    ' get first 100 rows
    Count = 0
    maxcount = 100
```
Err.Clear
Do While Not rs.EOF And Err.Number = 0 And Count < maxcount
  Count = Count + 1
  For Each Record In rs.fields
    colvalue = Record.Value
  Next
  rs.movenext
Loop
End Sub

**Supported/Non-Supported Features**

The Composite ODBC driver supports the following features:

- **Data types:** CHAR, VARCHAR, SHORT, LONG, DOUBLE, FLOAT, TIME, DATE, TIMESTAMP
  - Conversions (indicated by “->” below):
    - CHAR, VARCHAR -> VARCHAR
    - BIT, TINYINT, SMALLINT -> SMALLINT
    - BIGINT, INT -> INT
    - DECIMAL, REAL, FLOAT, NUMERIC -> FLOAT
  - All other types are converted to VARCHAR.

**Known Issue**

SQL parameters of a given length submitted in a prepared statement are assigned a data type of CHAR with the actual character length of the parameter submitted. If the parameter is a wild card of unknown length, then the parameter is defined with a data type of VARCHAR (255). The Composite ODBC driver actually supports retrieval of parameters with values longer than 255 characters if the client provides adequate memory for the task.
Using the ODBC Driver on UNIX and Linux

Make sure that you know the following details:

- **To install the ODBC driver at anytime after server installation**: Log into the installation machine as the same user that installed Composite Server, and the driver.
- **To configure the ODBC driver**: Make sure that you have Read and Write permissions on the following files, which are at the top level of the installation directory:
  
  - \(\text{composite<version>.xml}\)
  - \(\text{odbc.ini}\)
  - \(\text{odbcinst.ini}\)

  The configuration is done by an interactive utility, `driverConfig`, which is in the \(<\text{CIS installation directory}>/\text{apps/odbc}<\text{platform}>/\text{bin}\).
- **Creating a DSN** is done through the configuration utility `driverConfig`, which helps users to reconfigure the driver files (in case, file-location is changed after installation), and create, edit, list, or delete DSN entries.

The rest of this section describes the following tasks for using the ODBC driver on UNIX:

- **Setting the Environment Variables**, next
- **“Creating a DSN with driverConfig” **on page 29

**Setting the Environment Variables**

1. Log into the installation machine as the same user that installed the Composite software.
2. Set the following environment variables:

   - `COMPOSITE_HOME`
     
     Location where the driver is installed. This is the full path to the top-level installation directory for Composite Server.
   - `COMPOSITE_DSN_XML`
This is an optional variable. It allows you to specify an alternate location for the composite DSN (Data Source Name) configuration file, so different users on the same UNIX machine can have different sets of DSNs configured. It is the full path to the ODBC DSN configuration file for Composite Server. The DSN defaults to the following value, but it can be configured using the driverConfig utility:

$COMPOSITE_HOME/composite<version>.xml

ODBCINI

Full path to the configuration file odbc.ini, which is generated during creation of DSN configuration with driverConfig should be:

<CIS installation_directory>/odbc.ini

odbc.ini defines the DSN entries.

ODBCINSTINI

Full path to the configuration file odbcinst.ini, which is generated during DSN configuration with driverConfig should be:

<CIS installation_directory>/odbcinst.ini

odbcinst.ini defines the ODBC drivers.

LD_LIBRARY_PATH

This is specific to Solaris-based machines and Linux-based machines. This path refers to the location of the iODBC driver manager files. The default location is:

<CIS installation_directory>/apps/odbc/lib

LIBPATH

This is specific to AIX-based machines. This path refers to the location of the iODBC driver manager files. The default location is:

<CIS installation_directory>/apps/odbc/lib

SHLIB_PATH

This is specific to HP-UX-based machines. This path refers to the location of the iODBC driver manager files. The default location is:

<CIS installation_directory>/apps/odbc/lib
Creating a DSN with driverConfig

This section describes how to create a DSN by running the driverConfig utility program on a UNIX platform.

The configuration tool driverConfig is located at:

$COMPOSITE_HOME/apps/odbc/<platform>/bin

Run driverConfig with the command:

driverConfig

A sample interaction between the system and user is given below:

Composite Software [version] ODBC Driver

Main Menu
0  Exit this utility
1 Configure ODBC administrator
2 View configuration and DSNs on this system
3 Create/edit a DSN
Enter command> 3

---------

Create/edit a DSN
0  Return to main menu
1  Create a DSN
2  Edit an existing DSN
3  Delete an existing DSN
Enter command> 1

Enter DSN name
> testdsn
Enter driver [~/home/.../odbc/lib/libcomposite37.so]
> 
Enter host [localhost]
> 
Enter port [9401]  (This is the default port setting)
> 
Enter user
> admin
Enter password
> admin
Enter domain
> composite
Enter datasource
> ds
Enter catalog
> cat

Keep this information?
[tstdsn]
Driver = /home/.../odbc/lib/libcomposite37.so
host = localhost
port = 9401
uid = admin
password = admin
domain = composite
datasource = ds
catalog = cat
Enter [y]es or [n]o > y
• The details for the newly created DSN are saved.
Configuring CIS for use of a JMS Broker

JMS provides a way to publish asynchronous message-based web services. By default the installation of CIS supports both Sonic and TIBCO JMS brokers, but a few drivers must be copied from the JMS broker installation to the installed directory of CIS in order to properly connect the two servers.

To enable communications between CIS and the JMS broker several compiled library files, jars, will have to be copied to the Composite Server installation directory and then the Composite Server will have to be restarted.

**To enable CIS connection with TIBCO JMS**

Find and copy `tibjms.jar` from the TIBCO installation and paste that file into the following directory:

```
<installation dir>/apps/server/lib
```

Restart the Composite Server.

**To enable CIS connection with Sonic JMS**

Find and copy `mfcontext.jar` and the nine other jar files in that same directory with filenames that begin with the prefix of "sonic_". Paste them all into the following directory:

```
<installation dir>/apps/server/lib
```

Restart the Composite Server.

Configuration of the JMS Broker

Create and Configure a Queue and Queue Connection Factory

For either JMS broker, if you haven’t already, configure your JMS broker according to the respective manufacturer’s instructions.

1. Create a suitable Queue Connection Factory (QCF)
2. Create a suitable Queue
3. Register the Queue Connection Factory and the Queue with the JNDI
Chapter 1  Post-Installation Tasks

Note Due to release limitations, direct connections to JMS providers are not currently supported. Connection to JMS via JNDI is currently supported by CIS 4.6. CIS 4.6 also only supports queues and not JMS topic connection factories.

Direct connection to JMS brokers and publishing and subscription to JMS topic connection factories are planned for future releases.
Add JMS Connectors to the Composite Server

Connectors must be configured for use by the Composite Server. Use Composite Manager to create connectors so that the Composite Server may publish data services by way of JMS via JNDI after the JMS Broker has been configured.

1. Launch Composite Manager:
   a. When in front of the server hosting CIS, use the default localhost URL:
      http://localhost:9400/manager/#home
   b. Remotely - http://[Host]:[BasePort]/manager/#home
   c. From the Composite Studio enter Ctrl-M or from the Administration menu select Launch Manger (Web)...
   d. Log in to the Composite Manager using an Administrative profile.

2. Open the CONNECTOR MANAGEMENT page from the Composite Manager CONFIGURATION tab > Connectors selection.

3. Add a Connector using the provided button. The Add a JMS via JNDI Connector window is displayed. Publishing directly to JMS is not currently supported.
Almost all fields in the Add a JMS via JNDI Connector window must have some value for the Connector to function properly. Many of the fields do have defaults.

4. Enter values in the fields displayed by the **Info** tab.

**Connector Name** - convenient, identifier label for the connector

**Group Name** - connectors that share an identical group name share a common connection pool. Connector grouping has failover connection pooling because the connection pool is shared. If a connector instance fails other connectors in the group will be able to send and receive messages using the same connection pool.

**Annotation** - (optional) adds notes on the JNDI connector. Annotations will be visible on the Connector Management page.

5. Enter values in the fields displayed by the **JMS via JNDI** tab.

**Initial Context Factory** - Sonic and TIBCO context factories are supported by default, but other context factories may be supported. Other JMS compliant brokers and their respective JNDI context factories may be used to connect with CIS. Refer to the documentation of your particular JMS broker for specifics on what is needed to support a JNDI initial context factory. The JNDI initial context factory is usually the class name.

Type "c" to see the default, suggested string values that may be used with Sonic JMS and TIBCO JMS as values for the initial context factories.
Chapter 1  Post-Installation Tasks

For Sonic:  com.sonicsw.jndi.mfcontext.MFContextFactory
For TIBCO:  com.tibco.tibjms.naming.TibjmsInitialContextFactory

**JNDI Provider URL** - URL for connection with the JNDI. TCP protocol is generally used. TIBCO default port is 7222, and Sonic default port is 2506. Make sure the appropriate port in the firewall is opened to allow connections with the JNDI provider.

**JNDI User** and **JNDI Password** - JMS JNDI user profile must have sufficient permissions to look up JMS destinations. Passwords are not stored in clear text.

**JMS Client ID** - (optional) name the CIS connections with the JMS broker

**Queue Connection Factory** - JMS topics are not supported in the 4.6 release

6. Enter values for additional name-value pairs on the **JNDI Properties** tab.

JNDI Properties tab enables specification of additional name value pairs.

Click the plus button to add name value pairs.

In particular, Sonic requires specification of a "Domain" name, while TIBCO does not require further specification.

7. Enter values for additional name-value pairs on the **Pool** tab.

The Pool tab enables specification of the connection thread timeout and pool size parameters. The default values will be generally adequate for development needs.

**Pool Timeout** - specifies the maximum waiting time (in seconds) for a new connection. If a connection is not provided within the pool timeout period specified, then a check is made for an available connection using the proper user and uses that, or if that is not available then the least recently used connection for some other user is dropped and a new connection for the required user is opened.

**Minimum Pool Size** - the number of connections that should remain in the connection pool even when the pool becomes inactive.

The connection pool is initially empty. When there is a need to connect to JMS via JNDI, the pool creates one connection based on the information provided in the Info panel. Connections remain available even when there is no activity because
the time to negotiate new connections can add a significant amount to the query response time.

If the JMS connection pool has been inactive for a while, the connector pool size will start to shrink based upon the connection inactivity. The Pool Minimum Size specifies the minimum number of connections to remain in the pool, to maintain a minimum number of available connections.

**Maximum Pool Size** - the number of connections (both active and idle) allowed to burden the data source. When the connection pool limit is reached new incoming requests must wait until the next connection is made available.

The connection pool is initially empty. When there is a need to connect to the data source, the pool creates a connection based on the information provided in the Info panel. As making new connections can take some time and resources, these connections remain available even if they become idle.

Connectors with identical group names will share the same pool of connections.

For more information on publishing Composite Data Services to JMS queues refer to the *CIS User's Guide* chapter on Publishing Resources. The section on Publishing services using a SOAP/JMS binding is most relevant.
Chapter 2

CIS Configuration

This chapter introduces some of the configuration tasks you can perform to track information and control CIS behavior.

The following topics are covered in this chapter:

- “About CIS Configuration” on page 38
- “The Configuration Window” on page 39
- “Fine Tuning Memory” on page 44
- “Case Sensitivity” on page 47
- “Case Sensitivity and Trailing Spaces Mismatches” on page 47
- “Dealing with Settings Mismatches” on page 50
- “Trailing Spaces” on page 52
About CIS Configuration

The Composite Information Server is a complex and versatile platform. Its primary user interface tool, Composite Studio, provides a large number of configuration parameters that display configuration settings, usage data, and allow administrator modification of CIS settings and behavior. Usually none of the configuration settings require modification for development environments, but certain settings enable optimal CIS implementation for various production settings.

This chapter describes the Configuration window in Composite Studio which you use to change the configuration settings for the server, data sources, and query output data display. It also describes “Fine Tuning Memory” on page 44, and “Case Sensitivity” on page 47.

The next section describes the rights and privileges that are necessary to configure CIS.

Configuration Rights and Privileges

All Composite Studio users (users with the Access Tools right) may display the CIS Configuration panel from the Studio > Administration menu.

Display of all parameters in the CIS Configuration panel requires both the Access Tools right and the Read All Config right. If a different set of rights are held by the user, then only an appropriate subset of the available parameters will be visible as read-only settings.

Modification of CIS configuration parameters requires the Modify All Config right in addition to the Access Tools right.
The Configuration Window

The Configuration window provides access to all CIS configuration parameters. You access the Configuration window in Composite Studio by selecting Administration > Configuration.

The configuration parameters are grouped into three main categories: Composite Server, Data Sources, and Studio. When you open the subfolders in each category and select a parameter indicated by the icon, Composite Studio displays the
current configuration setting for that parameter along with a description in the right pane as shown here:

![Configuration parameters screenshot]

The configuration parameters, grouped by type, are listed in the following table.

**Table 4. Configuration Parameters**

<table>
<thead>
<tr>
<th>Folder</th>
<th>Configuration Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composite Server</td>
<td></td>
</tr>
<tr>
<td>API &gt; Protocol</td>
<td>Current and supported API protocol versions</td>
</tr>
<tr>
<td>Communications</td>
<td>DN, Java Keystore file and settings</td>
</tr>
<tr>
<td>Folder</td>
<td>Configuration Parameters</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration</td>
<td>Clustering, Repository, Debug, E-mail, Files, Hooks, General Info (host name, IP, version,...), License, Metadata (change log, cache sizes, purge thresholds), Monitor settings, Network (HTTPS hostname verification, FTP, HTTP, and HTTPS proxy settings), Security (Anonymous and Dynamic logins), and transaction logging</td>
</tr>
<tr>
<td>Events and Logging</td>
<td>Storage conditions, Event Generation (Cache, Data Source, Request, Resource, Session, Storage, System Overview, Transaction and Trigger events), and Logging (custom logger, database logger, file logger, memory, and SNMP settings)</td>
</tr>
<tr>
<td>JDBC and ODBC Drivers</td>
<td>Client communications settings, data fetch default, requests and session time-outs</td>
</tr>
<tr>
<td>Memory</td>
<td>Java heap (current and total available memory), managed memory settings, maximum memory for a request</td>
</tr>
<tr>
<td>Runtime Processing Information</td>
<td>I/O samples, Repository (Privilege, Resource, and User cache usage), Requests tracking, Sessions, Storage, Transactions, Triggers, and Wait Queue settings</td>
</tr>
<tr>
<td>SQL Engine</td>
<td>Cardinality, Query Plan, Prepared Statement, and Runtime Stats caches, Case Sensitivity, Ignore Trailing Spaces, Logging for resource usage, and query statistics, SQL optimization settings, and overrides</td>
</tr>
<tr>
<td>Web Services Interface</td>
<td>Base URI, HTTP, TCP/IP Base Port, HTTPS, logging, and validation settings</td>
</tr>
<tr>
<td>Data Sources</td>
<td></td>
</tr>
<tr>
<td>Common to Multiple Sources</td>
<td>Commit row limit, default execution timeout</td>
</tr>
<tr>
<td>Delimited File Sources</td>
<td>Create file back-ups, max value length</td>
</tr>
<tr>
<td>LDAP Sources</td>
<td>Default character column size</td>
</tr>
</tbody>
</table>
All parameters, whether read-only or configurable, have a type and a description that make their function and purpose clear. Read-only parameter values are grayed out and labeled “(Current).” If the value may be changed with the associated parameter is appropriately labeled: “(On Server Restart).” Those parameters that require CIS restart to take effect are clearly marked in the parameter description.

Locally defined CIS configuration settings are assumed to be individually set for the local computing environment, therefore they are not replaced or replicated when the server instance becomes part of a cluster and they are not exported or imported when the CIS instance is backed up or restored. These non-replicating configuration settings are clearly marked as such in the description of that parameter. Refer to the Composite Active Cluster Installation and Administration Guide for more information.

By default CIS is optimized for a typical development environment where an individual or a moderately sized team work together to prepare prototypes for test and later for a production deployment. Some CIS configuration settings should be assessed prior to test and production deployment so that performance for a particular implementation environment is optimal. Please refer to the CIS Best Practices Guidelines - Production Server Configuration document which is available from Composite Support for recommendations on optimized settings.

### Table 4. Configuration Parameters

<table>
<thead>
<tr>
<th>Folder</th>
<th>Configuration Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Sources</td>
<td>Introspection of all objects, table limit for introspections</td>
</tr>
<tr>
<td>Transformations</td>
<td>Defaults for binary and character column sizes, decimal precision, scale and stream buffer sizes</td>
</tr>
<tr>
<td>XML File Sources</td>
<td>Floppy drive introspection</td>
</tr>
<tr>
<td>XML HTTP Sources</td>
<td>Input parameter size</td>
</tr>
<tr>
<td>Studio</td>
<td></td>
</tr>
<tr>
<td>Data</td>
<td>Cursor fetch limit, fetch row size, and XML text size</td>
</tr>
<tr>
<td>Locking</td>
<td>Requires resource lock for any modification done within Studio</td>
</tr>
</tbody>
</table>

Composite Information Server Administration Guide 4.6 Rev. 1
Some changes may be undone with the Revert button which will reset a parameter value to the previous value before a recently made change.

Before you change your CIS configuration settings on the following, please review the other topics in this chapter.
Fine Tuning Memory

If you want to change the default memory setting, (512 MB), use the Configuration window (Administration > Configuration menu option) in Composite Studio, and navigate to Memory (Configuration > Composite Information Server Components > Composite Server > Memory). You can modify the settings for Java heap.

Consider the following to determine the configuration for optimal memory:

- Queries run faster with more memory. So, giving the server as much memory as possible is highly desirable.
- However, giving the server too much memory can cause excessive paging (see Paging,) which can degrade performance significantly.

Paging

Paging occurs if the total amount of memory of all the running applications exceeds the amount of physical memory. In this situation, the operating system temporarily moves parts of the running applications onto the disk so that the applications won’t crash when memory is exhausted. When a paged-out memory location is accessed, the operating system will restore that area of memory from disk and then, to make room, move some other part of memory to disk. Consequently, what should be a simple memory access becomes two disk operations and performance suffers. Some amount of paging is fine on the client side. But on the server, where things are a lot more controlled and optimal performance is desired, paging must be minimized.
Determining Memory Usage

To know the total memory available on Windows 2000, open the Task Manager window, and click the Performance tab in the Task Manager.
In the preceding screen, the MEM Usage meter shows how much memory is being used. If that number is bigger than the amount of physical memory, it means that you're paging.

To know the total memory available on Windows XP, open the Task Manager window, and click the Performance tab in the Task Manager. The following screenshot of the Windows XP Task Manager illustrates the memory usage.
The PF Usage meter in the preceding screen shows how much memory is being used. If that number is bigger than the amount of physical memory, it means that you’re paging.

**Case Sensitivity**

By default CIS is set to be **not** case sensitive. While the SQL specification encourages the use of case-sensitive string comparison, many databases default to a non-case sensitive comparison. Getting the correct results from a query requires knowledge of which type of comparison is used. For example, the test (`'abc' = 'ABC'`) returns **FALSE** for a case sensitive comparison and **TRUE** for a non-case sensitive comparison.

Changing the case sensitivity setting might impact existing queries, in that the results they return may be changed or performance may be affected.

**Case Sensitivity and Trailing Spaces Mismatches**

Case sensitivity and trailing space mismatches are often encountered in enterprise environments with many different database systems. CIS’s primary goal in this regard is to ensure reproducible and accurate results. However, there is often a trade-off with slower performance in certain cases when CIS must query databases with different case sensitivity or trailing spaces settings.

With CIS, case sensitivity and trailing spaces mismatches only occur under the following conditions:

- There is a mismatch between CIS and the underlying data source’s case sensitivity and/or trailing spaces settings.
- There is a WHERE clause with a CHAR or VARCHAR in the clause.

It should be noted here that CIS, like database management systems, necessarily provides a contract to the clients regarding case sensitivity and trailing spaces. CIS has a unique position within the enterprise in that it must deal with databases that have “conflicting” settings in this regard. CIS handles this by always following the convention configured in the Administration > Configuration menu.
This section documents how these settings may be overridden on a query by query basis; however, this practice should be considered very carefully to avoid providing queries to clients that could produce unexpected results. Consider the following example.

A client submits a simple SQL statement such as:

```
SELECT v1.balance FROM accounts v1 WHERE v1.account_name = 'bob'
```

The client is aware of what case sensitivity it wants to use. If it submits this to a case sensitive database, then it expects to only get accounts with exactly 'bob' as the name. If it submits this to a case insensitive database, it expects to get accounts with 'bob', 'BOB', and 'Bob'. If the client knows the database is case sensitive and it wants an insensitive compare then it would submit:

```
WHERE UPPER(v1.account_name) = UPPER('bob')
```

The same is true of CIS. However, in the case where CIS is not case sensitive and the underlying database is case sensitive, CIS will add the UPPER function to the SQL sent to the underlying database to insure CIS’s contract with the client is maintained. Unfortunately, doing this will invalidate an existing index—in the previous example, the index on account_name would be invalidated, causing a table scan.

### Determining Whether Settings Are Affecting Query Performance

To determine if the CIS settings are affecting query performance, you can evaluate any filter nodes or the SQL underlying each FETCH node in the Execution Plan in Studio to determine if case sensitivity or trailing spaces settings are impacting the query. Focus primarily on the WHERE clause or any filter nodes.

One of the two major issues that can come up is that some string comparisons in the WHERE clause have RTRIM or UPPER functions applied to them which is manifested in the FETCH node. The issue with this is that wrapping a column with a function like UPPER or RTRIM will prevent the underlying system from using an index on that column. This is necessary to provide correct results, but it creates
a trade-off situation with performance. Suddenly a quick lookup through an index becomes a full table scan.

The other issue that arises with string comparisons has to do with filters being applied at the CIS level instead of at the database level. If a filter is applied in CIS, it means that all rows must be returned from the underlying table which could be a huge performance bottleneck on large tables.

Review the following matrix to determine the possible impact of different case sensitivity and trailing spaces settings:

<table>
<thead>
<tr>
<th>CIS Setting</th>
<th>Underlying Data Source Setting</th>
<th>CIS Query Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>case_sensitivity=true</td>
<td>case_sensitivity=true</td>
<td>None</td>
</tr>
<tr>
<td>case_sensitivity=true</td>
<td>case_sensitivity=false</td>
<td>Performs WHERE clause string comparison in CIS instead of pushing down to database.</td>
</tr>
<tr>
<td>case_sensitivity=false</td>
<td>case_sensitivity=true</td>
<td>Adds UPPER to both sides</td>
</tr>
<tr>
<td>case_sensitivity=false</td>
<td>case_sensitivity=false</td>
<td>None</td>
</tr>
<tr>
<td>ignore_trailing_spaces=true</td>
<td>ignore_trailing_spaces=true</td>
<td>None</td>
</tr>
<tr>
<td>ignore_trailing_spaces=true</td>
<td>ignore_trailing_spaces=false</td>
<td>Add RTRIM to both sides</td>
</tr>
<tr>
<td>ignore_trailing_spaces=false</td>
<td>ignore_trailing_spaces=true</td>
<td>Performs WHERE clause string comparison in CIS instead of pushing down to database.</td>
</tr>
<tr>
<td>ignore_trailing_spaces=false</td>
<td>ignore_trailing_spaces=false</td>
<td>None</td>
</tr>
</tbody>
</table>

The Composite query engine is designed to get the “correct” and consistent answer regardless of the configurations of the underlying data sources. If you find an RTRIM in the WHERE clause, it is because CIS is configured with a contract to ignore trailing spaces while the underlying data source does not ignore them. Likewise if you find an UPPER, it means that CIS is configured to ignore case while the underlying database is sensitive to case.
This situation may be avoidable where there are data sources with conflicting settings. If all underlying data sources have the same settings in this regard, it is strongly recommended that CIS be set to the same exact case sensitivity and trailing spaces settings. If this is possible, the developer need not worry about this issue.

**Dealing with Settings Mismatches**

There are two ways to deal with settings mismatches. First, the system wide configuration values for case sensitivity and trailing spaces can be modified via the Administration/Configuration menu. This is only useful if the data sources are fairly homogeneous in regard to this behavior. Changes to this setting should be well-considered or avoided as they will cause all other query plans to be re-evaluated to accommodate the new setting.

Second and more “dangerous” with respect to affecting consistent results, if the data sources have varying policies for case sensitivity and/or trailing spaces, these values can be modified on a per-query basis by using SQL query options. This facility is useful when numerous types of data sources are used with varying case-sensitivity and/or trailing space settings.

**Warning!** These query hints should be used with an understanding that the global contract provided by CIS is overridden. It must be communicated to clients querying this published resource that the contractual behavior has been overridden.

In the previous example, the developer would use this syntax immediately after the SELECT keyword:

```sql
{option ignore_trailing_spaces="false",
  case_sensitive="true"}
```

Here is the same query after setting “case_sensitive” to “true” (note there are no longer RTRIMS in the SQL sent to the database). Composite Policy
Impact on String Comparison

The case-sensitive policy affects all forms of string comparison. The impacted functions and operators include:

- Comparison operators in WHERE and JOIN ON: = < <= >= > <>
- REPLACE(src, pattern, escape)
  The pattern is matched according to the policy.
- MIN(column)
  The strings ‘ABC’ and ‘abc’ are considered the same, so either may be chosen by this function.
- MAX(column)
  The strings ‘ABC’ and ‘abc’ are considered the same, so either may be chosen by this function.
- GROUP BY
  The strings ‘ABC’ and ‘abc’ are considered the same, so the group will include both sets of values.
- ORDER BY
  The strings ‘ABC’ and ‘abc’ are considered the same, so they will sort together and may be intermixed.

Case sensitivity does not affect the actual value of strings. Case is preserved in all cases. It only affects the comparison between strings.

Impact on Server Performance

Performance may be impacted by the choice of policy. Composite Server makes every attempt to run as much of the query as possible in the underlying database. This is always possible when the Composite policy is set to match the underlying database’s policy, but when the policies are different, some portions of the query may be executed in Composite Server instead of in the database.
Whenever possible, you should match the policy of Composite Server to that of the underlying database. If this is not desirable because you want to present a different policy, or because there are multiple underlying databases with different policies, the following performance guidelines apply:

- If Composite Server is **case sensitive** and the database is **not**, comparisons can only be pushed to the database if the data is known to be in upper case for both values or in lower case for both values. You can force this condition by wrapping values in `UPPER()` or `LOWER()` functions.

- If Composite Server is **non-case sensitive** and the database is **case sensitive**, and the data is not known to be in upper case for both values or in lower case for both values, Composite Server will add an `UPPER()` function to both values to ensure the underlying database performs a non-case sensitive comparison. This should have little impact on performance.

### Trailing Spaces

Most databases perform string comparisons while ignoring any spaces at the end of the string values. For example, the test (`'abc' = 'abc'`) is **TRUE**. Some databases do make use of trailing spaces, so this test would return **FALSE**.

### Composite Policy

Composite’s default policy is to **ignore** trailing spaces. Changing the policy may have an effect on existing queries, in that the results they return may be changed or performance may be affected.

Composite 1.7 defaulted to **not ignore** policy, so upgrading to later versions of Composite may affect query results. If this is a concern, you should change the policy to **not ignore**.

### Impact on String Comparison

The trailing spaces policy affects all forms of string comparison. The impacted functions and operators include:

- Comparison operators in **WHERE** and **JOIN ON**: `= < <= > >= <>`
The string length returned does not count trailing spaces.

- **MIN(column)**
  - The strings 'abc ' and 'abc' are considered the same, so either may be chosen by this function.

- **MAX(column)**
  - The strings 'abc ' and 'abc' are considered the same, so either may be chosen by this function.

- **GROUP BY**
  - The strings 'abc ' and 'abc' are considered the same, so the group will include both sets of values.

- **ORDER BY**
  - The strings 'abc ' and 'abc' are considered the same, so they will sort together and may be intermixed.

The trailing spaces policy does **not** affect the actual value of strings. Trailing spaces are preserved in all cases. It only affects the comparison between strings.

### Impact on Server Performance

Performance may be impacted by the choice of policy. Composite Server makes every attempt to run as much of the query as possible in the underlying database. This is always possible when the Composite policy is set to match the database’s policy, but when the policies are different, some portions of the query may be executed in Composite Server instead of in the database.

Whenever possible, you should match the policy of the server to that of the underlying database. If this is not desirable because you want to present a different policy or because there are multiple underlying databases with different policies, the following performance guidelines apply:

- If Composite Server **ignores** trailing spaces and the database **does not**, comparisons can only be pushed to the database if the data is known to be
without trailing spaces for both values. You can force this condition by
wrapping values in TRIM() or RTRIM() functions.

- If Composite Server does not ignore trailing spaces and the database ignores
  trailing spaces, and the data is not known to be without trailing spaces for both
  values, the server will add an RTRIM() function to both values to ensure the
  underlying database performs a ignore trailing spaces compare. This should
  not impact server performance.

**Studio Locking**

When the Studio Configuration setting: Studio > Locking > Enabled is set to true,
Studio users are forced to acquire a lock prior to changing a resource. Studio
resource locking is enforced by Composite Studio. The Composite Server web
services API does not honor this Studio Configuration setting.

Changing the Composite Server configuration requires the Modify All Config and of
course the Access Tools rights.

From Studio, open the Configuration window from the Administration menu.

1. Go to Studio > Locking at the bottom of the configuration window and set the
   value of Enabled to “True”.

2. Apply the changes and click OK.

This Composite Studio configuration change is not immediately propagated to
other open instances of Studio connected with this server, but any attempt to save
resources will force a check to see whether the Studio Lock is enabled.

The requirement for Studio resource locking prior to changing and saving
resources may be disabled for the entire server by any administrator with the
Modify All Resources right. Disable Studio Locking by toggling of the value of
Enabled to “False”.

Existing locks will persist regardless of whether Studio is requiring locks prior to
modification. When Studio locking is disabled users may still optionally use
resource locks so that simultaneous changes are not made to a resource being
revised by more than one person at a time.
Chapter 3

Composite Domain Administration

Composite supports the composite, dynamic, and LDAP domains, each of which controls a particular set of users and groups that can access CIS. This chapter describes the composite domain and how to create and manage its users and groups.

The following topics are covered in this chapter:

- “About the Composite Domain” on page 56
- “Domain Management” on page 57
- “Group Management” on page 58
- “User Management” on page 61
- “Changing a Password” on page 67
- “Changing Ownership of Resources” on page 68
- “Manage User and Group Privileges” on page 71

Configuration and management of the LDAP and dynamic domains are documented in the following chapters:

- Chapter 4—“LDAP Domain Administration” on page 73
- Chapter 5—“Dynamic Domain Administration” on page 99
About the Composite Domain

The composite domain comprises users and groups defined within Composite to access CIS. Composite has predefined specific users and groups in the composite domain which you can use and modify as appropriate. You can create additional users and groups within the composite domain to meet your specific needs.

Administration of the composite domain involves creating new users and groups, changing user passwords, and granting privileges to users and groups to access the resources in Composite.

The main tool used to manage domain users and groups is Composite Manager. You can access Composite Manager in two ways:

- From Composite Studio, choose Administration > Launch Manager.
- From a web browser using one of these URLs:
  - http://localhost:9400/manager (when CIS is locally installed)
  - http://[CIS_HostName]:[PortNumber-Default9400]/manager

The USERS page in Composite Manager is where you manage users and groups in the composite domain as well as in the LDAP and dynamic domains.
Domain Management

Domain management entails adding and removing domains and the users and groups assigned to a domain. Two domains—composite and dynamic—are already defined for use when CIS is installed. The Composite Manager DOMAIN MANAGEMENT page lists the defined domains and provides links to view the groups and users within those respective domains.

The DOMAIN MANAGEMENT page is used primarily for the specification of LDAP domains and for the selection and deselection of those external groups that will have rights and privileges to view and use Composite defined resources.

Domain management for LDAP domain configurations are described in the next chapter “LDAP Domain Administration” on page 73. For more information on dynamic domain administration refer to the chapter: “Dynamic Domain Administration” on page 99.
**Group Management**

You can create groups of users who need similar rights to perform administrative tasks on the server, and groups who need access to Composite tools to create, view, access, and change objects defined with Composite Studio. Developers, operations personnel, and administrators should each have their own groups to access Composite Manager and other Composite tools and options.


As an example, end users should belong to groups with no group rights. Typically end users are not allowed to change data source definitions, change server configuration settings, or back up servers. End users simply use JDBC, ODBC, or web service-enabled applications to trigger data requests and procedure calls that get executed in the background without further user interaction or need for additional rights.

**Built-in Groups**

There are three built-in groups—admin, all (composite), and all (dynamic)—which are created by the system and cannot be deleted.

**admin (composite)** - This group has administrative privileges. The admin user is a system-provided member of this group. Other users can be added to or removed from this group by anyone with administrative privileges.

**all (composite)** - This group contains all users except for the following: anonymous, nobody, system, and users of the dynamic domain. User membership is automatically maintained by the system.

**all (dynamic)** - This group contains all users in the dynamic domain.
Adding Groups to the Composite Domain

You can add any number of groups to the composite domain. When you add a group, you define the rights for that group. After you’ve created a group, you can add users to it.

To add a group to the composite domain

1. Launch Composite Manager from Composite Studio using Administration > Launch Manager or direct a web browser to the Composite Manager using one of these URLs:
   - http://localhost:9400/manager (when CIS is locally installed)
   - http://[CIS_HostName]:[PortNumber-Default9400]/manager
   After login, the MANAGER HOME page is displayed.
2. From the USERS tab, choose Group Management.
3. Click the Add Group button.
4. In the Add a Group window, enter the name for the new group.
5. Select the group rights template that is most appropriate for the new group. Customize the rights as required. Refer to the User Guide description of “Group and User Rights Templates,” for more information on the rights and what they will allow.
6. Add notes in the Annotation field to help developers identify the users, usage, and rights associated with the group. This will help with the setting of permissions on new resources and other future administration. Click OK. The group is added to the GROUP MANAGEMENT page.

Removing Groups

Administrators with the Modify All Users and the Access Tools rights may remove groups from the composite domain. Removing a group deletes any associated rights and privileges from group members.

Composite users who were members of a deleted group might still have the rights and privileges that were associated with that group. If this is the case, the rights...
and privileges are present because of membership in other groups or the rights and
privileges were explicitly assigned directly to the user.

**Note** Deletion of a composite domain group does not remove its member users
from the CIS.

► **Removing a group from the composite domain**

1. In Composite Manager, choose USERS > Group Management.
2. Select one or more groups using the check box and delete them with the
   Remove Groups button.
3. Accept the confirmation prompt and the group is deleted.

Removing LDAP groups does nothing to LDAP configurations and definitions,
but it does remove LDAP users and any group associated rights and privileges
from the Composite system.

► **Removing an externally defined LDAP group**

1. In Composite Manager, choose USERS > Domain Management.
2. Select the LDAP domain using the left most column radio button and then
   click the Edit External Groups button/link.
User Management

User administration involves adding a user to the domain, removing a user from the domain, adding users to a group, removing users from a group, and changing passwords.

Built-in Users and Their Privileges

The composite domain has the following users that are automatically created:
admin, anonymous, nobody, and system. These users are permanent in the system and cannot be removed.

- **admin** - This user has privileges to access and use any resource in the system. admin can also grant/revoke privileges to other users. The admin user cannot be removed from the system. The admin user has a home folder (/users/admin).
- **anonymous** - This user is provided for anonymous login for JDBC clients and Web service clients. By default, anonymous logins are disabled. anonymous users must be explicitly given privileges to access Composite resources. Refer to the section below.
- **nobody** - This user cannot log in or be removed. Abandoned resources owned previously by a user that no longer exists in the system are given to nobody.
- **system** - This user cannot log in or be removed. It owns items that even the users with administrative privileges cannot modify.

Members of the all group, meaning all composite users and all dynamic users, (and excluding nobody), have Read privileges for all folders created with the installation. Newly created folders and resources do not include privileges for members of the all group. Privileges must be assigned by the creator/owner of the resource, or by an administrator or user explicitly given the Grant right on that object.

All semi-editable folders (for example, /shared, /services/databases, /services/webservices) have no privileges but they are editable.

All pre-created tables/procedures have SELECT and EXECUTE privileges for the all groups (in the composite and dynamic domains) and the anonymous user in
composite (for example: /services/databases/system, /services/webservices/system, /lib).

- By default anonymous users cannot invoke any Web services. To make Web services available to anonymous users, grant the Read privilege to /services/webservices, then grant Read to the both the data service, service, and the port that you want the anonymous user to access and use.

- anonymous users cannot connect to the server using JDBC because no Composite data service of the type database is automatically available. To enable them, you should grant Read privileges to services/databases, the data service, and any catalogs or schemas that you want to make available.

- Resources in the Composite Data Services area point to the resources in the work area. In order to access a resource in the Composite Data Services area, the anonymous user needs permission to read all the folders above that item and have appropriate permission (such as SELECT, INSERT, UPDATE, DELETE, or EXECUTE) on the item to which the resource points.

In order to expose a resource to either Web services or JDBC clients, you should grant the Read privilege to all the folders above the resource and the appropriate permission to the resource itself. If the resource uses other resources, then you have to repeat the process with those resources as well.

This is similar to what you would do for any other user, except that some folders have the Read privilege by default for the all group and you need to override those folders.

The anonymous user is denied any access to the /users folder and admin cannot change it. This means that all published resources you want anonymous to use must reside in the /shared folder.

**Adding Users to the Composite Domain**

Composite administrators with the Modify All Users and Modify All Resources rights can add users to the composite domain.
To add a user to the composite domain

1. Launch Composite Manager from Composite Studio using Administration > Launch Manager or direct a web browser to the Composite Manager using one of these URLs:

   - `http://localhost:9400/manager` (when CIS is locally installed)
   - `http://[CIS_HostName]:[PortNumber-Default9400]/manager`

   After login, the MANAGER HOME page is displayed.

2. From the USERS tab, choose User Management.

3. Click Add User and the Add a User window is displayed.

4. Enter the new user name and password with a confirmation entry for the password.

   The user name is the login name for the user and can only contain alphanumeric characters and the underscore character.

   The password must be at least six characters long and it may have selected symbols and upper case alphanumeric characters. The following are some examples of valid passwords:

   - `joe-./:;<=>?@[\]^_`~` (all valid punctuation characters)
   - `123_joe`
   - `l23Abcd+23`
   - `!#$%&[]^+` (more valid punctuation characters)

5. Select a base template to begin rights assignment and select or deselect rights as appropriate for the local security policy and the expected level of user interaction with the CIS server and underlying data sources.

6. Enter notes in the Annotation field to give future administrators an indication of the user’s role in the system or organization. Click OK.

   The newly added user name is added to the composite domain.

Note: LDAP users are managed entirely by the LDAP server. Composite simply adds the LDAP domain and selected groups. Members of those groups inherit Composite rights and privileges for tools and resources from the
rights and privileges assigned to the group from the Manager Group page and resources.

**Removing Users from the Composite Domain**

Removing a user from the composite domain removes the user from CIS.

**To remove a user from the composite domain**

1. Launch Composite Manager from Composite Studio using Administration > Launch Manager or direct a web browser to the Composite Manager using one of these URLs:
   - http://localhost:9400/manager (when CIS is locally installed)
   - http://[CIS_HostName]:[PortNumber-Default9400]/manager
   After login, the MANAGER HOME page is displayed.
2. From the USERS tab, choose User Management.
3. Select check box to the left of the each user to be removed from the domain and click Remove User(s).
4. Confirm that you wish to delete the users and the user or users are removed from Composite Server.

**Note** Removing a user who is derived from an LDAP domain/group does not prohibit the user from logging into the system again. See "Removing LDAP Users from Composite" on page 96 for more information.

**Managing Group Membership**

A group must exist in the composite domain before you can try to add a user to that group. See Adding Groups to the Composite Domain for the details.
To add or remove a user to or from a group in the Composite domain

1. Launch Composite Manager from Composite Studio using Administration > Launch Manager or direct a web browser to the Composite Manager using one of these URLs:
   - http://localhost:9400/manager (when CIS is locally installed)
   - http://[CIS_HostName]:[PortNumber-Default9400]/manager

   After login, the MANAGER HOME page is displayed.
2. From the USERS tab, choose User Management.
3. Select the link in the # Groups column for the desired user.

   The Edit the User's Group Membership window is displayed.
4. Select/deselect the desired groups in which the user will be a member and click OK.

   All rights and privileges are inherited by group definition and user membership in that group. If a user belongs to multiple groups, no special rights and privileges are gained from having duplicate rights and privileges.

   If a user is added to the group named admin, it means that this user obtains administrative privileges in Composite. In order to use the new privileges as an administrator, the user has to log out and re-log into the Studio.

View Group Membership

Composite Manager displays the groups in which a selected user belongs, and it also provides filtering to see all the members of a single selected group.

To view a user’s group membership in the composite domain

1. Using Composite Manager, choose User Management from the USERS tab.
2. If the user belongs to a single group, it is displayed in the Groups column listing for that user. Otherwise expand the Groups column listing with a click on the expander icon and the list of groups is shown.
To view a group’s membership

1. Using Composite Manager, choose Group Management from the USERS tab.
2. Select the link in the # Users column for the group of interest. The users in that group are then listed on the USER MANAGEMENT page using the appropriate group filter.

Alternatively, go directly to the USER MANAGEMENT page and use the Domain and Group filters as shown to select the group of interest.
Changing a Password

Composite administrators with the Modify All Users and Modify All Resources rights can also change any composite user password, whereas non-admin Composite domain users with access to Studio (by Access Tools right) may only change their own passwords.

▶ Changing your own password in Studio

1. Select File > Change Password from the menu bar.
2. In the Change Password window, type your old password in the Old Password field.
3. Type the new password in the New Password field.
4. Retype the new password in the Confirm Password field.
5. Click OK.

▶ Changing a user’s password (or setting explicit user rights)

1. From Studio, launch Composite Manager using the Administration menu option, or direct a Web browser to the Manager interface. The default Manager Web page on the local server is:
   http://localhost:9400/manager
   After login the Manager Home page is displayed.
2. Go to the USERS > User Management page.
3. Select any user name link and the resulting window allows reset of that user’s password and also enables assignment or retraction of rights.

Note Changes made to the user rights profile take effect nearly immediately as CIS checks for appropriate rights every time feature access is attempted.
Changing Ownership of Resources

The administrator can change the ownership of resources one by one or as a group of resources within a container resource.

Abandoned resources owned previously by a user that no longer exists in the system are re-assigned to the nobody user. The nobody user cannot log in or be removed. The administrator can use the change ownership feature available in Composite Studio to change the ownership from nobody to some valid user. Also, if there becomes a need to change the ownership of resources from one regular user to another, the change ownership feature is useful.

To change the ownership of a resource

1. In the resource tree, first select the resource to change its ownership and then select the Administration > Change Owner of <resource> menu option.

   Or, you can right-click at the resource name and select the Change Resource Owner menu option.
Chapter 3  Composite Domain Administration

The current owner’s user name and domain are displayed, and a list of new owners with their user names and domains is presented.

**Note** Ownership cannot be changed for system-owned resources or home folders.

2. Select a new owner’s user name from the User drop-down list.

3. Optionally, check the Apply the change recursively check box. The Apply the change recursively check box is checked by default if the selected resource is a container. This box is unchecked for leaf resources. It is checked and disabled if the owner cannot be changed or if the resource is a physical data source. All resources within a physical data source and the data source itself are always owned by one user.

The Apply the change recursively check box is enabled when the resource is not in one’s home folder, as shown in the next screen.

4. To selectively change the ownership, select the Change if the current owner is box.

Resources within a container may have more than one owner, so this specification is useful and will avoid un-intended transfers.
5. Click OK to see the list of resources ready to be transferred to the new owner as shown here:

![Commit Resource Owner Changes]

Ownership of the following resources is ready to be transferred to “nobody” of the “composite” domain. Press “Commit” to apply the change. Or, press “Cancel” to go back and specify a different owner.

- Shared
- [shared]/examples
- [shared]/examples/CompositeView
- [shared]/examples/inventory/transactions
- [shared]/examples/LookupProduct
- [shared]/examples/NewOrder
- [shared]/examples/NavSales
- [shared]/examples/NavSupplier

22 resource(s) will be modified when the change is committed.

6. View the list of resources and click Commit if the list is acceptable, or click Cancel to return to the previous window and make a different selection. Clicking Commit will change the ownership of resources as specified.
Manage User and Group Privileges

Resource developers, owners, and users delegated Grant privilege on a resource may also set resource specific privileges for that object. Composite administrators with Modify All Users or Modify All Resources privileges may also review, set, and revoke privileges for any resources and define rights for any groups and users in CIS.

Management of user and group privileges on resources is generally best left to the developer who created and owns the resource, providing access for a security audit by an administrator at any time. It is more efficient to let the resource developers and owners set privileges for the native sources that they define, configure, and manage from within CIS.

To facilitate decentralized management of specific resource privileges it is helpful to define groups of users with similar and well-defined roles where possible. Group assignment of privileges on the resource is encouraged for any large deployment.

Refer to the “Privileges” section in the Security chapter in the CIS User’s Guide for many more details on access privileges.
Chapter 4

LDAP Domain Administration

Composite supports the following types of domains: composite, LDAP, and dynamic. This chapter focuses on how to configure and administer LDAP domains for use with Composite.

The following topics are covered in this chapter:
- “About the LDAP Domain” on page 74
- “Configuring LDAP Properties File” on page 75
- “Domain Administration” on page 85
- “LDAP User Management” on page 95
About the LDAP Domain

CIS can leverage enterprise LDAP implementations of Active Directory and iPlanet domains, groups, and users to authorize views and use, creation and management of Composite defined resources. Currently supported LDAP authentication servers are:
- iPlanet 5.1 sp2
- Windows Server 2003 Active Directory

Composite configuration and management for use of LDAP domains requires the Read and Modify All Users rights in addition to the Access Tools right to give the administrator the ability to create and modify domains, groups, and users. Those rights also enable specification and modification of rights given to LDAP groups and users.

Manager also enables quick configuration and provisioning of LDAP (Active Directory and iPlanet) domains, groups, and users with rights and privileges enabling use, view, and change of Composite defined resources. LDAP configurations and usage are described in the next chapter.
Configuring LDAP Properties File

Query searches for retrieving user and group information are controlled by a properties file (ldap.properties) in the installation. This properties file is in the following directory:

\(<\text{CIS\_installation\_directory}/\text{conf/server/ldap.properties}\)

The file ldap.properties contains relevant query parameters for the two supported LDAP directory servers (Active Directory and iPlanet).

If you add LDAP domains to Composite Server, you should configure the ldap.properties file after a successful installation.

**Note** For CIS Active Cluster, custom configurations of the ldap.properties file are not copied to other CIS instances in a clustered environment. The ldap.properties file is not automatically synchronized with other machines in the cluster. Each server is considered LDAP independent unless you manually copy these files to all members of the cluster.

This section describes the structure of the LDAP properties file and also gives an example of the default LDAP properties file.

**Structure of the LDAP Properties File**

The LDAP properties file (ldap.properties) has four sections which are described below using these conventions:

- TYPE must be replaced with either “iplanet” or “activedirectory”.
- Property file variables are designated with a capital letter enclosed by angled brackets: <A>, <B>,... <X>.
- A description of each line in the ldap.properties file is provided.

**Section 1: (used for querying all users)**

TYPE.all.users.search.context=<A>

Search-context used to find all users.

TYPE.all.users.filter=<B>
Filter to pass to a query for finding all users.

TYPE.all.users.username.attribute=<C>

Username attribute to retrieve the name of user found from a query.

TYPE.all.users.search.timeout=<D>

Search timeout value to limit the time for infinite search. 0 (zero) means infinite timeout, timeout is in milliseconds and should be greater than 0 (zero).

Section 2: (used for querying all groups)

TYPE.all.groups.search.context=<A>

Search-context used to find all groups.

TYPE.all.groups.filter=<B>

Filter to pass to a query for finding all groups.

TYPE.all.groups.groupname.attribute=<C>

Group name attribute to retrieve the name of a group found from a query.

TYPE.all.groups.search.timeout=<D>

Search timeout value to limit the time for infinite search. 0 (zero) means infinite timeout, timeout is in milliseconds and should be greater than 0 (zero).

Section 3: (used for authenticating LDAP users)

TYPE.user.username.comparison.is.case.sensitive=<A>

Sets the user name comparison to be case-sensitive or not. By default the value of <A> is “true” but it may be set to “false”.

TYPE.user.search.context=<B>

Search-context used to find the user attempting authentication.

TYPE.user.filter=<C>

Filter used to authenticate user in LDAP directory server. The “USERNAME” keyword will be replaced at runtime with the appropriate username.

TYPE.user.username.attribute=<D>
User name attribute to retrieve the name of the user attempting authentication from a query.

**TYPE.user.search.timeout**

Search timeout value to limit the time for infinite searches. 0 (zero) means infinite timeout, timeout is in milliseconds and should be greater than 0 (zero).

### Section 4: (used for querying all groups for a user)

**TYPE.user.groups.search.context**

Search-context used to find all the groups for a user.

**TYPE.user.groups.filter**

Filter to pass to a query for finding the members of a group. The “USERDN” keyword will be replaced at runtime with the appropriate user distinguished name.

**TYPE.user.groups.groupname.attribute**

Group name attribute for finding the name of a group to which a user belongs.

**TYPE.user.groups.search.timeout**

Search timeout value to limit the time for infinite searches. 0 (zero) means infinite timeout, timeout is in milliseconds and should be greater than 0 (zero).

### Example of an ldap.properties File

This section presents an example of the operational lines in the default ldap.properties file. Following the file is a key for the symbols and attributes that can be used in an ldap.properties file.

```plaintext
iplanet.all.users.search.context=ou=people
iplanet.all.users.filter=(& (objectclass=person))
iplanet.all.users.username.attribute=uid
iplanet.all.users.search.timeout=0

iplanet.all.groups.search.context=ou=groups
iplanet.all.groups.filter=(& (objectclass=groupofuniquenames))
```
iplanet.all.groups.groupname.attribute=cn
iplanet.all.groups.search.timeout=0

iplanet.user.username.comparison.is.case.sensitive=true
iplanet.user.search.context=ou=people
iplanet.user.filter=(uid=USERNAME) (objectclass=person)
iplanet.user.username.attribute=uid
iplanet.user.search.timeout=1000

iplanet.user.groups.search.context=ou=groups
iplanet.user.groups.filter=(uniquemember=USERDN) (objectclass=groupofuniquenames)
iplanet.user.groups.groupname.attribute=cn
iplanet.user.groups.search.timeout=1000

activedirectory.all.users.search.context=cn=users
activedirectory.all.users.filter=(objectclass=user)
activedirectory.all.users.username.attribute=samaccountname
activedirectory.all.users.search.timeout=0

activedirectory.all.groups.search.context=cn=users
activedirectory.all.groups.filter=(objectclass=group)
activedirectory.all.groups.groupname.attribute=cn
activedirectory.all.groups.search.timeout=0

activedirectory.user.username.comparison.is.case.sensitive=true
activedirectory.user.search.context=cn=users
activedirectory.user.filter=(samaccountname=USERNAME) (objectclass=user)
activedirectory.user.username.attribute=samaccountname
activedirectory.user.search.timeout=1000
LDAP Properties File Symbols and Attributes

The following symbols can be used in an ldap.properties file.

**LDAP Search Context Symbols**
- The pipe character may be used to separate multiple search context property values. This may be interpreted as a disjunction: "or".

**LDAP Search Filter Symbols**
- Conjunction (i.e. **and** - all in the list must be true)
- Disjunction (i.e. **or** - one or more alternatives must be true)
- Negation (i.e. **not** - item being negated must not be true)
- Equality (that is according to the matching rule of the attribute)
- Approximate equality (according to the matching rule of the attribute)
- Greater than (according to the matching rule of the attribute)
- Less than (according to the matching rule of the attribute)
- Presence (i.e. the entry must have the attribute returning whatever that value is)
- Wildcard (indicates zero or more characters can occur in the position); used when specifying attribute values to match
- Escape (for escaping "^", "(" , ")" when they occur inside of an attribute value)
LDAP Attribute Key

- o = Organization
- ou = Organization Unit
- cn = Common Name
- dn = Distinguished Name
- dc = Domain Component

Query Examples

This section shows example iPlanet or Active Directory LDAP server query examples. The iPlanet or Active Directory LDAP server configurations are similar except where the object class values, search contexts, and user/group attribute values may be different where:

TYPE = { iplanet | activedirectory }

Search for specific groups with a group filter

All group filters can use the search filter syntax described above in the above “Search Filter Syntax” area.

Example: Find all groups that have a prefix “cs_*” in their name where “Y” is a group object class for the domain type, and “Z” is a group name attribute:

Example solution:

TYPE.all.groups.filter=(&(objectclass=Y)(Z=cs_*))

Note This same method can be used for finding specific users also.

Specify multiple locations to find users or groups

All search context attributes can support looking for LDAP objects in multiple search contexts. Use the “|” character to separate multiple search contexts.

TYPE.*.search.context=CONTEXT_1|CONTEXT_2|...|CONTEXT_N

Example: TYPE.all.groups.search.context=cn-users|cn-users2

This example is for groups under cn-users and cn-users2 search contexts.
Disable case sensitivity for LDAP authentication

By default the Composite Server is case sensitive when used with either an iPlanet or ActiveDirectory domain, but that may be changed with ldap.properties. Example: Enable case insensitive user names for LDAP authentication. How can the default case sensitive mode used for LDAP authentication be disabled?

Example solution:

```
TYPE.user.username.comparison.is.case.sensitive=false
```

When the LDAP user name comparison is not case sensitive, then the user "cn=foo,ou=users,dc=domain,dc=com" can login to a Composite LDAP domain with user name "foo", "FOO". All variations of the user name used to login to Composite tools will map to the actual user name stored in the LDAP server.

**Note** If you disable case sensitive mode and have multiple users with the same name (but with variations in capitalization) login will be disabled for that user name. Search context may be specified to find user attribute values that differentiate the users affected. For instance in Active Directory, the samaccountname attribute for a user object is unique in the entire LDAP server, but cn (common name) is not.

**iPlanet get all users**

To start a search from the root node and get all users use a blank (null) value in the search context:

```
TYPE.all.users.search.context=
```

To find groups that match the objectclass filter use the following:

```
TYPE.all.users.filter=(objectclass=person)
```

To get user names from the user object name attribute:

```
TYPE.all.users.username.attribute=uid
```

To perform a search without a timeout:

```
TYPE.all.users.search.timeout=0
```
iPlanet get all users (under container ou=people)
This search context will find only groups under container ou=people:
   TYPE.all.groups.search.context=ou=people

This search will find only groups that match the objectclass filter:
   TYPE.all.groups.filter=(&(objectclass=person))

This search will get group names from this group object name attribute:
   TYPE.all.groups.groupname.attribute=cn

To specify a search that does not have a timeout (infinite search timeout):
   TYPE.all.groups.search.timeout=0

iPlanet get all groups
Using a null value (blank) will start search from the root node and get all groups:
   TYPE.all.groups.search.context=

To find only those groups that match the objectclass filter:
   TYPE.all.groups.filter=(&(objectclass=groupofuniquenames))

To get group names within this group object name attribute:
   TYPE.all.groups.groupname.attribute=cn

To specify a search that does not have a timeout (infinite search timeout):
   TYPE.all.groups.search.timeout=0

iPlanet get all groups (under container ou=groups)
This search context will find only groups under the container ou=groups
   TYPE.all.groups.search.context=ou=groups

To find only groups that match the objectclass filter
   TYPE.all.groups.filter=(&(objectclass=groupofuniquenames))
To get group names from this group object name attribute:

```
TYPE.all.groups.groupname.attribute=cn
```

To specify a search that does not have a timeout (infinite search timeout):

```
TYPE.all.groups.search.timeout=0
```

### iPlanet and Active Directory User Authentication

Composite LDAP user authentication dependent on either iPlanet or Active Directory servers depends on several configurations prior to successful user authentication through a Composite interface.

- The LDAP server must be configured for use
- The LDAP domain must be configured for use in the Manager console
- Specific Active Directory or iPlanet groups within the specified domain must be authorized to use Composite defined resources.

**Note**
- All members of Composite authorized LDAP groups get the basic set of privileges granted to the all group. Other resource privileges and Composite rights must be assigned explicitly to the LDAP group or to the individual user.
- Only users who are members of the specified domain and authorized groups may authenticate properly using Composite resources.

All LDAP users trying to authenticate against an LDAP server need to use the same username attribute value in the both settings below:

```text
TYPE.user.filter=(uid=USERNAME) (objectclass=person)
TYPE.user.username.attribute=uid
```

For example, a login from Composite Studio using an iPlanet LDAP domain with

```text
group='g1' defined locally on the server will take this login:
```

```text
username=user1 password=password domainname=iplanet_domain
```

and generate an LDAP authentication request as follows:

```text
uid=user1,ou=people,dc=DOMAIN_NAME,dc=COM
```
The example above assumes the following:

- CIS LDAP domain "iplanet_domain" already exists where CIS LDAP domain "iplanet_domain" has group "g1" in its group list.
- User "user1" exists in LDAP server at:
  ou=people, dc=DOMAIN_NAME, dc=COM
- Group "g1" exists in LDAP server at:
  ou=groups, dc=DOMAIN_NAME, dc=COM
- User "user1" is a member of the group "g1"
Domain Administration

LDAP domain administration involves these kinds of tasks:

- Adding an LDAP domain to Composite Server.
- Adding users and groups to an LDAP domain.
- Removing users or groups from an LDAP domain.
- Changing the LDAP domain connection parameters.
- Removing an LDAP domain.

Adding an LDAP Domain

You can add more than one LDAP domain to Composite Server, provided each of those domains has a unique name. The names “dynamic” and “composite” are reserved domain names in the Composite system, and therefore LDAP domains cannot be created using this name.

To add an LDAP domain

1. Launch Manager either by using the Administration menu option from Composite Studio, or by directing a browser to the
   http://<CIS_ServerName>:9400/manager, where 9400 is the default http port.
2. Choose USERS > Domain Management and click Add Domain at the lower right side of the domains table.

3. Enter the Domain Name. The domain name will be part of the login. When the process of adding the domain is complete, this name is displayed in the Domain Name column and as part of the login (lower case only).

4. Specify the LDAP directory type as either: Active Directory or iPlanet.

5. Type the path to the LDAP server in the Server URL field using the format:
   ldap://<hostname:port>/<directory suffix>
   Example for iplanet 5.1 sp2:
   <port> = 389 and <directory suffix> is dc=composite,dc=com
   Example for Windows 2003 Active Directory:
   <directory suffix> is dc=composite,dc=com

6. Enter an administrative LDAP user name and password.
Example for iplanet 5.1 sp2:
   cn=Directory Manager
Example for Windows 2003 Active Directory:
   administrator

7. Click OK.

Next, you should designate the LDAP groups (and user members of those groups) who can access to Composite resources.

**Working with Groups from an LDAP domain**

When you are adding groups from an LDAP domain to CIS, it means that you are selecting groups or users from the LDAP server and adding them to the Composite Server. This enables differentiated group and user access, use, creation, and modification of CIS resources as LDAP authenticated users.

LDAP domain users must belong to at least one LDAP group selected to use Composite Server as an authenticated user enabling implicit assignment of rights, privileges, and ownership of defined resources.

Similarly when an LDAP domain group is deselected from use with Composite Server, that group and all users defined exclusively by that group are removed locally from CIS disallowing access as an authenticated user. The external LDAP server is unaffected by these CIS definition changes.

After adding an LDAP group to CIS, members of that group can be authenticated with the LDAP server. Rights may be assigned to members and data sources may define privileges for the group or individual members of the group to use resource definitions and data.

A security check on user rights and privileges is made every time any request is made of CIS applications and defined resources. Authentication status with the LDAP domain is checked and maintained with a non-persistent session.

Authenticated users may own and use resources as defined by the rights and privileges assigned to them either explicitly as individuals or implicitly by
membership in one or more groups. Members of a group defined for use within CIS inherit all the rights and privileges defined for that group.

When the Edit/Add External Groups window is displayed, the currently available LDAP groups are displayed and those groups already selected for use within CIS are shown with a marked check box.

**Adding a Group to an LDAP Domain**

Adding external groups from an LDAP domain gives the Composite system a way to support differentiated access and use of Composite defined resources for selected user groups without including the entire domain.

**Note** Adding a group is the only way to add users to CIS from an LDAP server. User and group management is performed on the LDAP server and Composite rights and privileges are assigned to LDAP groups and users.

LDAP users are given rights and privileges to use Composite resources by explicit addition of the groups in which those members belong. Ensure that appropriate groupings of users will be enabled to use Composite resources by management of users on the LDAP servers.

**To add a group from an LDAP domain**

1. In Composite Manager, choose USERS > Domain Management and select the LDAP domain by using the row selector at the left of the Domain table.
2. Click Edit External Groups at the bottom of the table.

The Add External Groups window displays all groups in the LDAP or iPlanet domain.

3. Select those groups that you wish to grant access to CIS resources. You can use the navigation arrows and page numbers at the bottom of the window to display additional groups. You can also change the sort order by clicking the sort icon: 

4. Click OK and refer to the notes that follow.

Initially no users are shown as members of the selected groups. Users from the groups appear in the Composite system after the initial use of any Composite resource.

Set appropriate rights and privileges for LDAP groups in the same way that Composite groups and users get assigned rights and privileges. Pure end-users should receive no rights but get privileges which are assigned at the individual
resource level to groups and users to use data via JDBC, ODBC, or Web services clients. Unauthenticated users, anonymous, and dynamic users using pass-through authentication may be given privileges to view, access, and execute procedures on data resources, but they may not receive rights to change Composite definitions and settings.

Groups of developers, operations users, and administrators should get explicit rights to access tools and rights to read and/or modify Composite resources at design time.

After initial CIS use, LDAP domain users may be added directly to specifically defined Composite groups granting the user implicit rights and privileges assigned by group membership, or they may be given explicit individual rights and privileges. Managing rights and privileges by group assignment is encouraged as role based access control enables better control of large groups of users.

Refer to “Rights” and “Privileges” in the CIS User’s Guide for more information.

To add users to LDAP domains and groups, see “Adding Users to CIS from an LDAP Domain” on page 95, and “Adding Users to Groups” on page 97.

Removing a Group from an LDAP Domain

Removing a group from an LDAP domain means that you are removing the LDAP group, all the users within that group, and all the implicit rights and privileges given to that group definition for resources and uses on the Composite Server.

Resource definitions for /shared resources owned by users removed with a group deletion retain most configurations and access privilege information for remaining groups after the LDAP based owner is removed. Resource ownership is shifted to a special system user called “nobody”. Those data sources should be assigned a new owner and connections to those data sources should be tested and re-introspected to ensure that the resource remains accessible.

Group deletion also removes all access privilege information for the deleted group and affected members. Group deletion also clears any personal work space associated with deleted user profiles in the /users node.

As stated earlier, the external LDAP server is unaffected by these CIS definition changes.
To remove a group from an LDAP domain
1. In Composite Manager, choose USERS > Domain Management and select the LDAP domain by using the row selector at the left of the Domain table.
2. Click Edit External Groups at the bottom of the table.
   The Add External Groups window displays all groups in the LDAP or iPlanet domain.
3. Deselect those groups that you wish to remove. You can use the navigation arrows and page numbers at the bottom of the window to display additional groups.
4. Click OK.

Viewing Group Membership
The Composite administrator with Read All Users right may review and monitor user group membership from the Composite Manager.

To view a user’s group membership in an LDAP domain
1. In Composite Manager, choose USERS > User Management. The table of users may be filtered by domain and group, and sorted on multiple attributes.
2. In the Groups column click the “+” icon to expand the list of groups to which the selected LDAP user belongs.

Adding and Removing LDAP Users from a Group

To add or remove LDAP users to or from a Composite group
1. In Composite Manager, choose USERS > Group Management.
2. Select the Edit Users icon ( ) from the Composite group to which a user should be added or removed.
The Edit Group Membership window is displayed.

3. Add or remove users by checking or unchecking the users who should or should not belong to the Composite group. LDAP users get all the rights and privileges inherited from the groups in which they belong.

**Note** The Composite Server and Composite Manager do not manage LDAP group membership. LDAP users may be added to Composite groups as described above, but LDAP groups are not modifiable from Composite Manager.
Editing LDAP Domain Connection Parameters

Editing an LDAP domain enables change of connection parameters required to connect and read data from an LDAP authentication server. Everything but the nominal, domain name display text may be modified.

Change of the LDAP password in the CIS domain profile requires entry of the old password to unlock the encrypted cipher text.

To edit an LDAP domain:

1. In Composite Manager, choose USERS > Domain Management and select the Domain Name link for the LDAP domain that is to be modified.
2. Modify any field as required and click OK.
Removing an LDAP Domain

Removing an LDAP domain means that you are removing it from use by CIS. When an LDAP domain is removed, all the users, groups, rights, and privileges associated with that domain are deleted and removed from CIS. Ownership of shared Composite resources that were created and owned by users who will be deleted with the removal of the LDAP instance are moved to ownership by the user “nobody”. The LDAP users and groups will be untouched on the LDAP server.

To remove an LDAP domain

1. In Composite Manager, choose USERS > Domain Management and mark the row selector at the left of the Domain Name for the LDAP domain that is to be removed.
2. Click Remove Domain.
3. A verification prompt will ask whether you wish to remove the selected domain. Click OK and the domain, groups and users from that domain are no longer configured for use of CIS resources.

Resources that were created or owned exclusively by a deleted user are assigned to the “nobody” user. Privileges to utilize resources owned by nobody remain the same for those groups and users who remain after the LDAP domain is removed.
LDAP User Management

By default, without additional rights and privileges, all members of LDAP groups selected for use with CIS will be able to log into JDBC, ODBC, and Web services clients configured for use with CIS. Rights to use Composite tools and to view and use other resources must be added to group definitions or assigned explicitly to the user.

Assignment of rights and privileges to users from an LDAP domain is much the same as assignment of rights to users from a Composite domain.

Only a user with Read/Modify All Users, and Access Tools rights may add/modify an LDAP domain, add/remove groups, and clear and reset LDAP users to group settings.

Adding Users to CIS from an LDAP Domain

Under most conditions, LDAP users are added indirectly by addition of the groups to which they belong. Group management of rights and privileges may be assigned for users depending on the role performed by members of the group. To add users to an LDAP domain, the Composite administrator first has to add that LDAP domain to Composite Server, and then add groups to that domain.

To add a user to an LDAP domain, the user must belong to a group in the LDAP server. See “To add a group from an LDAP domain” for details.

When adding a user from an LDAP domain, three conditions must be satisfied to add a user to an LDAP domain.

- The entered LDAP username and password for the user are authenticated with the LDAP server successfully. If LDAP authentication fails or the LDAP user does not belong to any local group definitions, the user is not added to the LDAP domain in Composite Server. Consequently, this LDAP user is not allowed to log into Composite Studio successfully.
- The LDAP user is already a member of a group defined by the LDAP server.
- That pre-existing LDAP group is defined for use by CIS.
If these conditions are met, the user is successfully added to Composite Server. This user will be added to each local LDAP group as a member where appropriate. The domain sync process adds or removes LDAP users either to or from the appropriate local LDAP groups.

- **To add a user to an LDAP domain**
  1. Start Composite Studio.
  2. In the login screen, log in with a valid LDAP username, password, and domain.

### Removing LDAP Users from Composite

Removing a user from a domain and group configured for use in CIS only removes the user locally from Composite Server while the user may still exist in the LDAP server and possess implicit rights and privileges given by membership in the LDAP domain and group. Simply removing a user who is derived from an LDAP domain/group does not prohibit the user from logging into the system again.

Removing and preventing an LDAP user from gaining access to resources defined by Composite requires one of three courses of action:

- The LDAP group membership can be redefined at the source directory to exclude the undesired user.

- Rights and privileges for the entire LDAP group can be restricted to exclude access to resources and permissions. If other members of that LDAP group require rights and privileges, then those users may be given explicit rights and privileges or they may be made members of a Composite group that grants appropriate rights and privileges after they have been initialized into the system.

- The entire LDAP group can be removed from those included in the Composite external groups list.

In normal usage individual LDAP users may only be removed from CIS superficially. Composite services are not normally used as interfaces to manage LDAP users directly, though conceivably CIS could be configured and given permissions to change those tables directly and programmatically. Almost always
it is more advantageous to manage users and group memberships using the more familiar enterprise ready Active Directory or iPlanet interfaces. For example, if an individual LDAP Active Directory user needs to be locked out to prevent CIS access, then a management task must be performed directly on the LDAP server to change the column values for “memberOf” to exclude that user from the group given permission to authenticate for CIS access.

In Manager, Composite users may be removed easily enough, but LDAP users selected for removal are only removed temporarily because LDAP group membership will continue to give implicit rights and privileges. Removing an LDAP user resets rights and privileges to those rights and privileges inherited by group membership. Any user workspace in Composite Studio is also deleted by user removal, but that space is recreated with the next login into Studio.

Some possible workarounds:

- An LDAP group may be deleted (refer to “Working with Groups from an LDAP domain”) to remove all group users, rights and privileges for that group.
- Group rights and privileges may be restricted to initially grant nothing to all members of the group, and then other members of the targeted group may be added to other better defined groups of similar users with the desired set of rights and privileges.

Adding Users to Groups

LDAP users are added to LDAP groups by the LDAP administrator.

LDAP and dynamic users may be added to Composite groups to enable assignment of rights and privileges by a group membership. Though in the case of dynamically defined users it is recommended that they are not given any rights, nor any privileges to resources outside of the public domain. For more information refer to the chapter on the Dynamic Domain.

Add LDAP users to Composite groups using the Group Management page in the Composite Manager to add or remove users (regardless of their origin) to and from the group.
Any users added to a group gain any additional rights and privileges associated with that group. Rights and privileges accumulate based upon explicit assignment and group memberships.
Chapter 5

Dynamic Domain Administration

Composite supports the following types of domains: composite, LDAP, and dynamic. This chapter focuses on how to enable and administer dynamic domains for use with Composite. “Composite Domain Administration,” and “LDAP Domain Administration,” are discussed in the previous chapters.

The following topics are covered in this chapter:

- “About Dynamic Domains” on page 100
- “Domain Administration” on page 101
- “Group Administration” on page 103
- “User Administration” on page 105
About Dynamic Domains

Dynamic domains enable users to negotiate “direct” access to a secured data source by way of a Composite Server pass-through login. The Composite system does not store the password of dynamic users; it retains only an ephemeral encrypted copy in memory available during the current user session (the timeout setting is configurable).

When a user requests a view or procedure that requires data from a source that has pass-through login enabled (via Composite data source driver configuration setting), the user login and the parsed request for data are passed directly to the secured data source. This pass-through allows existing data source security structures to handle the authentication and request authorization. The dynamic domain lets the developer defer security authorization and enforcement to the data source security which is presumed to be more stringent and tightly controlled.

With the dynamic domain, the Composite solution may be made more transparent. The end user may use their existing login information for authentication with a data source to gain the same permissions they had in the past without needing to separately log into Composite.

**Note** Only one login (user name and password) is permitted for dynamic domain pass-through authentication. So, more than one pass-through-enabled data source may be used for federated queries if the data sources are set to authenticate using the same login.

Dynamic domains also enable a potentially large user base that does not require either a Composite or an LDAP domain structure.
Domain Administration

Aside from enabling the CIS configuration settings to enable the dynamic domain no special user management is required to enable users to access resources given proper privileges on resources that have been selected for exposure to dynamic domain users.

User login specifying the dynamic domain using JDBC, ODBC, or Web services is sufficient to dynamically create a new user profile.

For security reasons, dynamic domain users are blocked from using Composite Studio and other Composite administrative utilities. Dynamic domain users and the dynamic all group are given no rights by default. It is strongly recommended that no rights be assigned to dynamic users or groups so that they remain pure end-users without rights for changing the system.

The dynamic domain is disabled by default CIS configuration setting. Once enabled, dynamic users have default Read access to basic resources in Composite Studio (see “Granting Privileges to Dynamic Domain Users” on page 103 for the specific resources).

Enabling the Dynamic Domain

By default, the dynamic domain is disabled and an attempt to log in using this domain will fail as if the domain did not exist. This domain needs to be enabled before it can be used to log in.

To enable the dynamic domain

1. In Composite Studio, choose Administration > Configuration.
2. In the Configuration window, expand Composite Server > Configuration > Security, and select Enable Dynamic Domain Login.
3. In the right panel, set the Value to True to enable the dynamic domain, and click OK.
Group Administration

The dynamic domain has only one group named all. All dynamic users belong to the all group. No additional dynamic groups may be created.

The dynamic domain can not utilize groups for differentiation of user permissions by group assignment of privileges or rights because no password is stored to authenticate who is currently using a given user name. The data sources enabled with pass-through login perform the authentication and authorization security.

Granting Privileges to Dynamic Domain Users

Resources may be opened for use by anyone including dynamic domain users by granting privileges to the dynamic all group on published resources.

Caution Dynamic all privileges open published resources to public access.

Warning! No rights should be given to dynamically authenticated users because anybody can log in as a dynamic user; they are not authenticated by the Composite system.

When the dynamic domain is enabled, dynamic users have default Read access to the following basic resources in Composite Studio:

/  
/services  
/services/databases  
/services/webservices  
/services/webservices/system  
/shared  
/lib

All other access privileges must be explicitly granted for either the dynamic all group or for the individual dynamic user after initial login.
Caution. Dynamic users cannot be authenticated by definition as the password is not stored. Assigning resource privileges to individual dynamic users opens a resource to any user who may utilize that user name.

To view the dynamic user names that have been utilized

1. Open and login to Composite Manager.
2. Select USERS > Group Management.
3. In the "# Users" column, select the hyper-linked number representing the count of users in the all group row of the dynamic domain. Selection of this number link filters the display of users to show only those users in the all group of the dynamic domain.
User Administration

Management of dynamic domain users is mostly passive as far as CIS is concerned. Data sources enabled with a pass-through login must be configured to authenticate the user and to authorize access to data.

Initial login of a dynamic domain user with a JDBC, ODBC, or Web services client creates a new user profile on CIS. The new user is assigned an ID and may be treated like a normal user given proper caution to avoid inadvertent exposure of sensitive resources. Dynamic domain users do not have a home directory, hence they cannot create or own resources.

Caution Assigning resource privileges to any dynamic user exposes that resource to potential public access by any client using that user name. In sensitive environments dynamic users and the dynamic all group should only get privileges to access public resources, while data sources enabled with pass-through login may independently authenticate and authorize dynamic users to gain access to secured data.

Individual users in the dynamic domain may be deleted, but the all group and the dynamic domain are protected from deletion.

Caution Deletion of a dynamic user does not prevent that user name from being used to log in again.

The password for a dynamic domain user does not persist across sessions for logging purposes. But the password used for the current session is kept in memory and is passed when a request is made to data sources that have the pass-through option enabled.

Adding Users to the Dynamic Domain

To add a user to the dynamic domain

1. Enable the dynamic domain as described in “Enabling the Dynamic Domain” on page 101.
2. Connect to Composite Server through JDBC/ODBC, supplying the value dynamic for the argument domain in the connection string.

- See the “Client Interfaces” chapter in the CIS User’s Guide for details on connecting to Composite Server via JDBC/ODBC.

The following sample command uses the JDBCSample.bat program to run from the command line to create a user named newuser in the dynamic domain:

```
JdbcSample.bat system localhost 9401 newuser password dynamic "SELECT * FROM ALL_USERS"
```

### Removing Users from the Dynamic Domain

Removing users from the dynamic domain is mostly meaningless if the dynamic domain is enabled for use. Dynamic users are not authenticated, nor prevented from accessing all resources provided by privileges granted to the dynamic all group.

If you were to go through the motions to remove a user from the Composite list of users registered by the dynamic domain, then that would remove any group membership that had been assigned to the user, but the user would still be able to use a client with that same user ID for login.

### Dynamic Users Group Membership

Dynamic users are created at first login. All dynamic domain users automatically becomes a member of the dynamic all group. See “To add a user to the dynamic domain” on page 105 for details on adding users to the dynamic domain.

It is not recommended to add dynamic users to composite groups unless the group privileges are an entirely public set of permissions and no Composite rights are given.

### Viewing Dynamic User Group Membership

It is not recommended that dynamic users get regular group membership as that user name may be utilized by any individual using that login name to gain access
to group resources. For publicly available resources and groups, dynamic users may be

- **To view the group membership of a dynamic domain user**

1. Launch Composite Manager, using either the Composite Studio Administration menu, or by directing a browser to:
   

2. Choose USERS > User Management.

3. Filter the list of users by selecting the dynamic domain using the domain pull-down just above the table.

4. If a user belongs to more than the dynamic all, then an integer will be displayed next to the icon in the #Groups column. Select the link in the #Groups column to view or edit that user's group membership.

The Edit User's Group Membership Information window displays a list of groups with a checkmark selection to show to which groups the user belongs. Though it is not shown, all users in the dynamic domain belong to the dynamic all group.
Chapter 6

System Monitoring with Composite Manager

Composite provides system management capabilities through the use of Composite Manager via a Web interface and in Composite Studio. The use of both of these tools is described in this chapter.

The following topics are covered in this chapter:

- “About System Monitoring in Composite” on page 109
- “Working with Composite Manager” on page 111
- “Working with Studio Manager” on page 119
- “MANAGER HOME Page” on page 128
- “Composite Server Overview” on page 132
- “Cached Resources” on page 139
- “Data Sources” on page 148
- “Requests” on page 157
- “Sessions” on page 167
- “Transactions” on page 174
- “Triggers” on page 180
- “Events” on page 185
- “Event and Log Files” on page 194
- “I/O Log” on page 197
- “Memory Log” on page 200
- “Storage Log” on page 203
Chapter 6  System Monitoring with Composite Manager

About System Monitoring in Composite

Composite system management entails monitoring of system activities, system status, events, and system data and performing administrative tasks such as licensing and user management. Composite provides two interfaces for system management:

- Composite Manager—a Web browser interface
- Studio Manager—in Composite Studio

Composite Manager provides a thin client web-page based overview of CIS and displays summary views of CIS status, server information, cached resources, data sources, requests, sessions, transactions, triggers, and event logging. Composite Manager enables domain, group, and user management including configuring LDAP servers and selected groups for use with CIS. Cluster configuration, license management, and SSL keystore management are also provided in Composite Manager. Composite Manager is available only to users with administrative rights (Access Tools right is the minimum right required to view the Composite Manager).

Studio Manager provides much of the same information available in Composite Manager. Studio Manager is available only to those users with full administrative rights.

Some functionality is only available with either Composite Manager or Studio Manager and this is noted in the descriptions of those features.

Composite Manager Documentation

This chapter describes most of the functionality provided in Composite Manager. Some Composite Manager functionality is described in more detail in other chapters in this manual or in other documents:

- Domain, group, and user management are described in:
  - Chapter 3, “Composite Domain Administration”
  - Chapter 4, “LDAP Domain Administration”
  - Chapter 5, “Dynamic Domain Administration”
Cluster management is described in the *CIS Active Cluster Installation and Administration Guide*.

License and SSL management are described in Chapter 1, "Post-Installation Tasks".

**Studio Manager Documentation**

Studio Manager is documented in this chapter. Where Studio Manager panels are equivalent to Composite Manager pages, descriptions of the information is presented in the same section. Features provided only in Studio Manager are described in "Working with Studio Manager" on page 119.
Composite Manager enables users with appropriate Composite rights to view, monitor, and update selected CIS summary views and status. Additionally, properly authorized users may perform some server management tasks, establish and maintain active clustering, and manage domains, groups, and users and their associated Composite rights.

This section describes how to launch Composite Manager and use its basic features.

**Launching Composite Manager**

Composite Manager runs as a Web browser process. You can launch it in either of two ways:

- From Composite Studio, choose Administration > Launch Manager (Web)...
- In a Web browser (IE6, IE7, or Firefox 2), enter:
  
  http://<HostName|localhost>:<BasePort>/manager

  The default URL with default base port setting from the localhost would be:

  http://localhost:9400/manager

  Composite Manager launches and displays a login dialog. You must have a username and password with administrative rights to log in.
After a successful login, you see the MANAGER HOME page.

See “MANAGER HOME Page” on page 128 for a description of the features on this page.

Using Composite Manager

Many Composite Manager pages have features like adjustable page refresh settings, tables with sort functionality, detail buttons to display more information about a table row, row selection check boxes to specify the performance of an
action, and table filters that sharpen focus on the rows of the display. This section describes how you can use these features.

**Refreshing the Current Page**

Most Composite Manager pages have a refresh mechanism in the upper right corner of the page. The refresh rate specifies the time interval for an automatic refresh of the data on the currently displayed page. When you set the refresh rate, keep these things in mind:

- Page refresh rates are set independently of one another.
- Settings persist across sessions
- Different users have different refresh rate settings for each page.

You can manually refresh the page at any time by clicking the green arrow ( erotica) “Refresh Now” icon.

**Sorting with Composite Manager**

Table column header text displays a small white arrow in the column header row to show if the table is sorted by that column in ascending or descending order. Secondary and higher order sorting is indicated by a gray arrow in the columns used to further organize row display order. In the screenshot below, the column sorting indicator arrow is highlighted in red merely to call attention to it.
You can change the table row display sort order by clicking the Sort... icon (Sort...). Composite Manager displays the Advanced Sort dialog for you to define the sorting rules.

### Selecting a Row for an Action

Check box selection enables buttons that perform actions on the selected row or rows.

---

Chapter 6  System Monitoring with Composite Manager
Getting Additional Row Information

The Show Row Details button (  ) can be clicked wherever present to obtain more information about that row.

Filtering Table Data

You can use the Filter setting above most tables to filter the data displayed based on the column data. To apply a filter to the table, simply choose one from the Filter drop-down list.

For the status tables displayed via the MONITORING menu, the default list of filters looks like this:

```
Filter:
- Show All
- Show OK
- All Errors
- All Warnings & Errors
- <Edit Filters>...
```

For tables displayed via the USERS menu, only the Show All and <Edit Filters>... options are offered.

When working with table filters, these conventions apply:

- Filter definitions are defined and saved for a specific table.
- Composite Manager remembers the currently applied filter when you exit a page and applies that filter upon redisplay of the table.
- Only you can see filters that you have created and only on the computer on which you created them.

If you choose <Edit Filters>..., you can create new filters and copy, edit, or remove existing filters as described below.

Creating a New Table Filter

A table filter determines what rows are displayed based on the rules you specify for the data in the table columns.
To create a new filter

1. Above any table in Composite Manager, choose <Edit Filters...> from the Filter drop-down menu. The Advanced Filter dialog is displayed:

2. Click the Add Filter ( ) button above the list of existing filters.
3. In the Name edit box, type a unique name for your filter.
4. Specify a rule for your filter using these fields:
   4.1 Filter By - specify a column in the table on which to apply the rule. The drop-down menu lists all the columns displayed in the table view.
   4.2 Operator - specify the operator for the rule. The drop-down lists all available operators for type of data in the column (numeric, text, list of values, and so on).
   4.3 Condition - Specify the value or condition the data in the column must match.
5. To specify another rule, click the Add Rule button to the left of Filter By.
6. To remove any rule, click the Remove Rule button to the left of the rule definition.
7. Click Match Any Rule or Match All Rules to specify how you want the filter to work.
   Match Any Rule - the filter is applied if any one of the rule conditions are met.
   Match All Rules - the filter is applied only if all of the rule conditions are met.
8. Click OK to save the filter.
   The filter is saved with this table and can be applied or edited any time the table is viewed.

To copy an existing filter
You cannot edit the default All Errors or All Warnings & Errors filters; however you can copy and add to them if so desired.
1. Above any table in Composite Manager, choose <Edit Filters...> from the Filter drop-down menu. The Advanced Filter dialog is displayed.
2. Select the filter in the list box on the left.
3. Click the Copy Filter button above the list of filters.
4. Edit the name of the filter.
5. Make changes to the filter as desired.
6. Click OK to save the filter.

To remove an existing filter
You cannot remove the default All Errors or All Warnings & Errors filters.
1. In the Advanced Filter dialog, select the filter you want to remove.
2. Click the Remove Filter button above the list of filters.
Navigating Table Data

The arrows at the bottom of many tables enable you to quickly navigate forward and backward through the data.

Controlling the Number of Rows Displayed

The drop-down list in the lower right corner of many pages lets you select the number of rows that are displayed on each page. You can choose to display 10, 20, 50, or 100 rows per page.
Chapter 6  System Monitoring with Composite Manager

Working with Studio Manager

Studio Manager has many of the same features as Composite Manager but a complete different user interface. This section describes how to launch Studio Manager and use its basic features.

Launching Studio Manager

After starting the Composite Server, you launch Composite Studio from the Start
> All Programs menu by choosing:

Composite Software <version> > Studio > Start Composite Studio <version>
After Composite Studio launches, click the **Manager** tab shown on the left edge of Composite Studio. Composite Studio displays the Manager page:

![Composite Studio Manager tab](image)

Note that the Manager tab is not accessible or displayed for users who do not have full administrative rights.
Using Studio Manager

This section describes how to use many of the basic features that appear in Studio Manager. Each console in the Manager has built-in functionality to do the following:

- Selecting Columns for Display
- Viewing Table Row Details
- Sorting Rows
- Filtering Data for Display

This section describes how you can use this functionality in Studio Manager.

Selecting Columns for Display

- To specify the columns you want to have displayed

1. Open the desired console.
2. In the table view, right-click the header, and select the columns to be displayed.

   Show Default Columns - This option displays only those columns that are considered default in the system.

   Only Show This Column - This option lets you specify any one column to be shown. You can choose to show/hide any column you think is relevant for your needs.

   Show All Columns - This option displays all the columns.

Your selection determines which columns are displayed in the table view of the console.

Your choices about which columns to show or hide are saved and returned when you restart the Studio. Use the Show Default Columns option to reset the column choices to their original settings.
Viewing Table Row Details

To view the details of a table row

1. Open the desired console.
2. Double-click the row displaying the desired row in the display table, or select the row displaying the row and click the Show Row Detail button ( ) on the toolbar.

For example, double-clicking a row displaying a Session object in the Events console opens the details window corresponding to that session object, as shown next. Note that columns that were hidden are also displayed in this window.
Sorting Rows

You can follow two techniques to sort the columns in the table view.

► **Simple Sort Technique**

1. Open the desired console.
   The Events console is used here for example.
2. Click the desired column header by which you want to sort the rows.
   For example, click Time to sort the rows by the Time column. When you click the column header, a triangle appears indicating the sort direction, ascending (upward triangle) or descending (downward).
   You can hold down the Ctrl key and click other desired column headers to extend the sort rule.

► **Advanced Sort Technique**

1. Open the desired console.
   The Events console is used here for example.
2. Click the Sort button on the toolbar above the table display.
The Advanced Sort Dialog opens.

![Advanced Sort Dialog](image)

This dialog has three columns:

- **Sort By** - lists the columns displayed in the table view
- **Direction** - direction, ascending or descending, by which to sort the table entries
- **Move Rule** - direction, upward or downward. Changes the order in which sort rules are applied.

3. Select the desired column in the **Sort By** column.
4. Specify the ascending/descending order in the **Direction** column.
4.1 If you want to extend the sort order further, click the Add Rule button (or the plus sign on the button next to Sort By), and this action will add the next column, as shown in the next screenshot.

4.2 Use the Remove Rule button (or the negative sign on the button next to the desired rule) to delete the selected rule from the sort window.

5. Specify the ascending/descending order in the Direction column again if needed.

6. Click the upward or downward triangle in the Move Rule column to further filter the sort order.

   Notice when you select the upward/downward triangle, the entries in the Sort By column moves accordingly, thus specifying the sort order.

7. Click OK, once you have made all the specifications.

   Any sorting you specify either through the simple or advanced sort technique is automatically saved and reused when you restart the Studio.
Filtering Data for Display

To filter data for displaying in the table view

1. Open the desired console.
   The Events console is used here for example.
2. Click the Advanced Filter button above the table view.
   The Advanced Filter Dialog opens.

This dialog has three columns:
- **Filter By** - lists the columns displayed in the table view. You can select a column in this list in order to choose the column on which to apply the filter.
- **Operator** and **Condition** - work together as the two sides of an equation with the column. Operator lists a set of conditions for your selection and Condition lets you specify the value for the Operator.
3. Select the desired column in the Filter By column.

4. Specify your condition in the Operator and Condition columns.

5. Click Use Selected Filter or Do Not Filter.

Regardless of your choice, all filters are saved and can be edited any time later.

Filter definitions are defined per console. Filter definition in addition to the filter that is currently being used on a console is saved when you exit the Studio. The filter will be available when you restart the Studio and the Studio will automatically reuse the same active filter for the specific console.
MANAGER HOME Page

The Composite MANAGER HOME page is the first page displayed when you log in to Composite Manager. MANAGER HOME provides a quick summary of the current CIS status. The MANAGER HOME page is shown in "Launching Composite Manager" on page 111.

SERVER INFO Panel

The SERVER INFO panel shows summary information and links to the SERVER OVERVIEW page.

- **Server Name** - the HTTP base port is displayed. All other CIS ports are derived from the HTTP base port as follows:
  - base port +1 = JDBC and ODBC
  - base port +2 = HTTP SSL
  - base port +3 = JDBC SSL
  - base port +6 = Monitor
  - base port +8 = Default for Repository

In Composite Studio Manager, you can view and change the HTTP base port when required on the Configuration panel at Composite Server > Web Services Interface > Communications > HTTP > Port. Note that changing the base port...
changes all other ports on server restart, so system impact must be carefully considered before changes are made.

- **Total Memory Used**
  
  Percentage of total available Java Heap Memory (RAM) currently in use. Java Heap Memory is a CIS configuration setting that requires restart to change. Total memory is further divided into Managed and Reserved memory with a built in margin to prevent OOM errors. Refer to “About CIS Configuration” or the CIS Production Server Performance Best Practices guidelines for more information.

- **Sessions**
  
  The number of active sessions with a theoretical estimate of the total number of sessions that could be supported.

- **Server Requests**
  
  Number of active requests made to the server. Active requests have been started but not yet completed. The total count is cumulative of all requests.
Datasource Requests
Active data source requests sent to other resources and the total number of outgoing requests that the server has made on other resources. The total includes all requests completed or otherwise.

Transactions
Active transactions with the total number of transactions that the server has made on other resources.

SERVER STATUS Panel
The SERVER STATUS panel displays simple indicators showing the current aggregate status of the modules/consoles listed:

Status can be one of the following: OK (green), Disabled (grey), # Warnings (yellow), DOWN or # Errors (red), where # is the number of warnings or failures for the module listed. A single warning or critical error will change the status from green to yellow, or from yellow to red depending on the failure severity and the module.
QUICK LINKS Panel

The QUICK LINKS panel provides direct links to the EVENT LOG, CLUSTER MANAGEMENT, and USER MANAGEMENT pages.
Composite Server Overview

In Composite Manager, you access Composite server overview information by choosing Server Overview from the MONITORING menu. The SERVER OVERVIEW page is displayed, providing a consolidated overview of the system, and the overall status of all of the other system components.

The SERVER OVERVIEW page displays statistics about the server that are grouped into four areas: server status information, sessions and requests information, cache information, and server status indicators. In addition, two server overview buttons are provided at the bottom of the page. Each of these page elements are described below.
Server Status Information

The upper left section of the SERVER OVERVIEW page displays server status information. Each item listed is described in this section. Where appropriate, the related configuration parameter in Composite Studio Manager is also described.

- **Status**
  Status reports the presence and count of errors and warnings from all pages under the MONITORING tab. Status can be:
  - **OK**—no errors or warnings exist.
  - **# Warnings**—the total number of warnings on the server. If there are also errors, they are shown in place of showing a count of warnings.
  - **# Errors**—the total number of errors.

  In Composite Studio Manager, slightly more status information is available: Server is running, Server is stopping, Server stopped, Server is starting, Server failed, or Unknown server status (which is shown if the Monitor is not running.)

  When the Monitor is running, CIS may be started, stopped, or restarted using the Start/Stop/Restart buttons on the Studio Manager, Server Overview page. The Composite Server life-cycle is as follows:
  - Stopped -> Starting -> Running -> Stopping -> Stopped

- **Server Name**
  Server Name with the HTTP base port is displayed. All other CIS ports are derived from the HTTP base port as follows:
  - base port +1 = JDBC and ODBC
  - base port +2 = HTTP SSL
  - base port +3 = JDBC SSL
  - base port +4 = Reserved
  - base port +5 = Reserved
  - base port +6 = Monitor
  - base port +7 = Reserved
  - base port +8 = Default for Repository
• **Total Memory Used**

  Percentage of total available Java Heap Memory (RAM) currently in use. Java Heap Memory is a CIS configuration setting that requires restart to change. Total memory is further divided into Managed and Reserved memory with a built-in margin to prevent Out of Memory (OOM) errors. Refer to “About CIS Configuration” or the CIS Production Server Performance Best Practices Guidelines for more information.

• **Maximum Viewable Events**

  Maximum number of events that may be viewed from the Events console in the Manager.

  In Composite Studio Manager, you can set this number using the Configuration window setting for Maximum Viewable Entries in the Events and Logging > Logging > Memory section as shown here.

  ![Configuration Window](image)

  This number also controls the maximum number of rows of information displayed in the table in each console. Additional entries may be viewed in the log files.


- **Maximum Event Entries**

  Maximum number of events to be stored in the Composite repository. When the number of events reaches this threshold the oldest events are discarded in FIFO (first in, first out) order. The log files are generally configured to retain a more expansive archive of event entries.

  In Composite Studio Manager, you can change the Maximum Event Entries using the Configuration window setting for Maximum Log Entries in the Events and Logging > Logging > Database Logger section as shown here.

  ![Configuration Window](image)

- **Session and Request Information**

  The SERVER OVERVIEW page also displays summary information about sessions and requests.

  - **Sessions**

    The number of currently connected user sessions, and the total number of sessions started since the server started to run, including closed sessions.
Chapter 6  System Monitoring with Composite Manager

- **Requests**
  Active requests, started but not completed, and the total number of incoming requests made to the server. Includes the requests that have been completed.

- **Data Source Requests**
  Active data source requests sent to other resources versus the total number of outgoing requests that the server has made on other resources. The total is the resource cache storing resource meta data number of resources loaded on the server includes all requests completed or otherwise.

**Privilege, User, and Repository Caches**

Summary cache information on the SERVER OVERVIEW page displays usage of CIS system caches for security privileges on defined data resources, user privileges, and data source metadata repository stores. These system caches are not to be confused with the data source caches which store materialized views specifically configured at the data source level. For more information on data source caches refer to the CIS Technical Note, *Caching Views and Procedures in CIS*, which is available from the `<installation root>/docs` folder. The system caches store data such as user session values of privileges, recently introspected data source meta data, and execution plans.

**Access (Hits/Accesses)**, the first column in the sub-section, displays a percentage that for all three rows should be relatively high, as it is a fair indicator of enhanced performance obtained by system cache usage.

**Access** is any request to access an object in the repository, and **Hits** are inquiries sent to the cache or successful cache usages.

A "miss" is an access attempt that was required to look beyond the cache for a particular entity, meaning a disk access, LDAP or data source query.

Thus a high percentage of hits to total access attempts is one indicator of enhanced performance meaning that most of the entity access attempts are hitting the cache without requirement of disk or source data retrieval.
The second column in the sub-section is the **Capacity (Entries/Max)** which shows the amount of repository usage by each of the system caches. Each of the system cache sizes is configurable.

- **Privilege Cache**
  Privilege cache refers to repository storage of explicit privileges for resources. In Composite Studio Manager, you can change privilege cache capacity setting in the Configuration window at Runtime Processing Information > Repository > Privilege Cache Max Size. Other configuration settings display the current values of the Privilege Access and Hit counts and the current privilege cached size.

- **User Cache**
  Current user cache data stored in the repository. In Composite Studio Manager, you can change the user cache capacity setting in the Configuration window at Runtime Processing Information > Repository > Resource Cache Max Size.

- **Repository Cache**
  Repository cache is a resource meta data store enabling quick use of configured resources.

  In Composite Studio Manager, you can change the repository cache capacity setting in the Configuration window at Runtime Processing Information > Repository > User Cache Max Size.

**Server Status Indicators**

The **SERVER STATUS** summary box at right of the **SERVER OVERVIEW** page displays a summary status for other Composite Manager pages which are all available for display from the **MONITORING** and **LOGGING** tabs. The red, green, and yellow indicators give you a quick idea of the status of key system components. You can click on any of the links to go to the related page for detailed information.
Working with the SERVER OVERVIEW Page

You can start and stop a server or clear the repository cache for the server by clicking these buttons:

- **Stop**
  Stops CIS after acknowledgement of a verification prompt. Actually stopping CIS requires the Modify All Status right. The button is visible, but grayed out and inactive for other users with access to the Composite Manager.

- **Clear Repository Cache**
  Immediately empties the repository cache. Clearing the repository cache requires the Modify All Status right. The button is visible, but grayed out for any other users with access to the Composite Manager.
Cached Resources

In Composite Manager, you access cache resources information by choosing Cached Resources from the MONITORING menu. The CACHED RESOURCES page is displayed, providing information about the cached views and procedures, both enabled and disabled, that are configured for use in CIS. Summary information is displayed at the top of the CACHED RESOURCES page, and information about each individual cache is displayed in the table below.

The following sections describe the data displayed in the CACHED RESOURCES table and how you can work with this data.
Working with the CACHED RESOURCES Page

You can enable or disable cached tables and procedures and you can refresh them manually if necessary. Each row has a check box to selectively choose the cache you want to enable, disable, or refresh. After selecting the cache(s), you can click these buttons:

- **Change Enabling** button—toggles the enabled/disabled status of selected caches. You must have the Modify All Status right.
- **Refresh Cache(s)** button—refreshes the selected caches. You must have the Write privilege on the selected resource.

You can also change the number of rows displayed at once, quickly navigate through the pages using the arrows at the bottom of the table, and sort and refresh the data. These actions are described in "Using Composite Manager" on page 112.

The CACHED RESOURCES Table

The CACHED RESOURCES table displays summary information with cache details available (click to view the Details window).

- **Name** - the display name of the view or the procedure.
- **Status** - Current status of the cached view. The status of a cached resource can be any one listed in the following table:

<table>
<thead>
<tr>
<th>Status</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT LOADED</td>
<td>Cache has not been loaded.</td>
</tr>
<tr>
<td>UP</td>
<td>Cache has been loaded successfully.</td>
</tr>
<tr>
<td>DOWN</td>
<td>Cache is not loaded and the most recent refresh failed.</td>
</tr>
<tr>
<td>STAILE</td>
<td>Cache is loaded with valid data, but the most recent refresh failed. However, reads against the cache can succeed.</td>
</tr>
<tr>
<td>DISABLED</td>
<td>Cache has been disabled.</td>
</tr>
<tr>
<td>Status</td>
<td>Event</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>CONFIG ERROR</td>
<td>Cache cannot operate due to a configuration error.</td>
</tr>
</tbody>
</table>

**Type** - Values may be Table or Procedure.

**Variant** - Unique set of procedure input parameter values. Every set of procedure input parameters have a different storage table result set.

**Owner** - Resource owner. The cache is refreshed and cleared using the owner's identity.

**Last Access** - Date and time of the last end-user invocation of a view or procedure, also includes last refresh of data by timer, or last change of meta-data.

**Last Refresh End** - Completion date and time of last query refresh.

**Last Fail End** - Date and time when the last refresh attempt failed.

**Storage Used** - Disk space used to store result of table or procedure variant.
Cached Resource Details

Each row also has a Show Row Details button ( ) which you can use to display the fully qualified path and other details about cached resources.

In addition to the information presented in the CACHED RESOURCES table (and described in “The CACHED RESOURCES Table” on page 140), these details are provided:
**Path** - Composite resource location, fully qualified path.

**Owner domain** - domain of the user who created the resource, or who is currently designated as owner.

**Total Accesses** - count of the number of times the cache resource is used since last CIS restart.

**Last Success End** - Last successful completion date and time.

**Last Success Duration** - Time (seconds) required for last successful refresh.

**Last Fail Duration** - Time recorded for last failure.

**Total Successes** - Count of successful refreshes since last CIS restart.

**Total Failures** - Count of failed refreshes since last CIS restart.

**Message** - Error message returned from cache refresh failure.
Working with Cached Resources in Studio Manager

The Composite Studio Manager Cached Resources window displays the much of the same information as the CACHED RESOURCES page in Composite Manager.

As noted in the description of the CACHED RESOURCES table in "The CACHED RESOURCES Table" on page 140, some of the column names are different. Also, Studio Manager has the Schedule button described above. This section describes how to enable, disable, schedule, and refresh a cache in Studio Manager.
Enabling and Disabling Caches in Studio Manager

1. In the table view of the console, select the desired event to be scheduled for caching.
   To select multiple views, hold down the Shift key or Ctrl key and select the desired views. The Shift key lets you select adjacent rows, and the Ctrl key lets you select any row.

2. Use the Changed Enabling button to disable/enable caching for that view.
   The UP status changes to DISABLED when you click the Changed Enabling button. The DISABLED status changes to UP when you click the Changed Enabling button.

Modifying the Cache Schedule in Studio Manager

1. In the table view of the console, select the desired event to be scheduled for caching, and click the Schedule button.
   The Cache Schedule window opens.

2. In the Status section, select the Enable check box, if it is not selected.

3. In the Storage section, select Automatic or User Specified.
   - If you select Automatic, the cached view data will be stored in a system file, which will be used for later querying.
   - If you select User Specified, use the Browse button to locate the database for cache storage.
   Make sure that you choose a database whose schema has compatible data types and number of columns to accommodate the view data. Note that if you use an existing database, the data therein will be over-written when the current view is cached.
4. In the Refresh Mode section, select Manual, Exactly Once, or Periodic as relevant. Refreshing a cached resource means that you re-execute the resource at a specified time.

- To immediately refresh manually, click Refresh Now.
- To refresh exactly once, how often to execute the resource for caching (in the Start on section), such as every # of minutes, hourly, daily, or weekly. In the date and time fields, specify the date and time respectively to execute the resource.
- To refresh periodically, specify how often to refresh the cache (in the Refresh every section) and how often to execute the resource for caching (in the Start on section), such as every # of minutes, hourly, daily, or weekly. In the date and time fields, specify the date and time respectively to execute the resource.

The date entered indicates the time at which the first occurrence of the caching event will occur. For example, if a daily event is set for 11:55 A.M. three days in the future, it will run at 11:55 A.M. in three days and then every day thereafter.

5. In the Expiration Schedule section, select Never Expire to indicate that the cache resource should never expire, or specify when exactly should the cache resource expire (in the Expire after fields).

6. In the Advanced section, specify when to clear the cache and the maximum number of procedure variants using these options:

- when user clears it manually - means that the cache would clear only when cleared explicitly through the Clear Now button or an API, or when the cache expires.

- when refresh fails - Selecting this option would clear the cache if a refresh fails. The effect of this option is to allow access to previously cached data during a refresh, but to either provide updated data or to end up with a cleared cache when the refresh completes with success or failure respectively.

- when refresh begins - Selecting this option would automatically clear the cache before starting a refresh. The effect of this option is that any client attempting to read from the cached data will not see the previously cached data and will wait for the new data.
Maximum number of procedure variants - refers to the maximum number of unique set of input parameter values. Specify the desired number.

7. Click OK.

**Refreshing a Cache in Studio Manager**

- **To refresh a cache in Studio Manager**

  1. In the table view of the console, select the desired event to be scheduled for caching.

     To select multiple views to refresh their respective cache, hold down the Shift key or Ctrl key and select the desired views. The Shift key lets you select adjacent rows, and the Ctrl key lets you select any row.

  2. Click Refresh Cache.
Data Sources

In Composite Manager, you access data sources information by choosing Data Sources from the MONITORING menu. The Composite Manager DATA SOURCES page is displayed, providing information about all data sources added to the Composite Server, including:

- A consolidated overview of all the data sources in the repository.
- The overall status of the data sources with a count of warnings if any.
- An aggregated count of the active requests and an accumulated count of the total number of requests handled by CIS since the last restart.
- Estimations of the total volume of data passed from CIS to all data sources and back to CIS since the last CIS restart.

DATA SOURCES Summary Information

Summary information at the top of the DATA SOURCES page includes:

**Status** - displays the current status which can be OK (green), Disabled (grey), # Warnings (yellow), DOWN or # Errors (red), where # is the number of warnings or
failures for the module listed. A single warning or critical error will change the status from green to yellow, or from yellow to red depending on the failure severity and the module.

Requests - Displays the number of active requests and the total number of requests since server restart.

Bytes - Displays the number of bytes sent to the data sources and number of bytes received from the data sources.

**Working with the DATA SOURCES Page**

You can select one or more data sources by check box and then perform the following actions those data source(s):

- Enable or disable the data source - the Change Enabling button toggles the status of the data source. Enabling makes the data source accessible via Composite definitions and configurations. Disabled takes the data source offline and makes it inaccessible to Composite defined channels.

- Clear the currently allocated pool connections. The Clear Connection Pool(s) button drops the current connection pool allowing current processes to restart connections when necessary.

- Verify the data source connection using the Test Data Source(s) button.

You can also test the current status all data sources by clicking the Test All button. An Administrative user with the Modify All Status right may use the Test All button.

**The DATA SOURCES Table**

The following columns are shown for each data source in CIS.

Name - User-defined name for the datasource.
Status - Overall status for the data source, which may be one of the following:

<table>
<thead>
<tr>
<th>Status</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLED</td>
<td>The data source is disabled; represented by a grey circle.</td>
</tr>
<tr>
<td>DOWN</td>
<td>The data source is inaccessible; represented by a red circle.</td>
</tr>
<tr>
<td>NOT TESTED</td>
<td>The status of the data source has not been tested.</td>
</tr>
<tr>
<td>UP</td>
<td>The data source is connected to the Composite Server; represented by a green circle.</td>
</tr>
</tbody>
</table>

Type - Native data source type, some of the more common supported data sources categories include: DB2, Composite, Custom Java Procedure, Infirmity, FileCache, LDAP, Microsoft Access, Microsoft Excel, Microsoft SQL Server, MySQL, Netezza, Oracle, Sybase, Teradata, Wsdl, XML, and XmlHttp

Total Requests - Cumulative count of all requests made on data sources (via CIS) since start of the CIS.

Active Requests - Current count of all outstanding data source requests

Pool Size (In Use) - Current connection-pool size for relational data sources

Allocated Pool Size - Current number of connections allocated for CIS for a particular relational data source

Max Pool Size - Maximum connection-pool size for a relational data source, zero is unlimited or not applicable.

Pool Utilization - Utilization of pool represented as a percentage where allocated connections is divided maximum connections for a relational data source.
Data Source Details

To display the following read-only detail information for a data source in the repository, click the Show Row Details button ( ).

Name - User-defined name for the data source.
Path - Fully-qualified path to the data source. For example, if the data source ds_orders reside in /shared/sources, the path to ds_orders would be: /shared/sources.
Status - Current status, which can be UP, DOWN, or NOT TESTED.
Category - Category, which can be File, LDAP, Relational, WSDL, XML/HTTP.
Type - Type of the data source within the category to which it belongs.
Total Requests - Total number of requests (including active requests) made to the server since last startup.
Active Requests - Number of in-progress requests to the server.
Bytes From Data Source (Estimated) - An estimate of the total number of bytes of data received by the server from this data source.
Bytes Into Data Source (Estimated) - An estimate of the total number of bytes of data sent to this data source from the server.
Pool Size (In Use) - Current connection-pool size, if the data source is relational.
Allocated Pool Size - Current number of actual connections both idle and active allocated by CIS for a particular relational data source.
Max Pool Size - Configurable setting for maximum connection-pool size used to limit the number of connections allowed to burden a relational data source.
Pool Utilization - Utilization of pool represented in percentage, if the data source is relational.
Number of Logins - The number of times a connection to the data source is made in the connection pool.
Number of Logouts - The number of connections to the data source that were manually destroyed by logout from the connection pool.
Working with Data Sources in Studio Manager

In Studio Manager, you can display information about the current data sources by clicking the Manager button and then clicking Data Sources.

### Data Sources

<table>
<thead>
<tr>
<th>Status</th>
<th>2 Warnings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Requests</td>
<td>0</td>
</tr>
<tr>
<td>Active Requests</td>
<td>0</td>
</tr>
<tr>
<td>Bytes From Data Sources (Estimated)</td>
<td>0 B</td>
</tr>
<tr>
<td>Bytes Into Data Sources (Estimated)</td>
<td>0 B</td>
</tr>
</tbody>
</table>

### Next Test Time

- Test All Now
- Schedule Test

Studio Manager displays a slightly different mix of information and functionality than Composite Manager.

**Bytes From Data Source (Estimated)** - An estimate of the total number of bytes of data sent to the data sources since the server started.

**Bytes Into Data Source (Estimated)** (Studio Manager only) - An estimate of the total number of bytes of data received from all data sources since the server started.

**Test All Now** button - enables manual test of the availability of all resources. Use requires the Modify All Status right.
Schedule Test button - enables configuration of a time interval that should occur between automated attempts to test all of the data sources.

When you press the Schedule Test button, the Test All Data Sources Schedule window opens, where you can set the time and the interval at which the testing should occur. If the Do Not Execute Automatically button is selected in the Test All Data Sources Schedule window, then no automated testing of all of the data sources will occur. If an individual data source is tested at a given time (using the Test button), that test time will override this setting. Disabled data sources will fail this test.

Next Test Time - Time when the next test is scheduled to run.

In the data sources table, any data source row may be selected to:
Show read-only data source details using the green information icon:
Show configurable Data Source Information using the Info button:

The Data Source Information panel is feature rich, enabling basic and advanced configuration of the individual data source. Data source connection information may be edited directly from this panel, and tables may be added.
or removed from the definition. Refer to “Adding Data Sources,” in the User Guide for more info.

- Enable or disable the data source - the Change Enabling button toggles the status of the data source. Enabling makes the data source accessible via Composite definitions and configurations. Disabled takes the data source offline and makes it inaccessible to Composite defined channels.
- Clear the currently allocated pool connections using the Clear Pool button, which drops the current connection pool allowing current processes to restart connections when necessary.
- Verify the connection status of the data source using the Test button.
Requests

In Composite Manager, you access requests information by choosing Requests from the MONITORING menu. The Composite Manager REQUESTS page is displayed, providing information about all current requests for service including:

- Inbound requests through a Composite data service.
- Outbound requests against physical data sources.
- Internal requests against internal views.

Summary information is displayed at the top of the REQUESTS page, and information about each individual request is displayed in the table below. Operational information about queued, in process, and recently completed requests gives the administrative user an idea about what requests are taking inordinate amounts of time or memory resources to complete.

Note that some of the information displayed on the REQUESTS page is controlled by the configuration settings in Composite Studio. To view these settings, open Composite Studio and choose Configuration from the Administration menu. These locations have configuration settings for transactions:

- Composite Server > Configuration > Events and Logging > Event Generation > Request Events
- Composite Server > Runtime Processing Information > Requests

Most of the requests data displayed in Composite Manager is also displayed in Studio Manager. For additional information about monitoring requests in Studio Manager, see “Working with Requests in Studio Manager” on page 165.
Chapter 6  System Monitoring with Composite Manager

The REQUESTS page is shown below.

Note  You probably need to scroll the display to the right to see all of the information provided.
Requests are removed from the table periodically, based upon the Studio Manager configuration setting:

Composite Server > Runtime Processing Information > Requests > Request Purge Period

The default setting purges requests every 5 minutes.

**REQUESTS Summary Information**

The REQUESTS page provides the following summary information:

- **Status** - Aggregated status of all requests can be OK, Warning, Error, or Unknown. A single warning or error supersedes display of a status of OK. When failed requests or waiting requests are present, a count of those warnings or errors will be shown.

- **Waiting Requests** - Current number of requests waiting in the queue due to memory constraints.

- **Waiting Requests Threshold** - An event trigger threshold that causes an event. The event may be used for notification.

- **Server Requests (Active and Total)** - The number of currently active requests, and the total number of requests made to the server since the server was started.

- **Data Source Requests (Active and Total)** - The number of currently active requests, and the total number of requests made to the data sources since the server was started.

**Working with the REQUESTS Page**

You can select one or more requests in the REQUESTS table by check box and then perform the following actions on those requests:

- **Clear Plan Caches** button - Clears all query plan caches, in the event that current statistics gathering may have significantly changed information sufficient to change the query execution plan. Forces recalculation of all query plans at next time of execution which will be an initial performance hit.
Purge Completed Requests button - Immediately removes all completed and failed requests. This is useful to reset the view, removing any noise, just prior to testing a set of requests.

Cancel Requests button - Clears all requests.

The REQUESTS Table
The REQUESTS table displays these columns for each request:

- **ID** - Unique request identifier.
- **Status** - Can be any one of the following values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Indicates that the request...</th>
</tr>
</thead>
<tbody>
<tr>
<td>STARTED</td>
<td>Was created but not invoked or executed.</td>
</tr>
<tr>
<td>RUNNING</td>
<td>Is currently executing.</td>
</tr>
<tr>
<td>WAITING</td>
<td>Exists in a wait queue.</td>
</tr>
<tr>
<td>COMPLETED</td>
<td>Execution successfully completed but is not yet closed.</td>
</tr>
<tr>
<td>CLOSING</td>
<td>Is in the process of closing.</td>
</tr>
<tr>
<td>SUCCESS</td>
<td>Successfully executed and has closed.</td>
</tr>
<tr>
<td>FAILED</td>
<td>Execution failed.</td>
</tr>
<tr>
<td>TERMINATED</td>
<td>Was closed by cancelling.</td>
</tr>
<tr>
<td>COMMITTED</td>
<td>Changes were committed to the database.</td>
</tr>
<tr>
<td>ROLLED_BACK</td>
<td>Changes that might have been made were rolled back.</td>
</tr>
<tr>
<td>TOP_TIME</td>
<td>Is in the group of requests that took the longest amount of time to complete. The number of requests in this group is configurable in Composite Studio using this property: Composite Server &gt; Runtime Processing Information &gt; Requests &gt; Number of Top Requests Tracked</td>
</tr>
<tr>
<td></td>
<td>The default is 10 requests.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates that the request...</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TOP_MEMORY</td>
<td>Is in the group of requests that took the largest amount of managed memory. The number of requests in this group is controlled by the same property described for TOP_TIME above.</td>
</tr>
</tbody>
</table>

**Owner** - Userid of the user who submitted the request.

**Parent ID** - Unique ID for the request’s parent process.

**Session Type** - STUDIO, HTTP (Web service), INTERNAL, or client procedure.

**Session Name** - Name of the component that initiated this request.

**Start Time** - Time the request started to execute.

**End Time** - Time the request was completed. Blank if the request is unfinished.

**Total Duration** - Amount of time elapsed between Start Time and End Time.

**Rows Affected** - The number of rows affected by this request.

**Max Memory** - Maximum memory utilized by this request, blocks of 2MB are initially reserved and then if additional memory is required 2MB blocks are incrementally assigned.

**Max Disk** - The maximum amount of memory ever occupied by the request

**Summary** - The SQL statement or procedure made by this request.
Request Details

Every individual request has additional detailed information that might help in troubleshooting failed requests. To view the read-only details, click the Show Row Details button ( ) for the desired row.
In addition to the information presented in the REQUESTS table (and described in “The REQUESTS Table” on page 160), these details are provided:

- **Request Type** - Either SQL or Procedure.
- **Owner domain** - Name of the domain to which this owner belongs.
Session Type - The type of session: STUDIO, HTTP (Web service), INTERNAL, or client procedure.
Transaction ID - Unique ID for the request's session.
Duration - Amount of time elapsed between Start Time and End Time.
Server Duration - Represents the actual time spent by the server processing this request. The difference between Server Duration and Total Duration is the overhead on the server.
Current Memory - Memory utilization of this request.
Current Disk - The amount of current memory occupied by the request.
Description - a more complete description of the summary.
Message - Displays an error message if the request caused an error.
Working with Requests in Studio Manager

In Studio Manager, you can display information about the current requests by clicking the Manager tab and then clicking Requests.

Similar to Composite Manager, the top of the Studio Manager Requests page displays summary information and the bottom displays a table listing the details for each request. However, Studio Manager displays a slightly different mix of information and functionality than Composite Manager.

By default, the requests in the Details table are sorted in the order they are received (oldest first). You can click on any column header to change the sort order.
As with Composite Manager, you can use the Clear Plan Caches or Purge Completed Requests buttons to affect the requests. See “Working with the REQUESTS Page” on page 159 for more information.

Request Details in Studio Manager

To view additional information about a request in Studio Manager, select the row and then click the Info ( ) button. Most of the details you see in Studio Manager are the same as those displayed in Composite Manager (see “Request Details” on page 162). In addition, the following information is presented in Studio Manager:

- **Name** - For a procedural request, it is the name of the procedure. For an SQL request, it is the initial part of the SQL string. Otherwise, it is anonymous.
- **Path** - For a procedure, it is the path to the request. Otherwise, it is blank.
- **Error Message** - Error associated with a given request.
- **% Time in Server** - Displayed only when you click a row in order to view row details. It is “Server Time” divided by “Duration” times 100. That is (Server Time / Duration) x 100.
- **Rows/Lines Returned** - Total number of rows or lines returned depending on whether this request was relational or hierarchical.
- **Bytes From Data Source (Estimated)** - An estimate of data submitted into this request.
- **Bytes Into Data Source (Estimated)** - An estimate of data produced by this request.
- **Cache** - Boolean to indicate whether the request has been cached or not. True indicates that the request has been cached. False means that the request has not been cached.
- **ID** - Unique ID for the request’s parent process.

You can view the query plan for a request by selecting the request and clicking the Show Query Plan button. This action displays the full query plan of the request with statistics. You can use the plan to diagnose any type of query.
In Composite Manager, you access sessions information by choosing Sessions from the MONITORING menu. The SESSIONS page is displayed, providing information about the current and recently active sessions. Summary information is displayed at the top of the page, and information about each individual session is displayed in the table below.

Note that some of the information displayed on the SESSIONS page is controlled by the configuration settings in Composite Studio. To view these settings, open Composite Studio and choose Configuration from the Administration menu. These locations have configuration settings for transactions:

- Composite Server > Configuration > Events and Logging > Event Generation > Session Events
- Composite Server > Runtime Processing Information > Sessions

Most of the session data displayed in Composite Manager is also displayed in Studio Manager. For additional information about monitoring sessions in Studio Manager, see “Working with Sessions in Studio Manager” on page 172.
The SESSIONS page is shown below.

Sessions are removed from the table periodically, based upon the Studio Manager configuration setting:

**Note** You probably need to scroll the display to the right to see all of the information provided.
Composite Server > Runtime Processing Information > Sessions >
Session Purge Period

The default setting purges sessions every 30 minutes.

SECTIONS Summary Information

The SUMMARY page provides the following summary information:

- **Status** - Aggregated status of all sessions can be OK, Warning, Error, or Unknown. A single warning or error supersedes display of a status of OK.
- **Studio Session Timeout** - The amount of time the session can be inactive before it times out.
- **Sessions (Active and Total)** - The number of currently active sessions, and the total number of sessions since the server was started.

Working with the SECTIONS Page

If you want to limit the display of sessions to only active sessions, you can quickly remove the completed sessions by clicking the Purge Completed Sessions button.

If you want to terminate a session, you can select one or more sessions in the SECTIONS table by check box and then click the End Sessions button.

The SECTIONS Table

The SECTIONS table displays these columns for each session:

- **ID** - Unique session identifier.
- **Status** - Can be any one of the following values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Indicates that the session...</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVE</td>
<td>The session is currently active.</td>
</tr>
</tbody>
</table>
Name - The session name.

Type - The session type: STUDIO, HTTP (Web service), INTERNAL, or client procedure.

Owner - Userid of the user who initiated the session.

Host - The IP address or name of the host server.

Login Time - Time the user logged in.

Idle Duration - Amount of time the session has been idle.

Total Duration - Amount of time elapsed since the user logged in.

Active Requests - The number of active requests.

Total Requests - Total number of requests processed for this session.

Bytes To Client - The number of bytes in for all requests during this session.

Bytes From Client - The number of bytes sent out for all requests during this session.

<table>
<thead>
<tr>
<th>Status</th>
<th>Indicates that the session...</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME_OUT</td>
<td>The session has timed out. The Session Timeout configuration setting in Composite Studio determines how long the session can remain idle before it times out. See Composite Server &gt; Runtime Processing Information &gt; Sessions &gt; Session Timeout.</td>
</tr>
<tr>
<td>CLOSED</td>
<td>The session is closed.</td>
</tr>
</tbody>
</table>
Session Details

Every individual session has additional detailed information available. To view the read-only details, click the Show Row Details button ( ) for the desired row.

In addition to the information presented in the SESSIONS table (and described in “The SESSIONS Table” on page 169), these details are provided:

Owner domain - Name of the domain to which the session owner belongs.
Data Service -
Logout Time - The time this session logged out.
Timeout Duration - The amount of time this session can be idle before it will time out.
Active Transactions - The number of currently active transactions.
Total Transactions - Total number of transactions processed in this session.

Working with Sessions in Studio Manager

In Studio Manager, you can display information about the current and recent sessions by clicking the Manager tab and then clicking Sessions.

<table>
<thead>
<tr>
<th>ID</th>
<th>Type</th>
<th>User</th>
<th>Domain</th>
<th>Total Reg</th>
<th>Active Reg</th>
<th>Bytes In (Est)</th>
<th>Bytes Out (Est)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1194501623</td>
<td>Studio</td>
<td>admin</td>
<td>composite</td>
<td>0</td>
<td>0</td>
<td>73.4 MB</td>
<td>0 B</td>
</tr>
<tr>
<td>1277000004</td>
<td>JDBC</td>
<td>admin</td>
<td>composite</td>
<td>0</td>
<td>0</td>
<td>10.4 MB</td>
<td>16.1 MB</td>
</tr>
<tr>
<td>126012070707</td>
<td>Studio</td>
<td>admin</td>
<td>composite</td>
<td>0</td>
<td>0</td>
<td>6.8 MB</td>
<td>2 D</td>
</tr>
<tr>
<td>0763252657216</td>
<td>Internal</td>
<td>system</td>
<td>composite</td>
<td>0</td>
<td>0</td>
<td>0 B</td>
<td>0 B</td>
</tr>
</tbody>
</table>

Sessions console at 2:45:22 AM
Server Time: 2:45:21 PM
The Studio Manager Sessions window displays this summary information for all current and recent sessions:

- **Status** - Aggregated status of all sessions can be OK, Warning, Error, or Unknown. A single warning or error supersedes display of a status of OK.
- **Total Sessions** - Total number of sessions started since the server started.
- **Active Sessions** - Number of currently active sessions.
- **Default Session Timeout** - Timeout limit (in minutes) for JDBC/ODBC clients.

The Studio Manager sessions Details table displays the same information available in Composite Manager. See “The SESSIONS Table” on page 169.

**Session Details in Studio Manager**
To view additional information about a session in Studio Manager, select the row and then click the Info (i) button. The details you see in Studio Manager are the same as those displayed in Composite Manager (see “Session Details” on page 171).
Transactions

In Composite Manager, you access sessions information by choosing Transactions from the MONITORING menu. The TRANSACTIONS page is displayed, providing information about the current and recently active transactions. Summary information is displayed at the top of the page, and information about each individual transaction is displayed in the table below.

By default, the TRANSACTIONS page displays transactions that occurred within the last 5 minutes. Transactions created by Composite Manager itself are not displayed to reduce noise in the display.

Note that some of the information displayed on the TRANSACTIONS page is controlled by the configuration settings in Composite Studio. To view these settings, open Composite Studio and choose Configuration from the Administration menu. These locations have configuration settings for transactions:

- Composite Server > Configuration > Events and Logging > Event Generation > Transaction Events
- Composite Server > Runtime Processing Information > Transactions

Most of the session data displayed in Composite Manager is also displayed in Studio Manager. For additional information about monitoring sessions in Studio Manager, see “Working with Sessions in Studio Manager” on page 172.
The TRANSACTIONS page is shown below.

Transactions are removed from the table periodically, based upon the Studio Manager configuration setting:

Composite Server > Runtime Processing Information > Transactions > Transaction Purge Period

The default setting purges transactions every 5 minutes.

Note: You might need to scroll the display to the right to see all of the information provided.
TRANSACTIONS Summary Information

The TRANSACTIONS page provides the following summary information:

- **Status** - Aggregated status of all transactions can be OK, Warning, Error, or Unknown. A single warning or error supersedes display of a status of OK.

- **Total Transactions Run** - The total number of transactions processed since the server was started.

- **Total Transactions Rolled Back** - The total number of transactions that were rolled back since the server was started.

- **Total Transactions Failed** - The total number of transactions that failed since the server was started.

- **Active Transactions** - The total number of currently active transactions.

Working with the TRANSACTIONS Page

If you want to limit the display of transactions to only active transactions, you can quickly remove the completed transactions by clicking the Purge Completed Transactions button.

If you want to terminate a transaction, you can select one or more transactions in the TRANSACTIONS table by check box and then click the Cancel Transactions button.

The TRANSACTIONS Table

The TRANSACTIONS table displays these columns for each transaction:

- **ID** - Unique transaction identifier.

- **Status** - Can be any one of the following values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Indicates that the transaction...</th>
</tr>
</thead>
<tbody>
<tr>
<td>START</td>
<td>Was started.</td>
</tr>
<tr>
<td>COMMITTED</td>
<td>Has been committed.</td>
</tr>
</tbody>
</table>
Mode - Displays the mode for this transaction: AUTO or EXPLICIT.

Owner - User who initiated this transaction.

Session ID - Unique identifier for the transaction.

Session Name - Name of the component that issued the transaction. For example, Studio.

Start Time - Time at which the transaction was initiated.

End Time - Time at which the transaction was completed.

Duration - Amount of time for which the transaction has been running or ran.

<table>
<thead>
<tr>
<th>Status</th>
<th>Indicates that the transaction...</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAIL</td>
<td>Failed.</td>
</tr>
<tr>
<td>ROLLBACK</td>
<td>Was rolled back.</td>
</tr>
<tr>
<td>COMPENSATE</td>
<td>Was compensated.</td>
</tr>
</tbody>
</table>
Transaction Details

Every individual transaction has additional detailed information available. To view the read-only details, click the Show Row Details button ( ) for the desired row.

In addition to the information presented in the TRANSACTIONS table (and described in "The TRANSACTIONS Table" on page 176), these details are provided:

- **Owner domain** - Name of the domain to which the session owner belongs.
- **Session Type** - STUDIO, HTTP (Web service), INTERNAL, or client procedure.
- **Active Requests** - The total number of currently active transactions.
Total Requests - The total number of transactions since the server started.

Working with Transactions in Studio Manager

The Studio Manager Transactions console displays an overview of the transactions performed by CIS. The same information is provided in Studio Manager as is provided in Composite Manager with some naming variations.

See “TRANSACTIONS Summary Information” on page 176 and “The TRANSACTIONS Table” on page 176 for descriptions of the information displayed.
Triggers

In Composite Manager, you access trigger information by choosing Triggers from the MONITORING menu. The TRIGGERS page is displayed, providing information about the current and recently active triggers. Summary information is displayed at the top of the page, and information about each individual trigger is displayed in the table below.

By default, the TRIGGERS page displays triggers that occurred within the last 5 minutes. Triggers created by Composite Manager itself are not displayed to reduce noise in the display.

Note that some of the information displayed on the TRIGGERS page is controlled by the configuration settings in Composite Studio. To view these settings, open Composite Studio and choose Configuration from the Administration menu. These locations have configuration settings for triggers:

- Composite Server > Configuration > Events and Logging > Event Generation > Trigger Events
- Composite Server > Runtime Processing Information > Triggers

Most of the trigger data displayed in Composite Manager is also displayed in Studio Manager. For additional information about monitoring triggers in Studio Manager, see “Working with Triggers in Studio Manager” on page 184.

For more information about triggers, refer to the CIS User’s Guide chapter, “Triggers”.
The TRIGGERS page is shown below.

Composite provides a TestAllDataSources trigger by default. The TestAllDataSources trigger is configurable on the Data Sources console in Composite Studio or executable from the Manager DATA SOURCES page.

Note You might need to scroll the display to the right to see all of the information provided.

**TRIGGER Summary Information**

The TRIGGERS page provides the following summary information:

- **Status** - Aggregated status of all triggers can be OK, Warning, Error, or Unknown. A single warning or error supersedes display of a status of OK.
- **Total Runs** - Total number of trigger executions carried out since the server started.
- **Total Failed Runs** - Total number of trigger executions that failed since the server started.
Working with the TRIGGERS Page

If you want to change the status of a trigger between enabled and disabled, you can select one or more triggers in the TRIGGERS table by check box and then click the Change Enabling button.

The TRIGGERS Table

The TRIGGERS table displays these columns for each trigger:

- **Name** - The name of the trigger.
- **Status** - Can be any one of the following values:
  - **ACTIVE** - Is currently processing.
  - **DISABLED** - Is disabled.
  - **CONFIG ERROR** - Is not configured correctly.
- **Condition** - Type of trigger. Time-event, system-event, or user-defined event.
- **Action** - The type of action this trigger generated.
- **Owner** - User who initiated this trigger.
- **Next Time** - Next time when the execution will occur.
- **Frequency** - Recurrence of execution.
- **Last Time** - Last time the execution occurred
- **Last Success** - Last time the execution was successful
- **Total Attempts** - Total number of times the this trigger was invoked.
Trigger Details

Every individual trigger has additional detailed information available. To view the read-only details, click the Show Row Details button ( ) for the desired row.

In addition to the information presented in the TRIGGERS table (and described in “The TRIGGERS Table” on page 182), these details are provided:

- **Path** - Fully qualified path to the resource that has been scheduled for execution.
- **Parent Type** - Type of parent for this trigger.
- **Owner Domain** - The domain to which the Owner belongs.
- **Initial Time** - The first time the trigger execution occurred.
- **Last Fail** - Last time the trigger execution failed.
Total Successes - Total number of times the trigger execution successfully occurred since the server started.

Total Failures - Total number of times the trigger execution failed since the server started.

Message - Displays an error message if the trigger caused an error.

Working with Triggers in Studio Manager

The Studio Manager Triggers console displays an overview of the triggers configured for use by CIS. The same information is provided in Studio Manager as is provided in Composite Manager with some naming variations.

See “TRIGGER Summary Information” on page 181 and “The TRIGGERS Table” on page 182 for descriptions of the information displayed.
Events

In Composite Manager, you access information about the server events that have been logged by choosing Event Log from the LOGGING menu. The EVENT LOG page is displayed, providing information about all of the events generated by processes running on the Composite Server. Events originate from one of the following types of objects or processes:

- cached views
- data sources
- requests for query executions
- schedules
- sessions
- transactions

Summary information is displayed at the top of the page, and information about each individual event is displayed in the table below.

Note that some of the information displayed on the EVENT LOG page is controlled by the configuration settings in Composite Studio. To view these settings, open Composite Studio, choose Configuration from the Administration menu, and go to:

Composite Server > Configuration > Events and Logging

Most of the event data displayed in Composite Manager is also displayed in Studio Manager. For additional information about monitoring events in Studio Manager, see “Working with Sessions in Studio Manager” on page 172.
The EVENT LOG page is shown below:

Note: You might need to scroll the display to the right to see all of the information provided.
About the Server Events in CIS

Composite Manager and Studio Manager give you the ability to display Composite Server events for various types of objects and processes as described in the previous section. Depending upon the process, its event at a given time can be any one of the following:

START, STOP, RESTART, CREATE, DELETE, ADD, REMOVE, ON, OFF, END, FAIL, CANCEL, COMMIT, ROLLBACK, COMPENSATE, DESTROY, REFRESH, REQUEST, RESPONSE, MISS, SUCCESS, INCREASE, DECREASE, CHECK_OUT, CHECK_IN, INVALID, TERMINATE, MODIFY, IMPACT, OVER, UNDER, PASS, RESET, ROLL, WRITE, WAIT, RUN, EXHAUST, UP, DOWN

The type of event is often tied to the type of process and its life cycle as described in the next section.

Event Life Cycles

Here is a list of the possible event types during the life cycles of requests and transactions. General life cycle event types are also listed.

• General life cycles
  START -> END
  START -> FAIL

• Life cycles for a request
  START -> FAIL
  START -> CANCEL
  START -> RUN -> END
  START -> RUN -> FAIL
  START -> RUN -> CANCEL
  START -> WAIT -> RUN -> END
  START -> WAIT -> RUN -> FAIL
  START -> WAIT -> RUN -> CANCEL
  START -> WAIT -> FAIL
  START -> WAIT -> CANCEL
Life cycles for a transaction
START -> FAIL
START -> COMMIT
START -> ROLLBACK
START -> COMPENSATE

Server Event Attributes

The Composite Information Server creates SNMP events that are compliant with SNMPv1 protocol. The tables in Appendix A, “SNMP Traps” on page 305 contain details of these server events. The attributes listed are: SNMP ID, short name for the event, and description.

The SNMP traps in the tables have the following OID prefix 1.3.6.1.4.1.18439.2.3 starting with the CIS 4.5 release. For previous CIS releases, the OID prefix was 1.3.6.1.4.1.18439.2.2.

Set the generic trap to 6. Composite Server Monitor’s specific trap numbers range between 10000 and 19999. Composite Server’s specific trap numbers range between 20000 and 29999.

In the SNMP details tables, the SNMP ID is listed with the event name, and a description that includes the names of the variables whose values are passed in the message with the text description. The “VARIABLE” values in the description columns are passed in the MIB message payload with an incremented, sequential number that follows the concatenation of the OID prefix and SNMP ID. For example, the variables from the first MIB description are:

- trapTime
- trapServerHostName
- trapServerPort

The SNMP variables are sequentially assigned numbers for display in the MIB message payload. Hence trapTime is assigned a numeric representation of “1”, trapServerHostName is “2”, and trapServerPort is “3”. All SNMP variables appear in the MIB, identified only with their numeric representation.

Using this example, the line pictured below from a SNMP MIB shows an OID prefix that specifies output from a Composite Server from release 4.5, with a
SNMP ID designating a csMonitorStart event with a trapServerPort (represented by the numeral 3) opened on port 9406.

Good SNMP software will parse this message into a human readable format according to the MIB definitions set in the CompositeSoftware-MIB.mib file.

**EVENT LOG Summary Information**

The EVENT LOG page provides the following summary information:

- **Status** - Aggregated status of all events can be OK, Warning, Error, or Unknown. A single warning or error supersedes display of a status of OK.

- **Maximum Viewable Events** - The maximum number of event descriptions maintained in the repository event table. The default maximum is 1000 entries. The number of events is configurable in Composite Studio with the Administration menu Configuration option by choosing Composite Server > Events and Logging > Logging > Memory > Maximum Viewable Entries in the Configuration window.

- **Maximum Event Entries** - Maximum number of events that can be stored in the server. This number is set in Composite Studio with the Administration menu Configuration option by choosing Composite Server > Events and Logging > Logging > Database Logger > Maximum Log Entries in the Configuration window.

**Working with the EVENT LOG Page**

The EVENT LOG page is mainly an informational page. You can change the sort order, filter the data, or get more details on a specific event, but there are no actions on the data itself.
The EVENT LOG Table

The EVENT LOG table displays these columns for each event:

- **ID**: Unique event identifier.
- **Severity**: The severity level of the event, represented by a colored circle, may be one of DISABLED/OFF (gray circle), INFO (green circle), WARNING (yellow circle), or ERROR (red circle). Refer to Description below.
- **Category**: The type of event, such as REQUEST, SESSION, or TRANSACTION.
- **Type**: The type of event that occurred which can be anything in the event lifecycle including: START, STOP, RESTART, CREATE, DELETE, ADD, REMOVE, ON, OFF, END, FAIL, CANCEL, COMMIT, ROLLBACK, COMPENSATE, DESTROY, REFRESH, REQUEST, RESPONSE, MISS, SUCCESS, INCREASE, DECREASE, CHECK_OUT, CHECK_IN, INVALID, TERMINATE, MODIFY, IMPACT, OVER, UNDER, PASS, RESET, ROLL, WRITE, WAIT, RUN, EXHAUST, UP, and DOWN. See “Event Life Cycles” on page 187 for more information.
- **Owner**: User who generated this event.
- **Time**: The date and time the event occurred.
- **Description**: A description of the event, such as the request id.
Event Details in Composite Manager

Every individual event has additional detailed information available. To view the read-only details, click the Show Row Details button for the desired row.

In addition to the information presented in the EVENT LOG table (and described in “The EVENT LOG Table” on page 190), these details are provided:

Owner Domain - The domain to which the Owner belongs.
Parent Event ID - The ID of the parent event.
Detail - All logged details about this particular event.
Working with Events in Studio Manager

The Studio Manager Events console displays an overview of the events that have been logged very similar to the EVENT LOG page in Composite Manager.

The table below shows a sample of the events logged in Studio Manager.

<table>
<thead>
<tr>
<th>Time</th>
<th>Description</th>
<th>Type</th>
<th>User</th>
<th>ID</th>
<th>Parent ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>3:46:04 PM</td>
<td>START: session=24361697112329100...</td>
<td>Requests</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
<tr>
<td>3:46:04 PM</td>
<td>START: request id=441 started</td>
<td>Requests</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
<tr>
<td>3:46:04 PM</td>
<td>END: request id=441 completed</td>
<td>Requests</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
<tr>
<td>3:46:04 PM</td>
<td>START: request id=4412 started</td>
<td>Requests</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
<tr>
<td>3:46:04 PM</td>
<td>END: request id=4412 completed</td>
<td>Requests</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
<tr>
<td>3:46:04 PM</td>
<td>END: session=555617449907 completed</td>
<td>Sessions</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
<tr>
<td>3:46:04 PM</td>
<td>START: session=92721595452 started</td>
<td>Sessions</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
<tr>
<td>3:46:04 PM</td>
<td>START: request id=0008 started</td>
<td>Requests</td>
<td>admin</td>
<td>4785174378...</td>
<td>4785174378...</td>
</tr>
</tbody>
</table>

See “EVENT LOG Summary Information” on page 189 and “The EVENT LOG Table” on page 190 for descriptions of the information displayed. Note that there are some naming variations. For example:

<table>
<thead>
<tr>
<th>Composite Manager</th>
<th>Studio Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Type</td>
</tr>
<tr>
<td>Type &amp; Description</td>
<td>Description</td>
</tr>
<tr>
<td>Owner</td>
<td>User</td>
</tr>
</tbody>
</table>

In Studio Manager, right-click the table column header to show or hide desired columns. Also, you can double-click a desired row or select a row and use the Show Row Detail button to see all columns together in a dialog window.
Event Details in Studio Manager

Every individual event has additional detailed information available. In Studio Manager, select the event and then click the Show Row Detail button ( ). Composite Studio displays these event details:

- **Domain (Studio Manager)** - Domain to which the owner of the resource that triggered the event belongs.
- **Attributes (Studio Manager)** - An arbitrary list of additional properties specific to the type of event.
- **SNMP ID (Studio Manager)** - Unique SNMP ID that describes the context of the event.

In addition to the information presented in the Studio Manager Events table (and described in "The EVENT LOG Table" on page 190), these details are provided:
Event and Log Files

All events in the Composite system are logged, but not all log entries are tied to system events and visible through Composite Manager. Also, there may be cases where an event is associated with multiple log entries.

Composite uses a number of log files to store information logged during installation, uninstallation, and other system and user activities. The sections below describe the:

- Installation and uninstallation log files
- Server, monitor, and studio log files

Installation and Uninstallation Logs

Composite creates installation and uninstallation log files. The log files are created in the first available location listed in the order specified below on each platform:

- On Windows:
  \%HOMEDRIVE\%
  \%TEMP\%
  \%USERPROFILE\%

- On UNIX:
  /
  /tmp
  $HOME
Composite provides the following log for about installation activities:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CompositeIA.log</td>
<td>Internal installer log file, created at the root level of the local disk on the machine hosting the server. Contains information about the Composite software installation process. Information is logged by the installer.</td>
</tr>
<tr>
<td>CompositeInstall.log</td>
<td>Main Composite installation log file, created at the root level of the local disk on the machine hosting the server. Contains information about the actual process of installation. Information is logged by the Composite Server.</td>
</tr>
<tr>
<td>CompositeSoftware&lt;version number&gt;_InstallLog.log</td>
<td>Internal installer log file, created at the root level of the installation directory. Contains information about the software components installed, such as registry entry, location of the file, and status of the installation attempt.</td>
</tr>
<tr>
<td>CompositeIA_Uninstall.log</td>
<td>Internal un-installation log file, created at the root level of the local disk on the machine hosting the server. Contains information about the process of un-installation. Information is logged by the Composite Server.</td>
</tr>
<tr>
<td>CompositeUninstall.log</td>
<td>Main Composite un-installation log file, created at the root level of the local disk on the machine hosting the server. Contains information about the actual process of installation. Information is logged by the Composite Server.</td>
</tr>
</tbody>
</table>
### Server, Monitor, and Studio Log Files

Composite provides the following log files for server, monitor, and user activities. These log files can be found in:

```
<CIS_installation_directory>/logs
```

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cs_server.out.&lt;TIMESTAMP&gt;</td>
<td>Composite Server standard out/error logs</td>
</tr>
<tr>
<td>cs_server.log</td>
<td>Composite Server main log.</td>
</tr>
<tr>
<td>cs_server_events.log</td>
<td>Composite Server events log.</td>
</tr>
<tr>
<td>cs_monitor.out</td>
<td>Composite Server monitor standard out log. Only available on Windows systems.</td>
</tr>
<tr>
<td>cs_monitor.out</td>
<td>Composite Server monitor standard out/error log. Only available on UNIX systems. UNIX systems have stdout and stderr go to this file, which is not the case for the Windows systems.</td>
</tr>
<tr>
<td>cs_monitor.log</td>
<td>Composite Server monitor main log.</td>
</tr>
<tr>
<td>cs_monitor_events.log</td>
<td>Composite Server monitor events log.</td>
</tr>
<tr>
<td>cs_studio.log</td>
<td>Composite Studio main log.</td>
</tr>
</tbody>
</table>
I/O Log

In Composite Manager, you can access information about the input and output of data between data sources and clients and CIS by choosing I/O Log from the LOGGING menu. The Input/Output Graph page is displayed, providing a log of recent Composite Server activity. The upper section graphs the input requests over time, while the lower section graphs the output requests. Only users with the Read All Status right can view this page.

Here is an example of the Input/Output Graph page showing the upper graph:
The Input and Output graphs display the following information:

**Data Source** - Total requests made between the data sources and the clients. These are the numbers displayed in the Bytes To Data Source and Bytes From Data Source fields at the top of the DATA SOURCES page. Data source activity is displayed in blue.

**Composite Data Service** - Total requests made between the Composite Server and the clients. Composite Data Service activity is displayed in yellow.

**Total** - Aggregate data input/output from the server. This is the sum total of the other two values. The total activity is displayed in green.

**Working with the Input/Output Graph Page**

You can remove any of the logs from the graph by clicking its button below the graph. When the button changes to an outline, that log is not displayed.

For example, if you click Total on the Output Graph to remove the combined activity, you can clearly differentiate between the Data Source activity in blue and the Composite Data Service activity in yellow:
Working with the I/O Log in Studio Manager

You can view the I/O log in Studio Manager by choosing I/O from the Manager pane. The I/O log presents the same information as displaying in Composite Manager (see "I/O Log" on page 197) with the addition of a Status button at the top of the log.
Memory Log

In Composite Manager, you can access information about how memory has been used by CIS by choosing Memory Log from the LOGGING menu. The Memory Graph page is displayed, providing a log of the recent use of memory by Composite Server.

Here is an example of the Memory Graph page:

The Memory Graph displays the following information:

- **Java VM Memory** - Current memory usage for the Java VM. Java VM Memory is displayed in blue.
Managed Memory - Current memory usage for the memory that is tracked by Composite Server. Managed memory is displayed in yellow.

Beneath the graph, these values are displayed:

Java VM Memory Max - The maximum computational memory made available to Java VM.

Managed Memory Max - The maximum computational memory made available to CIS.

Working with the Memory Graph Page

You can remove any of the logs from the graph by clicking its button below the graph. When the button changes to an outline, that log is not displayed.

You can use the Free Unused Memory button to free unused memory. This action starts the Java VM garbage collection cycle that under normal circumstances is started automatically when the maximum managed memory level is exceeded. You must have the Modify_All_Status right to use this button.

Working with the Memory Log in Studio Manager

You can view the Memory log in Studio Manager by choosing Memory from the Manager pane. The Memory log presents the same information as displaying in Composite Manager (see “Memory Log” on page 200) with the addition of a Status button at the top of the log.

In addition, three threshold lines are displayed on the graph for:

Maximum Total Memory - Displays the maximum total memory available. Total memory is actual CIS usage levels, and the maximum is available computational memory.

Maximum Throttle Memory - Displays the maximum throttle memory available. CIS has a runtime configuration setting for a wait queue minimum memory threshold which is visible as the “Throttle” on the Memory console. If actual memory usage crosses the minimum threshold, all new queries are queued until more memory is available. This threshold is meant to avoid potentially fatal out-of-memory errors on the server.
**Maximum Managed Memory** - Displays the maximum total memory available as set by the Composite Server > Memory > Managed Memory > Available Managed Memory configuration parameter. Managed memory is a configurable percentage of that total made available to the Java Virtual Machine (JVM).
Storage Log

In Composite Manager, you can access information about how disk storage has been used by CIS by choosing Storage Log from the LOGGING menu. The Storage Graph page is displayed, providing log information about used disk space, available disk space, and the disk threshold.

Here is an example of the Storage Graph page:

The Storage Graph displays the following information:

- **Config Disk Used** - Current usage of the config disk. Config Disk Used is displayed in blue.
**Config Disk Size** - Total size of the config disk. Config Disk Size is displayed in yellow.

**Temp Disk Used** - Current usage of the temporary disk. Temp Disk Used is displayed in light green.

**Temp Disk Size** - Total size of the temporary disk. Temp Disk Size is displayed in orange.

**Log Disk Used** - Current usage of the log disk. Log Disk Used is displayed in dark blue.

**Log Disk Size** - Total size of the log disk. Log Disk Size is displayed in red.
Working with the Storage Log in Studio Manager

You can view the Storage log in Studio Manager by choosing Storage from the Manager pane. The Storage log presents log information about used disk space, maximum available disk space, and the disk threshold as shown here.

The Storage graph also provides a Status button at the top of the log. The status of storage can be any one listed in the following table:
<table>
<thead>
<tr>
<th>Storage Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>The storage used is within the set thresholds.</td>
</tr>
<tr>
<td>EXCEED</td>
<td>Maximum threshold was exceeded.</td>
</tr>
<tr>
<td>RESET</td>
<td>Maximum threshold was reset.</td>
</tr>
<tr>
<td>FAIL</td>
<td>Out of disk space.</td>
</tr>
</tbody>
</table>
Chapter 7

Utilities

This chapter describes the command-line utility programs which are available in the bin directory of the installation directory. Generally to use these programs (with the exception of model_import, pkg_export, and pkg_import), you need to have administrative rights to Access Tools, Read All Resources, and Modify All Resources.

Currently described utility programs (in alphabetical order):

- backup_export and backup_import
- "composite" on page 220
- "install_services" on page 223
- "model_import" on page 224
- "pkg_export and pkg_import" on page 232
- "remove_services" on page 264
- "repo_util" on page 265
  - "Sample Commands to Use repo_util" on page 267
- "server_util" on page 269
backup_export and backup_import

The Composite Information Server (CIS) offers two ways to perform a full server backup of an existing Composite Server instance. Either Composite Studio or the backup_import command line utility may be used to create or restore saved configurations from a full server backup CAR file. By default the backup_export command exports every part of the server configuration, including domains, users, groups, all resources, security settings (ownership of resources and privileges on resources), cache configurations, scheduling, driver configurations, and server-level settings.

Note For more information on how Composite Studio may be used to quickly export and import the full Composite Server configuration refer to the section on “Using Composite Studio for a Full Server Backup” in the User’s Guide.

Use Composite’s command-line backup programs to backup and save all data source metadata, user-defined resources, (published, shared, and other), and server settings are backed up into a single compressed file for safeguarding. The file generated by a full server backup export may be used to later restore the entire set of configurations (with the exception of local machine based server configuration settings), data source meta-data, and all derived and child resources.

Local computing environment based settings and configurations are excluded from a full server backup export. These configuration settings are identified as locally defined values in the description pane of the Configuration window displayed by invocation from the Administration menu in Studio.

Options may be specified to either include or exclude custom java and data source statistics regarding cardinality and table boundaries. Other command line utilities, namely pkg_export and pkg_import, give greater flexibility and control over what and how aspects of the server may be exported for purposes other than backup.

The backup_export command line utility requires the following rights for a full server backup export into a single composite archive file (*.car).

- Access Tools
- Read All Resources
Read All Users and
Read All Config

The Composite Studio Full Server Backup requires the same rights.

The backup import command line utility requires the following rights to restore
everything from a composite archive file (*.car):

- Access Tools
- Read and Modify All Resources
- Read and Modify All Users
- Read and Modify All Config

These programs are available in the bin directory of the installation directory:

- backup_export.bat (for installation on Windows only)
- backup_import.bat (for installation on Windows only)
- backup_export.sh (for installation on UNIX only)
- backup_import.sh (for installation on UNIX only)

### Backup Program Commands

#### Backup Export Syntax

This utility will function properly when the user executing it has all the administrative
display of Read All Resources, Read All Config, Read All Status, and Read All Users in
addition to Access Tools.

```
backup_export
  -server <hostname> [-port <port number>] [-encrypt]
  -pkgfile <file name>
  -user <user name> -password <password> [-domain <domain>]
  [-pkgname <name>] [-description <text>]
  [-optfile <file name>] [-excludejars]
  [-includeStatistics] [-verbose]
```
Command-Line Options for backup_export

Options in the following table are listed alphabetically. Syntactical order of the options is relevant in most cases.

Notes
- The export does not include runtime history like log files or probe history.
- The -pkgname and -description flags are optional. They let you include a name and notes within the contents.xml to assist in later identification.

<table>
<thead>
<tr>
<th>Option</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-description &lt;text&gt;</td>
<td>optional</td>
<td>Description of the exported archive file set as an attribute of the contents.xml file within the exported CAR. Description is displayed prior to a Studio based import.</td>
</tr>
<tr>
<td>-domain &lt;domain&gt;</td>
<td>optional</td>
<td>User domain. The default value is composite.</td>
</tr>
<tr>
<td>-encrypt</td>
<td>optional</td>
<td>Encrypts communication between the command line and CIS using SSL sent over the dedicated HTTPS port. Use the -port option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port.</td>
</tr>
<tr>
<td>-excludejars</td>
<td>optional</td>
<td>Suppresses export of custom jars. By default the export does not include binary files such as custom Java procedure JAR files or JDBC driver JAR files.</td>
</tr>
<tr>
<td>-includeStatistics</td>
<td>optional</td>
<td>Includes any known resource cardinality statistics about data source table boundaries, column boundaries, and configurations when statistics gathering is enabled.</td>
</tr>
</tbody>
</table>
## Table 5. Options for the `backup_export` Command-Line Program

<table>
<thead>
<tr>
<th>Option</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-optfile &lt;file name&gt;</code></td>
<td>optional</td>
<td>Specifies an option file providing a way to pass options without using the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line. The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal. For example: backup_export -server localhost -user test -password password -pkgfile sample.car is the same as: backup_export -optfile sample.opt where <code>sample.opt</code> contains mandatory arguments and options: -server localhost -user test -password password -pkgfile sample.car</td>
</tr>
<tr>
<td><code>-password &lt;password&gt;</code></td>
<td>mandatory</td>
<td>Password of the administrative user performing the export.</td>
</tr>
<tr>
<td><code>-pkgfile &lt;file name&gt;</code></td>
<td>mandatory</td>
<td>Specifies the path and the file name created as the backup archive file. The file path specified must be accessible to the command line client. CIS passes data to the command line client and then the client writes that CAR file to the location specified.</td>
</tr>
<tr>
<td><code>-pkgname &lt;name&gt;</code></td>
<td>optional</td>
<td>Names an attribute in the contents.xml within the exported backup file. This option is likely to deprecated in future releases.</td>
</tr>
<tr>
<td><code>-port &lt;BasePortNum&gt;</code></td>
<td>optional</td>
<td>Specifies Web Services Base Port (HTTP) used to communicate with the Composite Server. The default value is 9400. Specification is optional if the port setting has not changed. NOTE: Specify the Web Services HTTP port even if the <code>-encrypt</code> option is specified. If <code>-encrypt</code> is specified then the tool will automatically add two to the port number specified here.</td>
</tr>
<tr>
<td><code>-server &lt;hostname&gt;</code></td>
<td>mandatory</td>
<td>Target CIS to which the utility will connect.</td>
</tr>
</tbody>
</table>
Table 5. Options for the backup_export Command-Line Program

<table>
<thead>
<tr>
<th>Option</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-user &lt;username&gt;</td>
<td>mandatory</td>
<td>Composite system administrative user name. To properly use backup_export the administrative user must have at least the following rights: Access Tools, Read All Resources, Read All Users, and Read All Config.</td>
</tr>
<tr>
<td>-verbose</td>
<td>optional</td>
<td>Generates descriptive output describing the export in the command line window.</td>
</tr>
</tbody>
</table>
Backup Import Syntax

Backup Import command imports the entire contents of an archive file created with the backup_export utility or Studio (refer to “Backup Export Syntax” on page 209 for export conditions).

Backup Import follows the import rules described in “Rules For Import” on page 218. Proper execution of the backup import command requires administrative privileges and a full server export CAR file.

backup_import
    -server <hostname> [-port <port number>] [-encrypt]
    -pkgfile <target/file name>
    -user <user name> -password <password> [-domain <domain>]
    -relocate <oldPath> <newPath> ...
    [-optfile <filename>] ...
    [-set <path> <type> <attribute> <value>]
    [-printinfo] [-overwrite] [-verbose]

Backup Import Syntax

Backup Import command imports the entire contents of an archive file created with the backup_export utility or Studio (refer to “Backup Export Syntax” on page 209 for export conditions).

Backup Import follows the import rules described in “Rules For Import” on page 218. Proper execution of the backup import command requires administrative privileges and a full server export CAR file.

backup_import
    -server <hostname> [-port <port number>] [-encrypt]
    -pkgfile <target/file name>
    -user <user name> -password <password> [-domain <domain>]
    -relocate <oldPath> <newPath> ...
    [-optfile <filename>] ...
    [-set <path> <type> <attribute> <value>]
    [-printinfo] [-overwrite] [-verbose]
# Command-Line Options for backup_import

Table 6. Options for the backup_import Command-Line Program

<table>
<thead>
<tr>
<th>Option</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-domain &lt;Domain&gt;</td>
<td>optional</td>
<td>User domain. The default value is composite.</td>
</tr>
<tr>
<td>-encrypt</td>
<td>optional</td>
<td>Encrypt communication between the command line and CIS using SSL sent over the dedicated HTTPS port. NOTE: When using the -encrypt option, the HTTPS port is automatically used. Use the -port option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port.</td>
</tr>
</tbody>
</table>
| -optfile <File Name> | optional | Specifies an option file providing a way to pass options without using the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line. The contents of the options file are the same strings you would use on the command line. Additionally line breaks (new lines) are allowed in the options file, in contrast to the command line which does not normally permit extra line breaks or Enter keystrokes. For example: 
backup_import
  -server localhost -user test
  -password password -pkgfile sample.car 
is the same as:
backup_import
  -optfile sample.opt
  where sample.opt contains mandatory arguments and options:
  -server localhost
  -user test
  -password password
  -pkgfile sample.car |
| -overwrite    | optional           | This option does a destructive import overwriting any duplicate resources with the identical resource path. |
| -password <Password> | mandatory | Password of the administrative user performing the import. |
Table 6. Options for the backup_import Command-Line Program

<table>
<thead>
<tr>
<th>Option</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-pkgfile &lt;FileName&gt;</td>
<td>mandatory</td>
<td>Specifies the location and file name of the CAR file that is to be read from as the backup archive file. The -pkgfile target file must be a CAR file exported with either backup_export or using the Studio facility for Full Server Backup.</td>
</tr>
<tr>
<td>-port &lt;BasePortNum&gt;</td>
<td>optional</td>
<td>Specifies Web Services Base Port (HTTP) used to communicate with the Composite Server. The default value is 9400. Specification is optional if the port setting has not changed. Note: Specify the Web Services HTTP port even if the -encrypt option is specified. If -encrypt is specified then the tool will automatically add two to the port number specified here.</td>
</tr>
<tr>
<td>-printinfo</td>
<td>optional</td>
<td>This option disables actual import, and instead allows for inspection of the archive file. PrintInfo displays properties of the CAR file to the command window and exposes some impacts of import with information such as user name, source server with port number, source Java version, user domain, creation date of the archive file, source operating system, and archive type.</td>
</tr>
<tr>
<td>-relocate &lt;old path&gt; &lt;new path&gt;</td>
<td>optional</td>
<td>Specify a new location resource name path for top-level items. Specify the old path and the new path using the resource name. The -relocate option may be used to exclude specified resources from import. Set the -relocate option with the &lt;new path&gt; attribute set to &quot;NOIMPORT&quot; and the resources designated by the &lt;old path&gt; attribute will not be imported. The following example option stops all resources in the /shared/OldProject container from being imported from the CAR file. -relocate /shared/OldProject NOIMPORT</td>
</tr>
<tr>
<td>-server &lt;HostName&gt;</td>
<td>mandatory</td>
<td>Target CIS to which the utility will connect to for import of the CAR file defined resources.</td>
</tr>
</tbody>
</table>
The Composite resource name is the `<path>`. The `<type>` is always equal to "DATA_SOURCE" when using the set option with the attributes named above. The `<attribute>` can be: classpath, host, port, database, user, or password. Set `<value>` to a valid entry for the selected attribute. String values may be enclosed with double quotes to allow for spaces in the `<value>`. Example:

```
./pkg_import.sh -pkgfile MyCustJavaDB.car -optfile C:\X.opt -set /shared/datasources/DBCustom_Java DATA_SOURCE classpath "C:\Program Files\JavaDev;D:\My Documents\Java Joe"
```

The set option may be repeated as often as is necessary to set different attributes. Multiple classpaths can be set with a single statement. When executing backup_import from a Windows system use the semicolon as a delimiter where `<value>` could be:

```
C:\DevZone\ATeam\Jars\my.jar;D:\Current\Ref\classes
```

When executing the pkg_import from a UNIX/Linux system use colons as the delimiter. For example:

```
/lib/ext/classes:/lib/src/jars
```

- `<set <path> <type> <attribute> <value>>` optional
  Enables resource attribute changes during import. Use the -set option to change the data source attribute value(s) of classpath, host, port, database, user, or password when deploying a .car file to a new location like a production server. The Composite resource name is the `<path>`. The `<type>` is always equal to "DATA_SOURCE" when using the set option with the attributes named above. The `<attribute>` can be: classpath, host, port, database, user, or password. Set `<value>` to a valid entry for the selected attribute. String values may be enclosed with double quotes to allow for spaces in the `<value>`. Example:

```
./pkg_import.sh -pkgfile MyCustJavaDB.car -optfile C:\X.opt -set /shared/datasources/DBCustom_Java DATA_SOURCE classpath "C:\Program Files\JavaDev;D:\My Documents\Java Joe"
```

The set option may be repeated as often as is necessary to set different attributes. Multiple classpaths can be set with a single statement. When executing backup_import from a Windows system use the semicolon as a delimiter where `<value>` could be:

```
C:\DevZone\ATeam\Jars\my.jar;D:\Current\Ref\classes
```

When executing the pkg_import from a UNIX/Linux system use colons as the delimiter. For example:

```
/lib/ext/classes:/lib/src/jars
```

- `<user <UserName>>` mandatory
  Composite system administrative user name. To properly use backup_import the administrative user must have at least the following rights: Access Tools, Modify All Resources, Modify All Users, and Modify All Config.
Chapter 7  Utilities

Table 6. Options for the backup_import Command-Line Program

<table>
<thead>
<tr>
<th>Option</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-verbose</td>
<td>optional</td>
<td>Generates descriptive output describing the export in the command line window. By default the verbose option is not engaged and only error messages are displayed.</td>
</tr>
</tbody>
</table>

Notes

- The -pkgfile target file must be a .car file exported with either backup_export or using the Studio facility for Full Server Backup.
- The -verbose option causes informational messages to be displayed after importing. Without this option, only error messages are displayed.
- The -set option allows data source connection information to be explicitly specified or changed from the original during import.
  
  [-set <path> <attribute> <value>]

  This option is typically used when deploying a .car file to a production server. The properties most commonly changed are: host, port, database, user, password

Set option

The following attributes of the -set option may be invoked when importing data sources:

- user <login> or <username> or error depending on source type
- password <password> or error depending on source type
- user2 <appUserName> or error if not Oracle EBS
- password2 <appPassword> or error if not Oracle EBS
- host <urlIP> or <dsn> or <server> or <appServer> or <url> or <root> or error depending on the source type
- port <urlPort> or <port> or error depending on source type
database <urlDatabaseName> or <enterprise> or <appServer> or error depending on the source type
path <root> or <url> or error depending on source type
annotation

Example usage to change the password property of a data source:
```
pkg_import mycar.car -set /shared/myDataSource
DATA_SOURCE password myNewPassword
```
In this example, -set is the option; DATA_SOURCE is the type of the resource being imported, and password is the property that is being changed.

Rules For Import

Importing follows some rules to resolve conflicts during import. These rules are:

1. If an imported resource does not exist, it is created. The person performing the import gets appropriate privileges as the creator (such as READ|WRITE for a folder or READ|WRITE|EXECUTE for a procedure). If the user is in the admin group and has requested -includeaccess, then the owner of the resource is set as it was before and any privileges in the import are also put in place.

2. If a resource is imported to a non-existent folder, the folder (and any parent folders of that folder that do not yet exist) is created with the importing user getting READ|WRITE privilege and ownership of these folders. Auto-creation of missing folders is not supported in the Composite Data Services area.

3. If a resource already exists and it is also being imported, the old version is overwritten (assuming you have the WRITE privilege) in all ways, except the following:
   3.1 The owner is not changed. The original owner retains ownership.
   3.2 Privileges for users that are not explicitly changed by the import are left intact. For example, if abe has READ|WRITE and bob has READ|WRITE, and the import lists abe as READ but does not mention bob then abe’s privileges are updated but bob’s are left intact.
   3.3 If the resource is a folder or data source, its children resources are not removed.
4. Restrictions

4.1 The configuration settings (done through the Administration > Configuration menu option in the Studio) are not carried over when you export/import a resource using the Studio.

4.2 You cannot create a resource in a folder where you do not have the WRITE privilege.

4.3 You cannot overwrite a resource unless you have the WRITE privilege for that resource.

4.4 You cannot export just part of a physical data source. It is either all or nothing.

4.5 You cannot import just part of a physical data source. If you import, you must include the source definition itself.

4.6 The Composite Data Services area has strict structure rules that are enforced.
   - You cannot import anything that was exported from the Composite Data Services area to outside of that area.

4.7 You cannot import anything that was exported from outside the Composite Data Services area into that area.
**composite**

The command-line program `composite.bat` (for Windows) or `composite.sh` (for UNIX) can be used to stop or start Composite Server from a command-line interface. Examples are given here using the `*.sh` command.

- **To start or stop, or restart the server**
  1. Make sure that the monitor is active.
  2. Run the following command:
     ```
     <installation_directory>/bin/composite.sh server
     <start|stop|restart> -user <username> -password <password>
     ```

- **To start, stop, or restart the monitor, use the following command**
  ```
  <installation_directory>/bin/composite.sh monitor
  <start|stop|restart>
  ```
  Starting the monitor automatically starts the server.
  Stopping the monitor automatically stops the server.
  Restarting the monitor automatically stops and restarts the server.

**Note**

If you plan to run the monitor process manually and wish to keep the monitor process running even after you log off the system, you need to run the following command:

```
nohup <installation_directory>/bin/composite.sh monitor
<start|restart>
```

- On Windows, if you plan to run the monitor process manually and wish to keep the monitor process running even after you log off the system, you need to set `Server Ignore Signals` to `True`, as follows:
  1. Go to Administration > Configuration > Composite Information Server Components > Composite Server > Configuration > Monitor > Server Ignore Signals(On Monitor Restart).
  2. Set the Value to `True` and the restart the monitor.
To run the server as a foreground process with no monitor

1. Stop the monitor.
2. Run the following commands, as needed:
   <installation_directory>/bin/composite.sh server <run|debug>
   <installation_directory>/bin/composite_server.sh <run|debug>

The commands with the debug option also enable Java debugging on port 8000. All those actions only output to log files. These commands may be used in order to obtain thread dumps or debug a server issue without the monitor getting in the way.

If you are running the server with no monitor with one of the commands above, a monitor start will kill that server process and restart a new one in the background.

Note: If you plan to run the server process manually and wish to keep the server process running even after you log off the system, you need to run the following command:
   nohup <command> &

where <command> refers to one of the commands listed above in this section To run the server as a foreground process with no monitor.

- On Windows, if you plan to run the server process manually and wish to keep the server process running even after you log off the system, you need set Server Ignore Signals to True, as follows:
  Go to Administration > Configuration > Composite Information Server Components > Composite Server > Configuration > Monitor > Server Ignore Signals(On Monitor Restart).
  Set the Value to True and restart the monitor.
To start, stop, or restart the repository that was installed during the installation, use the following command

```
composite.sh repo <start|stop|restart> -osuser <osusername> -user <username> -password <password>
```

where:
- `osusername`: Username of the account that will run the repository process
- `username`: Repository database user name
- `password`: Repository database user password

This command is only supported for a repository that was installed during the installation of Composite Server.

**Note** On Windows, the usage is as follows:

```
composite.bat repo <start|stop|restart|install|uninstall>
```

### Stopping and Starting the Server on Windows Startup Program

On Windows, you can stop/start the server through the startup program without a command-line interface.

**To stop Composite Server manually**

Use the following step:

- Select Start > All Programs > Composite Software > Composite Software (version) > Server > Stop Composite Server (version) from the Windows desktop.

**To start Composite Server manually**

Use the following step:

- Select Start > All Programs > Composite Software > Composite Software (version) > Server > Start Composite Server (version) from the Windows desktop.
install_services

The install_services.sh script can be used from a command-line interface to automatically re-start the server and the repository on UNIX.

If at anytime after installing the software you re-start the installation machine, Composite Server and the metadata repository will NOT start automatically (unlike when they start automatically after a successful installation of the software). In order for the installation machine to automatically start/stop the server during a re-start, you should run a script named install_services.sh, which would install two Composite service files (csw.repository and csw.server) and configure them as described here.

To configure the Composite service files csw.repository and csw.server

1. Log into the installation machine as root.
2. Change the working directory to the bin directory in the installation directory ($installation_directory)/bin).
3. Run the following command:
   install_services.sh

   This command prompts for a user name, and other details to configure the service files csw.repository and csw.server accordingly.

   It installs csw.repository and csw.server into an appropriate location on the installation machine and configures them.

Running install_services.sh does not interrupt any repository/server processes that are running, but prepares the machine for automatically starting those processes during re-start of the UNIX based computer.
model_import

The model_import command-line utility program enables import of metadata models from third-party data modeling tools to Composite Server. The model_import utility is available for execution from:

<composite_installation_directory>/bin

Automate the modeling import task with the model import program command line for CIS running on 32-bit platforms.

Warning! Metadata model import is not compatible for execution on 64-bit platforms. The third party MetaIntegration modeling components do not support use on 64-bit platforms.

Minimal administrative rights (Access Tools) are required to use the model_import program.

The model_import program does not allow selective import of modeled tables or modeled views into the Composite Server. This program will always import all the contents (tables and views) in the model. For a selective import of model tables and model views, use Composite Studio.

The following table lists the parameters to use in the command line program, model_import.bat to view the contents of a model:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Mandatory/Optional</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-file &lt;file name&gt;</td>
<td>mandatory</td>
<td>Model file to import. Always needed.</td>
</tr>
</tbody>
</table>
The options file feature provides a way to pass options without using the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line.

The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal. For example,

```
model_import
-file Demo.dm1
-type EmbarcaderoEr Studio
-viewContent
```

is the same as:

```
model_import
-optfile sample.txt
```

where `sample.txt` contains the following options with new lines):

```
-file Demo.dm1
-type EmbarcaderoErStudio
-viewContent
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Mandatory/Optional</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-optfile &lt;file name&gt;</td>
<td>optional</td>
<td>Options file. The options file feature provides a way to pass options without using the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line. The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal. For example, <code>model_import -file Demo.dm1 -type EmbarcaderoErStudio -viewContent</code> is the same as: <code>model_import -optfile sample.txt</code> where <code>sample.txt</code> contains the following options with new lines): <code>-file Demo.dm1 -type EmbarcaderoErStudio -viewContent</code></td>
</tr>
<tr>
<td>-type &lt;model type and version&gt;</td>
<td>mandatory</td>
<td>Use one of the following: CaErwin7Xml EmbarcaderoErStudio</td>
</tr>
<tr>
<td>-viewContent</td>
<td>mandatory</td>
<td>View the contents of the model without actually importing and applying changes.</td>
</tr>
</tbody>
</table>
The following table lists the parameters to use in the command line program, `model_import.bat` to **import** a model:

Table 8. Parameters to use with the `model_import` program for an import

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Mandatory/Optional</th>
<th>Comments</th>
</tr>
</thead>
</table>
| `-dest <destination path>` | mandatory          | Destination path must be specified for model import success. The `model_import` command does not create the destination path automatically and an exception will be thrown if the path is not specified or does not exist.  
Valid syntax example: `-dest /users/composite/test`  
Invalid syntax example: `-dest C:\` |
| `-encrypt`      | optional           | Encrypts communication between the command line and CIS using SSL sent over the dedicated HTTPS port.  
NOTE: When using the `-encrypt` option, the HTTPS port is automatically used. Use the `-port` option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port. |
| `-domain <domain>` | optional           | User domain. Default=composite                                                                                                             |
| `-file <file name>` | mandatory          | Model file to import.                                                                                                                      |
Table 8. Parameters to use with the model_import program for an import

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Mandatory/Optional</th>
<th>Comments</th>
</tr>
</thead>
</table>
| -map <model source path> <resource path in Composite> | optional | The path to the source in the model and the destination path to the resource in Composite must be delimited by a white space. Also, there should either be a white space or a new line between two adjacent mappings. Example:  
- map <source table1> <destination table1>  
- map <source table2> <destination table2>  
- map <source table3> <destination table3> |
The options file feature provides a way to pass options without using the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line.

The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal. For example,

```bash
model_import
-server localhost
-user test
-password password
-file Demo.dm
-type EmbarcaderoErStudio -dest C:\
-overwrite new
```

is the same as:

```bash
model_import
-optfile sample.txt
```

where `sample.txt` contains the following options with new lines:

```bash
-server localhost
-user test
-password password
-file Demo.dm
-type EmbarcaderoErStudio -dest C:\
-overwrite new
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Mandatory/Optional</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>--optfile &lt;file name&gt;</td>
<td>optional</td>
<td>Options file.</td>
</tr>
</tbody>
</table>

Table 8. Parameters to use with the `model_import` program for an import
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Mandatory/Optional</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-overwrite &lt;overwrite option&gt;</td>
<td>optional</td>
<td>Use one of the following options: merge (default option) replace new</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For a description of these terms, see the section To re-import an external model in the chapter Resource Management Basics in the User’s Guide.</td>
</tr>
<tr>
<td>-password &lt;password&gt;</td>
<td>mandatory</td>
<td>Password to use.</td>
</tr>
<tr>
<td>-port &lt;BasePortNum&gt;</td>
<td>optional</td>
<td>Specifies Web Services Base Port (HTTP) used to communicate with the Composite Server. The default value is 9400. Specification is optional if the port setting has not changed. NOTE: Specify the Web Services HTTP port even if the -encrypt option is specified. If -encrypt is specified then the tool will automatically add two to the port number specified here.</td>
</tr>
<tr>
<td>-server &lt;hostname&gt;</td>
<td>mandatory</td>
<td>Host with which to connect</td>
</tr>
<tr>
<td>-type &lt;model type and version&gt;</td>
<td>mandatory</td>
<td>Use one of the following: CaErwin7Xml EmbarcaderoErStudio</td>
</tr>
<tr>
<td>-user &lt;user name&gt;</td>
<td>mandatory</td>
<td>User name to log into Composite</td>
</tr>
<tr>
<td>-verbose</td>
<td>optional</td>
<td>Generates more output in some cases</td>
</tr>
</tbody>
</table>
The Model Import Command

You can view the contents of a model and/or just import it to Composite. Both tasks are described here.

To view the contents of a model, run the following command from the directory where the model_import program is:

```
model_import
-file <file name> -type <model type and version>
-viewContent
```

Example:

```
model_import
-file C:\example.DM1 -type EmbarcaderoErStudio
-viewContent
```

Output:

```
MODEL: /example
DESIGN_PACKAGE: /example/Logical
TABLE: /example/Logical/Customers
TABLE: /example/Logical/OrderDetails
TABLE: /example/Logical/orders
TABLE: /example/Logical/Products
VIEW: /example/Logical/View1
```
To import a model to Composite, run the following command from the directory where the model_import program is:

```bash
model_import -server <host name> [-port <port>] [-encrypt]
-user <user name> -password <password> [-domain <domain>]
-file <file name> -type <model type and version>
-dest <destination path>
[-map <model path> <resource path>] ...
[-overwrite <overwrite option>]
[-optfile <filename>] [-verbose]
```

A `model_import` example without an `-overwrite` option:

```bash
model_import -server localhost
-user test -password password
-file C:\example.DM1 -type EmbarcaderoErStudio
-dest /users/composite/test
```

An example with an `-overwrite` option:

```bash
model_import -server localhost
-user test -password password
-file C:\example.DM1 -type EmbarcaderoErStudio
-dest /users/composite/test
-overwrite merge
```

An example with the `-optfile` option:

```bash
model_import -optfile C:\model.txt
```

where, `model.txt` is the options file containing the necessary information about the host name, etc.
pkg_export and pkg_import

These command line utilities provide two ways of exporting and importing specified resources from the Composite Server:

- Export to and import from a CAR file (-pkgfile option)
- Export to and import from a hierarchical directory (-pkgdir option)

Selected directories or individual resources may be exported to a single discrete CAR file or they may be exported to a hierarchical directory that mirrors the Composite Server resource tree directory structure in Composite Studio.

Advantages of exporting and importing to a single CAR file include:

- Aggregates all metadata files and objects into a single file
- Portability - multiple resource files are packaged in a compressed archive.
- All resource and metadata objects may be exported/imported.

Disadvantages of CAR files include:

- No incremental update available. Any changes to a CIS resource backed up to a CAR file requires re-creation of the CAR file to capture modifications.
- Exported CAR file objects are in a proprietary format that is not easily modified.

Advantages of exporting and importing to a directory structure include:

- All incremental changes (additions, modifications, and deletions) made on the Composite Server may be captured with a single pkg_export execution that updates only those files affected by the changes.
- Exported files are stored in a hierarchical directory structure that mimics the structure created, using the Composite Server.
- SQL and metadata files are stored in file formats that may be modified.
- Directory and file updates compatible with many source code control systems

Disadvantages of directory package exports:

- JARs, users, groups, domains, and rights in the directory export are not supported for import in the 4.6 release.
The utilities, `pkg_export` and `pkg_import`, are available in the `bin` directory of the installation directory. Different versions of the utilities are provided for use and execution in different computing environments:

For Windows installations:
- `pkg_export.bat` and `pkg_import.bat`

For UNIX based installations:
- `pkg_export.sh` and `pkg_import.sh`

From the Windows command prompt (`cmd.exe`) you may get started with the following line (given that CIS is in the default installation path):

```
C:\Program Files\Composite Software\CIS <version>\bin>START pkg_export
```

Executing the above line in the `cmd.exe` window will display the help text with syntax for usage, arguments, and available options.

**Note** The Composite Studio menu option to export selected resources into CAR files is equivalent to using the `pkg_export` with the `-pkgfile` option. For details on using Studio to export and import selected resources refer to the chapter `Resource Management Basics` in the `User's Guide`.

**Package Export Command Line Utility**

This utility exports specified directories and resources. The package export command-line utility can be thought of as if it were two different utilities because some of the options that are available to each of the two primary types (CAR file `-pkgfile` and directory `-pkgdir`) of export are not interoperable.

Two sections follow to describe the various mandatory switches and options available for use with each option of the package export command-line utility:

- `pkg_export -pkgfile`
- `pkg_export -pkgdir`
Package Export to a CAR file (-pkgfile option)

For export of specified resources to a CAR file:

```
pkg_export -pkgfile <FileName>
<NamespacePath> [...] -server <hostname> [-port <port>] [-encrypt]
-user <user> -password <password> [-domain <domain>]
[-pkgname <name>] [-description <text>]
[-optfile <filename>] [...] [-rebindable <path> <description>] ...
[-includeaccess] [-includecaching]
[-includeSourceInfo] [-includeJars]
[-includeAllUsers] [-includeUser <domain> <user>] ...
[-includeGroup <domain> <group>] ...
[-includeDomain <domain>] ...
[-includeRequiredUsers] [-includeDependencies]
[-includeStatistics]
[-verbose] [-quiet]
```

**Examples**

```
pkg_export -pkgfile MyExport.car
    shared/procedures/myParameterizedQuery
    -server localhost
    -user admin -password AdminPassword
    -includeDependencies -rebindable shared/sources/ds_orders/products "This needs rebinding to the production data source."
```

In the example above, `myParameterizedQuery` is exported with dependencies that in this case includes the products table from the orders data source.

The `-rebindable` option is specified to notify or remind the user during an import that the products resource will need to be rebound. During import a message prompt and the `<description>` get displayed within the command prompt and they also appear when the resulting export CAR file is imported using Composite Studio. Rebinding must be done manually after the import unless the `-rebind` option specifies the new resource for rebinding during import.
Another example:

```
pkg_export -pkgfile Sources_Backup.car
    shared/sources
    -optfile C:/BackupScripts/Sources/weekly.opt
    -includeDependencies
    -includesourceinfo
```

In this example `shared/sources` is backed up to `Sources_Backup.car`.

The option file, `weekly.opt`, must contain any mandatory arguments that were missing in the original command:

```
-server localhost
-user DBASecure1
-password Password
-domain EnterpriseLDAP
```

An options file could be dynamically generated to specify options and arguments including the user name, password, and domain so that programmatic backups may be set while obfuscating the DBA login from display on either the application window or in the file prior to running the scheduled script.

The following table of `pkg_export -pkgfile` parameters and arguments is organized by the order of appearance.

<table>
<thead>
<tr>
<th><code>pkg_export -pkgfile</code> Parameters and Args</th>
<th>Optional / Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-pkgfile <code>&lt;FileName&gt;</code></td>
<td>mandatory</td>
<td>Specifies new CAR file name.</td>
</tr>
<tr>
<td>-server <code>&lt;HostName&gt;</code></td>
<td>mandatory</td>
<td>Composite Server host to which the utility will connect</td>
</tr>
<tr>
<td>-port <code>&lt;BasePortNum&gt;</code></td>
<td>optional</td>
<td>Specifies Web Services Base Port (HTTP) used to communicate with the Composite Server. The default value is 9400. Specification is optional if the port setting has not changed from the default. NOTE: Specify the Web Services HTTP port even if the -encrypt option is specified. If -encrypt is specified then the tool will automatically add two to the port number specified here.</td>
</tr>
</tbody>
</table>
-encrypt

Optional Encrypts communication between the command line and CIS using SSL sent over the dedicated HTTPS port.

NOTE: When using the -encrypt option, the HTTPS port is automatically used. Use the -port option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port.

-user <UserName>

Mandatory Composite system administrative user name. To properly use pkg_export the user must have ownership of the specified resource or at least read privilege on all the specified resources with: Access Tools and Read All Config rights.

-password <Password>

Mandatory Password for user profile used to export package.

-domain <Domain>

Optional User domain. The default value is "composite" and does not have to be stated unless the user profile used for export has another value.

From this row down the Parameters are listed alphabetically.

| -description "<Text>" | Optional | Package description of the archive file. Notation appears when Composite Studio is used to import the CAR.
| -includeAllUsers | Optional | Exports all domains, groups, and users to the export file. Requires the Read All Users right.
| -includeUser <DomainName> <UserName> | Optional | Includes the specified user in the export file. This option may be repeated to export multiple users. Repeat the option keyword -includeUser with arguments for the new domain and user as many times as is necessary.
| -includeGroup <DomainName> <GroupName> | Optional | Exports group information about the specified group in the export file.
| -includeDomain <DomainName> | Optional | Export the specified domain metadata to the export file. |
### pkg_export -pkgfile

<table>
<thead>
<tr>
<th>Parameters and Args</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-includeaccess</td>
<td>optional</td>
<td>Includes the current user access controls (privilege specifications) on the resources in the export file. Default setting does NOT include access control even when exported by an administrator. An error may occur if this option is used and the exporting user is not a member of the admin group.</td>
</tr>
<tr>
<td>-includecaching</td>
<td>optional</td>
<td>Includes the details of caching on views and procedures in the export file.</td>
</tr>
<tr>
<td>-includeDependencies</td>
<td>optional</td>
<td>Gathers and includes all dependent resources for the resources you choose to export.</td>
</tr>
<tr>
<td>-includeJars</td>
<td>optional</td>
<td>Includes the .JAR files in the export file.</td>
</tr>
<tr>
<td>-includeRequiredUsers</td>
<td>optional</td>
<td>Includes the information about the required users in the export file.</td>
</tr>
<tr>
<td>-includeSourceInfo</td>
<td>optional</td>
<td>Data source connection details such as user name, password, host name, and port are not included by default. Specify -includeSourceInfo to include these.</td>
</tr>
<tr>
<td>-includeStatistics</td>
<td>optional</td>
<td>Includes any resource stats known about the table boundaries, column boundaries, etc.</td>
</tr>
</tbody>
</table>
The options file feature provides a way to pass options without using the command line. Use the options file for scripting and ensuring that sensitive information is not displayed on the operating system command line.

The contents of the options file are the same strings you would use on the command line. Unlike most command prompt windows, new lines in the text file are legal.

For example,

```
backup_export
   -server localhost
   -user test
   -password password
   -pkgfile sample.car
```

is the same as:

```
backup_export
   -optfile sample.opt
```

where `sample.opt` contains either:

```
   -server localhost -user test
   -password password
   -pkgfile sample.car
```

or (this one with new lines):

```
   -server localhost
   -user test
   -password password
   -pkgfile sample.car
```

This option is also available for use in `pkg_import`.

<table>
<thead>
<tr>
<th>pkg_export -pkgfile Parameters and Args</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
</table>
| -optfile `<FileName>`                  | optional            | Options file. The options file feature provides a way to pass options without using the command line. Use the options file for scripting and ensuring that sensitive information is not displayed on the operating system command line. The contents of the options file are the same strings you would use on the command line. Unlike most command prompt windows, new lines in the text file are legal. For example, `backup_export
   -server localhost
   -user test
   -password password
   -pkgfile sample.car`
   is the same as:
   `backup_export
   -optfile sample.opt`
   where `sample.opt` contains either:
   `-server localhost -user test`  
   `-password password`  
   `-pkgfile sample.car`
   or (this one with new lines):
   `-server localhost`  
   `-user test`  
   `-password password`  
   `-pkgfile sample.car`
   This option is also available for use in `pkg_import`. |
| -pkgname `<Name>`                      | optional             | Package name may be set, but this string is not currently used. Spaces are allowed but punctuation is not. |
pkg_export -pkgfile

Parameters and Args | Optional/Mandatory | Comments
--- | --- | ---
-rebindable <Path> <Description> ... | optional | Marks a resource dependency for rebinding on import. When a rebindable resource is imported a reminder and the <Description> are displayed on the command line. The -rebind option must be specified on import for that action to take place on import. That message is also displayed in Studio to prompt designation of a new resource (path) as the resource dependency.
-verbose | optional | This option causes verbose reporting of information much like the GUI provides instead of the normal terse reporting.

**Note** The pkg_export command exports each of the listed resources (as specified using a namespace path such as /users/composite/manager/sources or /shared/projects/pegasus). It does not include any domains, users, groups, or server settings.

- This command can be used by any user. If you do not have the READ privilege to any of the specified resources, the export will fail. If you do have the READ privilege for all of them, then all resources that are children of those resources will also be included as long as you have the READ privilege on those children.

  - Caution: Users who attempt export without the READ privilege on a child resource will not be able to export the child resource, and they will not be notified of the omission of the child from the export package.

- By default, access information (privilege settings) are **not** included in the export. The -includeaccess option must be provided if you want privilege settings included in the archive file. The -includeaccess option is ignored if you are not logged in as an administrator with the Read All Resources right.

- By default, no caching configurations are included in the export. The -includecaching option must be specified to include cached data from materialized views, configurations that include scheduling for cache refreshes.
By default, physical data source connection details such as usernames, passwords, host names, and ports are blanked out during an export. The -includesourceinfo option must be provided if you want those details included. Note that if passwords are included, they are encrypted.

- The -pkgname and -description flags are optional. They let you include your specific information in the archive file for later identification.
- The -verbose option reports if problems are encountered during the export

**Package Export to a Directory (-pkgdir option)**

The -pkgdir option exports resources to a directory for incremental update. The resource definitions and file objects are externalized from the Composite Server and they may be modified given certain precautions.

**Caution**  Since privilege settings and resource metadata are exported as files that may be modified, they must be protected from intentional or inadvertent changes.

One of the primary advantages of externalizing resources with the -pkgdir option is that exports may be quickly performed that incrementally update only those files that have been created, changed, or deleted. This is great for source control systems that safeguard files and track version changes.

- **Exporting to a new directory** - When a package export is made to a new directory all Composite defined resources in the specified Composite directories are exported to a hierarchical directory structure that directly parallels Composite Studio resource organization.

- **Exporting to an existing externalized directory** - To incrementally update an existing externalized directory use the pkg_export -pkgdir command and exclude the Composite resource namespace path. By default, the package export will incrementally update only those files that have changed since the last export. Make sure to specify the existing -pkgdir <existing_externalized_directory> without specifying the Composite resource namespace path to engage.

When exporting to an existing externalized directory, the Composite resource namespace path should not be specified as the directory already has a manifest file that specifies what Composite resources will be updated in the export directory.
During the first \texttt{-pkgdir} export, the manifest file is initialized and set with a specific set of Composite resources and/or directories that will be updated in that \texttt{-pkgdir} directory. The manifest file will always define those Composite resources that will be stored in that particular physical location. The manifest file should not be modified under normal conditions, but the timestamp may be changed to enable an export of resources changed after a particular time.

Once defined the manifest file The manifest file is inspected and only those objects that have changed will be exported and saved to the external directory.

**Exporting all with the \texttt{-full} option** - Use the \texttt{-full} option to export everything (all resources changed or not) in the Composite resource namespace path. The \texttt{-full} option forces all Composite defined resources named by the root directory in the manifest file to be updated. All resources are exported, overwriting everything in the specified path ensuring that the externalized files and the Composite Server are synchronized.

**Caution** When a lot of resources must be exported at once (or when exporting the entire Composite directory) on a Windows server under high load conditions, one must first modify the Windows server to allow more sockets per user and reduce the TCP timed wait delay. Windows can safely accommodate 65534 sockets per user in the TCP/IP scheme and TCP timed wait can be decreased to 30 seconds to release socket resources more quickly.

By default, most Windows operating systems do not have the following keys so they must be created to tune the system for high-volume package exports.

Navigate to key:

\begin{verbatim}
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcp\Parameters
\end{verbatim}

Create the following two keys:

\begin{verbatim}
DWORD Value Name="MaxUserPort", Value=65534 (Decimal)
DWORD Value Name="TcpTimedWaitDelay", Value=30 (Decimal)
\end{verbatim}

Once you've set the parameters, restart the machine for them to take affect.
Note  Limitation - Externalization (package export to a directory) in the 4.6 release does not support export and import of: JARs, users, groups, domains, and rights in the packaged directory export.

Usage of Package Export to a directory (-pkgdir option)

As stated previously, the pkg_export utility is available in the bin directory of the CIS installation. Windows and Unix specific versions of the utility are available.

pkg_export
  -pkgdir <directory>
  <NamespacePath> [...]
  -server <hostname> [-port <port>] [-encrypt]
  -user <user> -password <password> [-domain <domain>]
  [-pkgname <name>] [-description <text>]
  [-optfile <filename>] ...
  [-full]
  [-messagesOnly]
  [-fileEncoding <encoding>]
  [-listIgnored]
  [-verbose] [-quiet]

Examples

The default administrative user profile is used to execute the following command which externalizes all resources defined by the CIS instance on the localhost in the resource path: /shared/examples/ds_orders. All the CIS metadata object definitions are exported as XML readable files to the C:/temp directory.

pkg_export.sh -pkgdir C:/temp /shared/examples/ds_orders
  -server localhost -user admin -password admin

The above example establishes a manifest file in C:/temp that will reserve the directory for sync of all resources in /shared/examples/ds_orders path. Later, to see what files have been changed and what would be exported the -messagesOnly option may be specified so that nothing is actually exported on execution of the command:
To incrementally synchronize that externalized directory execute this command:

```
pkg_export.sh -pkgdir C:/temp -server localhost -user admin
                -password admin -messagesOnly
```

Use the `-encrypt` option to securely backup a directory to some local or locally mapped drive from across an unsecured network. Example:

```
pkg_export.sh -pkgdir Z:/Secure /shared/examples/ds_orders
                -server 111.123.456.99 -port 2220 -encrypt -user admin999
                -password Secured999 -domain SomeLDAPDomain
```

With the above example command, an SSL/HTTPS connection with a Composite Server at the specified IP address is established. The specified port is the designated Composite Server HTTP base port, but the `-encrypt` option changes the actual connection to use the HTTPS port. The encrypted connection enables a secured login authentication. The Composite Server exports the requested XML files securely over the SSL connection to the client application and the client writes those files to the designated target directory `Z:/Secure`.

The following table of `pkg_export -pkgfile` parameters and arguments is organized by both the order of appearance and alphabetically.

<table>
<thead>
<tr>
<th><code>pkg_export -pkgdir</code> Parameters and Args</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-pkgdir &lt;Directory&gt;</code></td>
<td>mandatory</td>
<td>Specifies the absolute location for creation of a directory and placement of the export files. Example: <code>-pkgdir C:/SourceControl/Project1</code> Mapped directories must be available to the user on the command line client</td>
</tr>
</tbody>
</table>
### pkg_export -pkgdir

<table>
<thead>
<tr>
<th>Parameters and Args</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;NamespacePath&gt;</code></td>
<td>mandatory</td>
<td>Uses the Composite resource name convention to specify one or many resource directories for export. Example: <code>/shared/examples/ds_orders</code>. All resources within the specified Composite directory are exported to: <code>-pkgdir</code> <code>C:/Directory/specified</code></td>
</tr>
<tr>
<td><code>-server &lt;HostName&gt;</code></td>
<td>mandatory</td>
<td>Composite Server host to which the utility will connect. Default name is localhost.</td>
</tr>
<tr>
<td><code>-port &lt;BasePortNum&gt;</code></td>
<td>optional</td>
<td>Specifies Web Services Base Port (HTTP) used to communicate with the Composite Server. The default value is 9400. Specification is optional if the port setting has not changed. NOTE: Specify the Web Services HTTP port even if the <code>-encrypt</code> option is specified. If <code>-encrypt</code> is specified then the tool will automatically add two to the port number specified here.</td>
</tr>
<tr>
<td><code>-encrypt</code></td>
<td>optional</td>
<td>Encrypts communication between the command line and CIS using SSL sent over the dedicated HTTPS port. NOTE: When using the <code>-encrypt</code> option, the HTTPS port is automatically used. Use the <code>-port</code> option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port.</td>
</tr>
<tr>
<td><code>-user &lt;UserName&gt;</code></td>
<td>mandatory</td>
<td>User name for authorization of export. User must have Access Tools and ownership of the resources to be exported or the Read All Resources rights for proper export of all configurations.</td>
</tr>
<tr>
<td><code>-password &lt;Password&gt;</code></td>
<td>mandatory</td>
<td>Password for user profile used to export package.</td>
</tr>
<tr>
<td><code>-domain &lt;DomainName&gt;</code></td>
<td>optional</td>
<td>User domain. The default value is “composite” and does not have to be stated.</td>
</tr>
</tbody>
</table>
### pkg_export -pkgdir

<table>
<thead>
<tr>
<th>Parameters and Args</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-description &lt;text&gt;</td>
<td>optional</td>
<td>Textual description of the archive directory. Visible when selected for import with the Studio interface.</td>
</tr>
<tr>
<td>-full</td>
<td>optional</td>
<td>When a new directory is created all resources in the specified directory are exported. When an existing directory is the specified target incremental update is performed, exporting all resources that have changed since the last export. The -full option is actually meant for import and is non-functional in the 4.6 release.</td>
</tr>
<tr>
<td>-listIgnored</td>
<td>optional</td>
<td>Lists those items that are not exported</td>
</tr>
</tbody>
</table>
### Parameters and Args

<table>
<thead>
<tr>
<th>pkg_export -pkgdir</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-messagesOnly</td>
<td>optional</td>
<td>Preview an export using this option. No files are created, modified, or deleted but instead command line messages will list those files that will be added, modified, and deleted.</td>
</tr>
</tbody>
</table>
| -optfile <filename> | optional           | Options file. The options file feature provides a way to pass options using a file instead of the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line. The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal. For example,  

```bash
pkg_export -pkgdir
-server localhost
-user MyAdmin
-password CleartextPassword
-pkgfile Backup.car
```

is the same as:  

```bash
backup_export
-optfile sample.opt
```

where `sample.opt` contains either:  

```bash
-server localhost -user MyAdmin
-password CleartextPassword
-pkgfile Backup.car
```

or (this one with new lines):  

```bash
-server localhost
-user test
-password password
-pkgfile Backup.car
```

This option is also available for use in pkg_import.
Package Import Command Line Utility

The package import (pkg_import) utility imports directories and resources from either a zipped Composite Archive (CAR) file or from an externalized directory of Composite resources rendered as XML files. The pkg_import utility is available for execution from the bin directory of the CIS install.

The package import command-line utility can be thought of as if it were two different utilities because some options for import from a CAR file -pkgfile are different from the options available for import from a directory using -pkgdir.

Use of the package import (pkg_import) command-line utility requires the following rights to properly restore Composite defined resources: Access Tools, Read and Modify All Config, Read and Modify All Resources, Read and Modify All Users. Import generally requires the most administrative rights as it will overwrite (effectively deleting) many types of resource objects, directories, user privileges, and other resource definitions.

The package or directory being imported and the options employed to import them will dictate what rights are actually needed to import, but by nature of the ability to overwrite resource definitions, import generally requires full admin rights.
Two sections follow to describe the various mandatory switches and options available for use with each option of the package export command-line utility:

- pkg_import -pkgfile
- pkg_import -pkgdir

**Package Import from a CAR file (-pkgfile option)**

Package import from a CAR file (-pkgfile) has the following generic form:

```
pkg_import -pkgfile <D:/irectory/Path/and/File_Name.car>...
- server <HostName> [-port <PortNumber>] [-encrypt]
- user <UserName> -password <Password> [-domain <Domain>]
[-relocate <OldPath> <NewPath>] ...
[-rebind <OldPath> <NewPath>] ...
[-set <path> <DataType> <Attribute> <Value>] ...
[-optfile <D:/irectory/Path/and/File_Name>]
[-printinfo] [-printroots] [-printusers]
[-printcontents] [-printreferences]
[-includeaccess] [-nocaching]
[excludelars] [-nosourceinfo]
[-overwrite] [-overrideLocks] [-messagesonly]
[-verbose] [-quiet]
```

**Examples**

In this example, `set` is the option; **DATA SOURCE** is the type of the resource being imported, and `password` is the attribute being changed:

```
pkg_import.sh -pkgfile C:/Store/EnterpriseArchive/mycar.car
- server localhost -user ProdAdmin -password adminPassWeird
- set /shared/myDataSource DATA SOURCE password MyNewPassword
```

In the next example, only `shared/procedures/myParameterizedQuery` is imported with its associated dependencies from the specified CAR file. The `relocate` option is used to move the query to a new directory.

```
pkg_import -pkgfile Z:/Archive/QA_Image99999.car
```
shared/procedures/myParameterizedQuery -server localhost
-user admin -password AdminPassword -includeDependencies
-relocate shared/procedures/myParameterizedQuery
shared/RestrictedUse_Procedures/myParameterizedQuery

### Package Import (-pkgfile) Mandatory Switches and Options

<table>
<thead>
<tr>
<th>pkg_import -pkgfile Parameters and Args</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-pkgfile &lt;FileName&gt;</td>
<td>mandatory</td>
<td>Specifies the import CAR file. The file name should be specified as an absolute path from a mapped directory. Multiple CAR files may be specified.</td>
</tr>
<tr>
<td>-server &lt;HostName&gt;</td>
<td>mandatory</td>
<td>Composite Server host to which the utility will connect.</td>
</tr>
<tr>
<td>-port &lt;BasePortNum&gt;</td>
<td>optional</td>
<td>Specifies Web Services Base Port (HTTP) used to communicate with the Composite Server. The default value is 9400. Specification is optional if the port setting has not changed. NOTE: Specify the Web Services HTTP port even if the -encrypt option is specified. If -encrypt is specified then the tool will automatically add two to the port number specified here.</td>
</tr>
<tr>
<td>-encrypt</td>
<td>optional</td>
<td>Encrypts communication between the command line and CIS using SSL sent over the dedicated HTTPS port. NOTE: When using the -encrypt option, the HTTPS port is automatically used. Use the -port option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port.</td>
</tr>
<tr>
<td>-user &lt;UserName&gt;</td>
<td>mandatory</td>
<td>User name of profile used to import. User rights specified by the target CIS instance grant permission to import and may restrict write privilege to import into designated directories only.</td>
</tr>
<tr>
<td>-password &lt;Password&gt;</td>
<td>mandatory</td>
<td>Password for user profile used to export package.</td>
</tr>
</tbody>
</table>
The options file feature provides a way to pass options using a file instead of the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line. The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal.

For example,

```bash
backup_export
    -server localhost
    -user test
    -password password
    -pkgfile sample.car
```

is the same as:

```bash
backup_export
    -optfile sample.opt
```

where `sample.opt` contains either:

```bash
    -server localhost -user test
    -password password
    -pkgfile sample.car
```
or (this one with new lines):

```bash
    -server localhost
    -user test
    -password password
    -pkgfile sample.car
```

This option is also available for use in `pkg_export`.

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameters and Args</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>pkg_import -pkgfile</td>
<td>-domain &lt;domain&gt;</td>
<td>optional</td>
<td>Enter domain for the user performing the import. If it is omitted the assumed value is &quot;composite&quot;.</td>
</tr>
<tr>
<td></td>
<td>-optfile &lt;FileName&gt;</td>
<td>optional</td>
<td>Options file.</td>
</tr>
</tbody>
</table>

The options file feature provides a way to pass options using a file instead of the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line. The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal.

For example,

```bash
backup_export
    -server localhost
    -user test
    -password password
    -pkgfile sample.car
```

is the same as:

```bash
backup_export
    -optfile sample.opt
```

where `sample.opt` contains either:

```bash
    -server localhost -user test
    -password password
    -pkgfile sample.car
```
or (this one with new lines):

```bash
    -server localhost
    -user test
    -password password
    -pkgfile sample.car
```

This option is also available for use in `pkg_export`.
### Optional/ Mandatory

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameters</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>-relocate</strong> <code>&lt;OldPath&gt;</code> <code>&lt;NewPath&gt;</code></td>
<td>optional</td>
<td>This option can be used multiple times. It is used to specify a new location for a top-level item. An error will occur if you try to relocate something that is not in the package or is not a top-level item.</td>
</tr>
<tr>
<td><strong>-rebind</strong> <code>&lt;OldPath&gt;</code> <code>&lt;NewPath&gt;</code></td>
<td>optional</td>
<td>Sets a new resource path for a dependency resource. The option may be repeated for as many dependencies as may be necessary. Migration from a development or testing environment to a production server deployment makes use of the -rebind option.</td>
</tr>
</tbody>
</table>
Table 7.1 Parameters and Args

<table>
<thead>
<tr>
<th>Command</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>pkg_import -pkgfile</td>
<td>-set &lt;path&gt; &lt;type&gt; &lt;attribute&gt; &lt;value&gt;</td>
<td>Changes the data source attribute value(s) of classpath, host, port, database, user, or password when deploying a .car file to a new location like a production server. The Composite resource name is the &lt;path&gt;. The &lt;type&gt; is always equal to “DATA_SOURCE” when using the set option with the attributes named above. The &lt;attribute&gt; can be: classpath, host, port, database, user, or password. Set &lt;value&gt; to a valid entry for the selected attribute. String values may be enclosed with double quotes to allow for spaces in the &lt;value&gt;. Example: <code>. /pkg_import.sh -pkgfile MyCustJavaDB.car -optfile C:\X.o -set /shared/datasources/DBCustom_Java DATA_SOURCE classpath &quot;C:\Program Files\JavaDev;D:\My Documents\Java Joe&quot;</code> The set option may be repeated to set different attributes. Multiple classpaths can be set with a single statement. When executing pkg_import from a Windows system use the semicolon as a delimiter where &lt;value&gt; could be something like: C:\DevZone\ATeam\Jars\my.jar;D:\Current\Ref\classes When executing the pkg_import from a UNIX/Linux system use colons as the delimiter. For example: <code>/lib/ext/classes:/lib/src/jars</code></td>
</tr>
<tr>
<td></td>
<td>-printinfo</td>
<td>Prints information such as user name, source server with port number, source Java version, user domain, creation date of the archive file, source operating system, and archive type.</td>
</tr>
<tr>
<td></td>
<td>-printroots</td>
<td>Prints the new path(s) to the imported resources.</td>
</tr>
</tbody>
</table>
### Parameters and Args

<table>
<thead>
<tr>
<th>pkg_import -pkgfile</th>
<th>Optional/Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-printusers</td>
<td>optional</td>
<td>Prints the user names of the owners of the imported resource(s) and their associated user groups.</td>
</tr>
<tr>
<td>-includeusers</td>
<td>optional</td>
<td>Imports all users present in the exported package car. By default domain, groups and user information are not included in either export or import. This option is also available for use in pkg_export.</td>
</tr>
<tr>
<td>-printcontents</td>
<td>optional</td>
<td>This option disables actual import, and instead allows for inspection of the archive file. Print contents displays properties of the CAR file to the command window and exposes some impacts of import with information such as user name, source server with port number, source Java version, user domain, creation date of the archive file, source operating system, and archive type.</td>
</tr>
<tr>
<td>-printreferences</td>
<td>optional</td>
<td>Prints a list of resources referred to by the imported resource(s).</td>
</tr>
<tr>
<td>-includeaccess</td>
<td>optional</td>
<td>Includes the current user access controls on the resources in the export file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>It defaults to not including access control even if you are an administrator. You get an error if you use this flag and are not logged in as a member of the admin group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This option is also available for use in pkg_export.</td>
</tr>
<tr>
<td>-nocaching</td>
<td>optional</td>
<td>Omits caching data and all caching configurations as if the caching of the exported resource were never set.</td>
</tr>
<tr>
<td>-excludejars</td>
<td>optional</td>
<td>Does not import the jar files.</td>
</tr>
</tbody>
</table>
The `pkg_import` command imports the resources in the archive file into the server following the import rules ("Rules For Import" on page 257). If this command is used on an archive created using `backup_export`, only the resource information will be used.

- By default, access information (ownership and privileges) are not imported. Any resources that are created as a result of the import are owned by you. Existing resources follow the import rules ("Rules For Import" on page 257). The `-includeaccess` option must be used if you want to preserve ownership and privilege information. This option is ignored if you are not logged in as a member of the `admin` group.
- By default, caching configuration is imported. The `-nocaching` option must be used if you want to ignore cache configurations.

### Parameters and Args

<table>
<thead>
<tr>
<th><code>pkg_import -pkgfile</code> Parameters and Args</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-nosourceinfo</code></td>
<td>optional</td>
<td>Suppresses import of the following pre-existing connection attributes when an otherwise identical resource is already present at the target: Driver, ConnectionURL, Port, Database Name, Login, Password, and Pass-through Login. Also supports re-import without need for explicit &quot;-set&quot; options and without altering original data source attributes.</td>
</tr>
<tr>
<td><code>-overwrite</code></td>
<td>optional</td>
<td>This option overwrites duplicated resources.</td>
</tr>
<tr>
<td><code>-messagesonly</code></td>
<td>optional</td>
<td>Displays the messages generated in a package import without actually performing the import.</td>
</tr>
<tr>
<td><code>-port &lt;PortNumber&gt;</code></td>
<td>optional</td>
<td>Port for the target CIS instance. Default=9400</td>
</tr>
<tr>
<td><code>-verbose</code></td>
<td>optional</td>
<td>This option causes verbose reporting of information much like the GUI provides instead of the normal terse reporting.</td>
</tr>
</tbody>
</table>
By default, scheduling configuration is imported. The `-noscheduling` option must be used if you want to ignore scheduling configurations. Note that if you are logged in as a member of the `admin` group, then all scheduling is imported. If not, only the schedules owned by you are imported.

By default, physical data source connection details such as usernames, passwords, host names, and ports are imported. The `-nosourceinfo` option must be used if you want to ignore those details. When ignoring connection details and importing over an existing physical data source, the previous values will be left unmodified instead of being overwritten. When creating a new data source, these values are set to an empty string.

By default, all resources import into the same location in the namespace they were in when exported. The `-relocate` option can be used to change the location for the import. You can issue as many `-relocate` flags as desired and they are processed in order, with the first matching `oldPath` being applied to each resource. Relocating a resource will modify (rebind) references made by other resources being imported, but will not modify references on resources that are not part of the import.

As an additional option, resources can be rebound as a group during the import process using the `-rebind` option. You can issue as many `-rebind` flags as desired and they are processed in order. All imported resources will have the rebinding performed. In case of conflict between rebinds caused by the `-relocate` and `-rebind` flags, the `-rebind` ones are performed first.

The `-verbose` option causes informational messages to be printed after importing. Without this option, only error messages are displayed.

The `-printinfo` option causes the archive file to be examined and for information about it to be printed to the display. The archive file is NOT imported when this option is given.

The `-printcontents` option causes the archive file to be examined and for the list of resources in the file to be printed to the display. The archive file is NOT imported when this option is given.

The `-printroots` option causes the archive file to be examined and for the list of top level resources (generally the list provided to `pkg_list` on the command line) to be printed to the display. This is useful for understanding...
what is in the archive without having to see the complete list. The archive file is NOT imported when this option is given.

- The \texttt{-printreferences} option causes the archive file to be examined and for the list of resources that are referenced within the import but are not actually part of the import to be printed to the display. This is useful for identifying external dependencies for the archive. The archive file is NOT imported when this option is given.

- The \texttt{-printusers} option causes the archive file to be examined and for the list of users that are referenced as owners or in privileges on the resources to be printed to the display. This is useful for identifying the users required to import with access information intact. The archive file is NOT imported when this option is given.

- The \texttt{-messagesonly} option causes the archive file to generate all the messages it would generate if you actually imported it, but does not commit the import to the server's storage.

- The \texttt{-set} option allows data source connection information to be explicitly specified or changed from the original during import.

  \texttt{[-set <path> <attribute> <value>]}  

  This option is typically used when deploying a \texttt{.car} file to a production server. The properties most commonly changed are: \texttt{host}, \texttt{port}, \texttt{database}, \texttt{user}, \texttt{password}

  The following attributes of the \texttt{-set} option may be invoked when importing data sources:

  - \texttt{user <login> or <username> or error depending on source type}
  - \texttt{password <password> or error depending on source type}
  - \texttt{user2 <appUserName> or error if not Oracle EBS}
  - \texttt{password2 <appPassword> or error if not Oracle EBS}
  - \texttt{host <urlIP> or <dsn> or <server> or <appServer> or <url> or <root> or error depending on the source type}
  - \texttt{port <urlPort> or <port> or error depending on source type}
Example usage to change the password property of a data source:
```
pkg import mycar.car -set /shared/myDataSource
DATA_SOURCE password myNewPassword
```
In this example, -set is the option; DATA_SOURCE is the type of the resource being imported, and password is the property that is being changed.

**Rules For Import**

Importing follows some rules to resolve conflicts during import. These rules are:

1. If an imported resource does not exist prior to import, then it is created. The user performing the import gets all privileges as if they were the original creator (such as READ|WRITE for a folder or READ|WRITE|EXECUTE for a procedure) unless the -includeaccess option is specified.

   If an administrative user who has the Modify All Users right imports a resource using the -includeaccess option, then the original owner of the resource is set as the owner and any pre-existing privileges in the import package are also set for the newly imported resource.

2. If a resource is imported to a non-existent location, the new directory path and folder are created with the import of the new resource. The user who performs the import is assigned ownership of the new folders and gets READ|WRITE privilege on the resource and new container folders.

   Composite Data Services area does not support auto-creation of new folders.

3. If a resource already exists and it is also being imported, the old version is overwritten (assuming you have the WRITE privilege) in all ways, except the following:

   3.1 The owner is not changed. The original owner retains ownership.
   3.2 Privileges for users that are not explicitly changed by the import are left intact.
For example, two users, Abe and Bob, have READ|WRITE privileges on an existing resource that will be overwritten by an import. If the imported resource overwrites Abe resource privileges to READ only, but does not mention Bob, then Abe’s privileges are updated but Bob’s are left intact.

3.3 Child resources are not removed when the imported resource is a new folder or data source.

4. Restrictions

4.1 Server configuration settings (visible using the Composite Studio Administration > Configuration menu option) are not ported over when a resource is exported or imported using the pkg_export and pkg_import utilities or when specifying a single resource for export using Studio.

4.2 Import into a folder requires the WRITE privilege on the destination folder and READ privileges on the parent directory path. Importing cannot create a resource in a folder where the user does not have the WRITE privilege.

4.3 Overwrite or deletion of a Composite resource requires WRITE privilege on that target.

4.4 Export of a physical data source is either all or nothing. Partial export of a data source configuration is not permitted.

4.5 You cannot import just part of a physical data source. If you import, you must include the source definition itself.

4.6 The Composite Data Services area has strict structure rules that are enforced.

    – You cannot import anything that was exported from the Composite Data Services area to outside of that area.

4.7 You cannot import anything that was exported from outside the Composite Data Services area into that area.
Package Import from an Externalized Directory (-pkgdir option)

Package import from an externalized directory (pkg_import -pkgdir) takes the XML files that represent the exported output of a Composite directory and uses those files to restore that Composite namespace path to the state captured by the exported files. Importing an externalized directory will delete, overwrite, and synchronize the Composite Server directory so that it has the same resource definitions as the externalized directory.

The manifest file in the top level of the externalized directory will dictate what Composite namespace path will get updated with the XML rendered representations of Composite metadata.

Overwrite of a Composite resource requires WRITE privilege on that resource. If the importing user does not have WRITE privileges on a resource or a folder then those resources in that path can not be deleted or overwritten by an import action performed by that user. Resource locks do not impede resource overwriting by package import.

Usage of Package Import to a directory (-pkgdir option)

As stated previously, the pkg_import utility is available in the bin directory of the CIS installation. Windows and Unix specific versions of the utility are available.

The utility follows the following generic form:

```
pkg_import -pkgdir <directory>  
- server <hostname> [-port <port>] [-encrypt]  
- user <user> - password <password> [-domain <domain>]  
[-optfile <filename>] ...  
[-messagesonly]  
[-fileEncoding <encoding>]  
[-listIgnored] [-includeOwnership]  
[-verbose] [-quiet]
```

Example
In the following example the user, BackupAdmin, assesses the impact of an import from externalized directory that was saved to a disk. The -messagesonly, -listIgnored, and -verbose options are employed to get a full accounting of what files would be replaced or ignored if the package import were to actually get executed. The -messagesonly option disables the import and no changes are actually made.

```
pkg_import -pkgdir E:/DiskArchive/CompositeServer/Jan2008
   -server localhost -user BackupAdmin -password becarefulnow
   -messagesonly -listIgnored -verbose
```

Verify Package Import Impact using the -messagesonly Option
It is always a best practice to execute the pkg_import -pkgdir using the -messagesonly option to verify what resources will be overwritten by the import action. The messages only option of package import reports what files will be imported into the Composite Server from the externalized directory without actually deleting or overwriting any resources.

<table>
<thead>
<tr>
<th>pkg_import -pkgdir Parameters and Args</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-pkgdir &lt;directory&gt;</td>
<td>mandatory</td>
<td>Specifies the externalized directory that will be imported to overwrite and synchronize the Composite namespace path(s) named in the manifest.</td>
</tr>
<tr>
<td>-server &lt;HostName&gt;</td>
<td>mandatory</td>
<td>Composite Server host to which the utility will connect.</td>
</tr>
<tr>
<td>-port &lt;BasePortNum&gt;</td>
<td>optional</td>
<td>Specifies Web Services Base Port (HTTP) used to communicate with the Composite Server. The default value is 9400. Specification is optional if the port setting has not changed. NOTE: Specify the Web Services HTTP port even if the -encrypt option is specified. If -encrypt is specified then the tool will automatically add two to the port number specified here.</td>
</tr>
</tbody>
</table>
**Encrypt**

Optional Encrypts communication between the command line and CIS using SSL sent over the dedicated HTTPS port.

**NOTE:** When using the `-encrypt` option, the HTTPS port is automatically used. Use the `-port` option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port.

**User `<UserName>`**

Mandatory User name of profile used to import. User rights specified by the target CIS instance grant permission to import and may restrict write privileges on any particular directory or resource path.

**Password `<Password>`**

Mandatory Password for user profile used to import the directory.

**Domain `<domain>`**

Optional Enter domain for the user performing the import. If it is omitted the assumed value is "composite".

<table>
<thead>
<tr>
<th>pkg_import -pkgdir Parameters and Args</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-encrypt</td>
<td>optional</td>
<td>Encrypts communication between the command line and CIS using SSL sent over the dedicated HTTPS port. <strong>NOTE:</strong> When using the <code>-encrypt</code> option, the HTTPS port is automatically used. Use the <code>-port</code> option to specify the HTTP web services base port and the command line utility automatically switches the SSL connection to the dedicated HTTPS port.</td>
</tr>
<tr>
<td>-user <code>&lt;UserName&gt;</code></td>
<td>mandatory</td>
<td>User name of profile used to import. User rights specified by the target CIS instance grant permission to import and may restrict write privileges on any particular directory or resource path.</td>
</tr>
<tr>
<td>-password <code>&lt;Password&gt;</code></td>
<td>mandatory</td>
<td>Password for user profile used to import the directory.</td>
</tr>
<tr>
<td>-domain <code>&lt;domain&gt;</code></td>
<td>optional</td>
<td>Enter domain for the user performing the import. If it is omitted the assumed value is &quot;composite&quot;.</td>
</tr>
</tbody>
</table>
Chapter 7 Utilities

pkg_import -pkgdir
Parameters and Args

-FileEncoding
<encoding>

Optional/
Mandatory

optional

Comments

Encoding defaults to UTF-8, but a different encoding
option may be specified. Use the command line to display
a list of valid encodings by entering an invalid encoding
value, or try to read the 8 point below. Valid encoding
values include the following:
Big5, Big5-HKSCS, Cp1252, EUC-JP, EUC-KR, GB18030, GB2312, GBK,
IBM-Thai, IBM00858, IBM01140, IBM01141, IBM01142, IBM01143,
IBM01144, IBM01145, IBM01146, IBM01147, IBM01148, IBM01149,
IBM037, IBM1026, IBM1047, IBM273, IBM277, IBM278, IBM280,
IBM284, IBM285, IBM297, IBM420, IBM424, IBM437, IBM500, IBM775,
IBM850, IBM852, IBM855, IBM857, IBM860, IBM861, IBM862, IBM863,
IBM864, IBM865, IBM866, IBM868, IBM869, IBM870, IBM871, IBM918,
windows-1250, windows-1251, windows-1252, windows-1253, windows1254, windows-1255, windows-1256, windows-1257, windows-1258,
windows-31j, x-Big5-Solaris, x-euc-jp-linux, x-EUC-TW, x-eucJP-Open, xIBM1006, x-IBM1025, x-IBM1046, x-IBM1097, x-IBM1098, x-IBM1112, xIBM1122, x-IBM1123, x-IBM1124, x-IBM1381, x-IBM1383, x-IBM33722,
x-IBM737, x-IBM834, x-IBM856, x-IBM874, x-IBM875, x-IBM921, xIBM922, x-IBM930, x-IBM933, x-IBM935, x-IBM937, x-IBM939, xIBM942, x-IBM942C, x-IBM943, x-IBM943C, x-IBM948, x-IBM949, xIBM949C, x-IBM950, x-IBM964, x-IBM970, x-ISCII91, x-ISO-2022-CNCNS, x-ISO-2022-CN-GB, x-iso-8859-11, x-JIS0208, x-JISAutoDetect, xJohab, x-MacArabic, x-MacCentralEurope, x-MacCroatian, x-MacCyrillic, xMacDingbat, x-MacGreek, x-MacHebrew, x-MacIceland, x-MacRoman, xMacRomania, x-MacSymbol, x-MacThai, x-MacTurkish, x-MacUkraine, xMS950-HKSCS, x-mswin-936, x-PCK, x-windows-50220, x-windows-50221,
x-windows-874, x-windows-949, x-windows-950, x-windows-iso2022jp

-includeOwnership

optional

Imports resources with the original ownership if the
importing administrator has the Modify All Users right.

-listIgnored

optional

Displays a list of folders and resources that are not
updated by the import.

-messagesonly

optional

Displays the messages generated in a package import
without actually performing the import.

Composite Information Server

262

Administration Guide 4.6 Rev. 1


The options file feature provides a way to pass options using a file instead of the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line.

The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal.

For example,
```
backup_import
  -server localhost
  -user test
  -password password
  -pkgfile sample.car
```

is the same as:
```
backup_import
  -optfile sample.opt
```

where `sample.opt` contains either:
```
  -server localhost
  -user test
  -password password
  -pkgfile sample.car
```

or (this one with new lines):
```
  -server localhost
  -user test
  -password password
  -pkgfile sample.car
```

This option is also available for use in `pkg_export`.

### Optional/ Mandatory

<table>
<thead>
<tr>
<th>pkg_import Parameters and Args</th>
<th>Optional/ Mandatory</th>
<th>Comments</th>
</tr>
</thead>
</table>
| -optfile `<FileName>`         | optional             | Options file.
|                               |                      | The options file feature provides a way to pass options using a file instead of the command line. The options file is useful for scripting and ensuring that sensitive information does not display on the operating system command line. The contents of the options file are the same strings you would use on the command line, with the addition of new lines being legal. For example, `backup_import
  -server localhost
  -user test
  -password password
  -pkgfile sample.car`
|                               |                      | is the same as:
|                               |                      | `backup_import`
|                               |                      |   -optfile sample.opt
|                               |                      | where `sample.opt` contains either:
|                               |                      |   -server localhost
|                               |                      |   -user test
|                               |                      |   -password password
|                               |                      |   -pkgfile sample.car
|                               |                      | or (this one with new lines):
|                               |                      |   -server localhost
|                               |                      |   -user test
|                               |                      |   -password password
|                               |                      |   -pkgfile sample.car
|                               |                      | This option is also available for use in `pkg_export`.
| -quiet                        | optional             | Suppresses notification messages. |
| -verbose                      | optional             | This option causes verbose reporting of information much like the GUI provides instead of the normal terse reporting. |
remove_services

The remove_services.sh script can be used from the command-line interface to un-install the Composite services files that are used to automatically re-start the server and the repository on UNIX.

- To remove the Composite service files
  1. Log into the installation machine as root.
  2. Change the working directory to the bin directory in the installation directory (<installation_directory>/bin).
  3. Run the following command:
     remove_services.sh

This command does not interrupt any repository/server processes that are running but removes the Composite Service files.
repo_util

This section describes the usage of Composite’s command-line program repo_util which you can use to change the repository database.

The repo_util scripts, namely repo_util.bat and repo_util.sh, are available in the bin directory of the Composite installation directory.

You can use this program to perform several tasks including the following:

- Test the connection to the repository database
- List the current repository configuration information
- Export the repository configuration
- Update the repository configuration
- Create/Drop the repository schema
- Print diagnostic information about the CIS metadata repository
- Print debugging messages

The syntax to use repo_util on Windows:

```
repo_util.bat command [options] [database_configuration_options]
```

The following tables list the commands and options for running the repo_util program. Sample Commands to Use repo_util of commands are given at the end.

Table 9. Commands for using repo_util

<table>
<thead>
<tr>
<th>Commands for repo_util</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-createSchema</td>
<td>Creates the repository schema.</td>
</tr>
<tr>
<td>-dropSchema</td>
<td>Drops the repository schema and all data contained within it. This will permanently delete all of the server’s data. Use with caution.</td>
</tr>
<tr>
<td>-dumpDiagnosticInfo</td>
<td>Prints diagnostic information about the repository database.</td>
</tr>
<tr>
<td>-exportConfig</td>
<td>Exports the repository database configuration in the JAVA property file format. The output is suitable for use as a repository configuration file. See -configFile for details.</td>
</tr>
</tbody>
</table>
### Table 9. Commands for using `repo_util`

<table>
<thead>
<tr>
<th>Commands for repo_util</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-help</td>
<td>Prints this help information.</td>
</tr>
<tr>
<td>-listConfig</td>
<td>Lists the repository database configuration in a human readable format.</td>
</tr>
<tr>
<td>-testConn</td>
<td>Tests the connection to the repository database.</td>
</tr>
<tr>
<td>-updateConfig</td>
<td>Changes the repository database configuration. Use this command to change one or more configuration options. You may specify new configuration options individually using command line arguments or collectively, using the -configFile option. Configuration options that are not specified are left unchanged.</td>
</tr>
</tbody>
</table>

### Table 10. Debug options for using `repo_util`

<table>
<thead>
<tr>
<th>Debug Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-debug</td>
<td>Prints debug messages.</td>
</tr>
<tr>
<td>-force</td>
<td>Do not prompt for confirmation. Use with caution.</td>
</tr>
</tbody>
</table>

### Table 11. Database options for using `repo_util`

<table>
<thead>
<tr>
<th>Database Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-configFile</td>
<td>Read database configuration options from this JAVA property file. The property names in the file must match the database option names defined in this section. Run <code>repo_util.bat -exportConfig</code> for an example of the contents of this file.</td>
</tr>
<tr>
<td>-connectionUrl</td>
<td>The JDBC URL that is used to connect to the external database. For example: <code>jdbc:mysql://localhost:3406/cs030101?continueBatchOnError=false&amp;useUnicode=true</code></td>
</tr>
</tbody>
</table>
Here are some examples of commands for using the `repo_util` program:

- To list the server configuration information:
  
  ```
  repo_util.bat -listConfig
  ```

### Table 11. Database options for using repo_util

<table>
<thead>
<tr>
<th>Database Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-databaseCatalog</td>
<td>Database catalog that contains the Composite schema. It may be blank if the database does not support catalogs.</td>
</tr>
<tr>
<td>-databaseSchema</td>
<td>Database schema that contains the Composite schema. It may be blank if the database does not support schemas.</td>
</tr>
<tr>
<td>-databasePassword</td>
<td>Database password.</td>
</tr>
<tr>
<td>-databaseUser</td>
<td>Database user name.</td>
</tr>
<tr>
<td>-driverClass</td>
<td>The fully qualified class name of a JDBC compliant driver. For example:</td>
</tr>
<tr>
<td></td>
<td>com.mysql.jdbc.Driver</td>
</tr>
<tr>
<td>-driverClassPath</td>
<td>A semi-colon or colon separated list of JAR files and directories. For example:</td>
</tr>
<tr>
<td></td>
<td>/tmp/oracle40.jar:/tmp</td>
</tr>
<tr>
<td>-driverName</td>
<td>Name of the Composite datasource driver name. This is required for proper operation of the system tables.</td>
</tr>
<tr>
<td>-driverType</td>
<td>Name of the Composite data source driver type. This is required for proper operation of the system tables.</td>
</tr>
<tr>
<td>-repositoryClass</td>
<td>Repository class name.</td>
</tr>
<tr>
<td>-schemaCreateScript</td>
<td>Composite schema creation script. This script contains the SQL commands to create the Composite schema.</td>
</tr>
<tr>
<td>-schemaDropScript</td>
<td>Composite schema drop script. This script contains the SQL commands to drop the Composite schema.</td>
</tr>
<tr>
<td>-schemaInitializeScript</td>
<td>Composite initialize script. This script contains the SQL commands to initialize the Composite table.</td>
</tr>
</tbody>
</table>
To export a repository configuration file:
```bash
repo_util.bat -exportConfig > repo.properties
```

To update the repository database user name and password:
```bash
repo_util.bat -updateConfig -databaseUser someuser -databasePassword somepassword
```

To update the repository configuration using a repository configuration file, overriding the database password:
```bash
repo_util.bat -updateConfig -configFile repo.properties -databasePassword somepassword
```
server_util

The server_util program is used for getting the server performance profile report and resetting the system namespace.

Usage syntax:

```
server_util -server <hostname> [-port <port>] [-encrypt]
-user <username> -password <password> [-domain <domain>]
<command> [-verbose]
```

where <command> refers to one of the following options:

- **resetNamespace** (Resets the server namespace to show changes to the system namespace (e.g., a system table change after application of a patch.))
- **profile** (Displays current server profile performance profiling data. Server profiling is always working in the background by default. Some of the report contents will display performance metrics once that code path has been exercised. Some pertinent performance profiling is detailed below.)
- **clearProfile** (Clear all existing profiling data.)
- **regenerateFiles** (Regenerate files that are based on configuration settings. Use of the Configuration window Apply button and CIS restart generally make this command obsolete.)
- **createMemorySizeFile** (Calculates and saves object memory sizes.)
- **getServerName** (Retrieves the server name.)
- **setServerName** -serverName <server name> (Sets server name, which must be a unique display name.)

Sample Commands to Use server_util

The following command would list the server profile for a default installation:

```
server_util -server HostName -user admin -password admin -profile
```

The Server Performance Profile Report contains many different metrics of which only a few are described here:
request.setup.sql:  Time to construct the SQL sent to outside data sources.

components.archive:  Import and Export detail

request.data:  Aggregated amount of time required to send data to the requesting client after SQL processing was underway.

internal.repository:  Repository response time for metadata information gathering.

components.operator:  Query engine processing time for SQL that could not be pushed to the underlying data sources during.

ds:  Aggregated time required to communicate with external data sources.

The following -clearProfile command clears the server profile information to start aggregate and average statistics data with a clean slate.

```
server_util -server localhost -user admin -password admin
   -clearProfile
```

The following -resetNamespace command would reset the system namespace.

```
server_util -server localhost -user admin -password admin
   -resetNamespace
```
Chapter 8

Setting Up an Oracle Repository

This chapter describes the steps to follow if you want to use an Oracle database as the Composite metadata repository.

Currently supported version: Oracle 10g (Thin Driver)

Topics covered here:
- Creating an Oracle Repository Database
- “Configuring Composite Server for an Oracle Repository” on page 273

Pre-requisite: Install Oracle Call Interface (OCI)

Before an Oracle 10g type 2 database may be used as a repository for the Composite Server the Oracle Call Interface (OCI) client must be installed locally on the server hosting the Composite Information Server.

The PATH (Windows) or LD_LIBRARY_PATH (for most Unix systems) to OCI must be specified for Composite to properly recognize and use the OCI client.

Refer to the Oracle Instant Client (which includes OCI) documentation for more detailed installation information.

Creating an Oracle Repository Database

For a small sized repository database, we recommend allocating 250MB.

For a medium sized repository, we recommend allocating 800MB.

For a large sized repository, we recommend allocating at least 2000MB (or 2GB).
This section describes how to create a **tablespace** and **user** to use an Oracle repository database. In the following example, the name `CIS_REPO` is used for the tablespace and `composite` for the user.

1. Make sure that the Oracle system used by Composite Server supports the **international character set**.

2. Use the Oracle command line tool to create a **tablespace** (here named `CIS_REPO`) with the following command:

   ```sql
   CREATE TABLESPACE "CIS_REPO"
   LOGGING
   DATAFILE 'C:\ORACLE\PRODUCT\10.2.0\ORADATA\ORCL\TEST.ora'
   SIZE 250M
   ``

   This command lets you create a tablespace for a small size repository. For a larger size repository, increase the size to 800M or 2000M.

   For a complete syntax to create a tablespace in Oracle that fits your needs, refer to Oracle documentation.

3. Use the Oracle command line tool to **create a user** (here named `composite`) with the following command:

   ```sql
   CREATE USER "composite" PROFILE "DEFAULT"
   IDENTIFIED BY "password"
   DEFAULT TABLESPACE "CIS_REPO"
   TEMPORARY TABLESPACE "TEMP"
   QUOTA UNLIMITED
   ON "CIS_REPO"
   ACCOUNT UNLOCK;
   GRANT ALTER SESSION TO "composite"
   GRANT CREATE ANY INDEX TO "composite"
   GRANT CREATE PROCEDURE TO "composite"
   GRANT CREATE TABLE TO "composite"
   GRANT CREATE SESSION TO "composite"
   GRANT CREATE SYNONYM TO "composite"
   GRANT CREATE VIEW TO "composite"
   ```
GRANT DROP ANY INDEX TO "composite"
GRANT DROP ANY PROCEDURE TO "composite"
GRANT DROP ANY TABLE TO "composite";

This command creates a user composite that is granted access to the newly created tablespace, CIS_REPO, with unlimited space quota. The user is also granted the privileges of creating and dropping indexes, procedures, and tables.

For a complete syntax to create a user in Oracle that fits the client’s needs, refer to Oracle documentation.

After the user is created as described here, the user name can be used as the values for the properties databaseUser and databaseSchema described in Configuring Composite Server for an Oracle Repository. You should also find out from your database administrator (DBA) about the Oracle server’s SID, since the SID will be used as the value of databaseName.

Configuring Composite Server for an Oracle Repository

After installing Composite, use the command line program repo_util to configure Composite Server to use a pre-configured Oracle repository.

The repo_util program (repo_util.bat for Windows; repo_util.sh for Unix) is available in the bin directory of Composite installation directory.

This section describes the steps for configuring Composite Server to use the thin driver or the OCI driver to connect to an Oracle repository database.

- To change the repository to Oracle (using the thin driver) after installing CIS

1. Stop Composite Server, if it is running.
2. Do one of the following to remove the repository dependency on the MySQL repository from the Composite Server:
   2.1 Find sc.exe and execute this line in the Windows Command Prompt:

   `sc.exe config SERVICE_NAME depend= ""`

   Where SERVICE_NAME is "Composite Server Repository 4.6.0". Or...
2.2 Edit the registry so that the value of the following key is an empty string:

```
HKEY_LOCAL_MACHINE\System\CurrentControlSet\services\SERVICE_NAME\DependOnService
```

Where `SERVICE_NAME` is "Composite Server Repository 4.6.0".

3. To list the current repository configuration, run `repo_util` with the following option:

```
repo_util.bat -listConfig (Windows)
repo_util.sh -listConfig (UNIX)
```

The following is the display (on Windows) of a sample configuration for a MySQL repository:

Repository Database Configuration:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>connectionUrl</td>
<td>jdbc:mysql://localhost:3306/cs030801?continueBatchOnError=false&amp;useUnicode=true&amp;characterEncoding=utf8&amp;clobberStreamingResults=true&amp;useReadAheadInput=true</td>
</tr>
<tr>
<td>databaseCatalog</td>
<td>[not set]</td>
</tr>
<tr>
<td>databaseHost</td>
<td>localhost</td>
</tr>
<tr>
<td>databaseName</td>
<td>....</td>
</tr>
<tr>
<td>databasePassword</td>
<td>[not shown]</td>
</tr>
<tr>
<td>databasePort</td>
<td>3306</td>
</tr>
<tr>
<td>databaseSchema</td>
<td>[not set]</td>
</tr>
<tr>
<td>databaseUser</td>
<td>composite</td>
</tr>
<tr>
<td>driverClass</td>
<td>com.mysql.jdbc.Driver</td>
</tr>
<tr>
<td>driverClassPath</td>
<td>C:\mysql-connector-java-1_1_10_1-bin.jar</td>
</tr>
<tr>
<td>driverName</td>
<td>MySQL 4.1</td>
</tr>
<tr>
<td>driverType</td>
<td>MySql</td>
</tr>
<tr>
<td>poolInitialSize</td>
<td>5</td>
</tr>
<tr>
<td>poolMaxSize</td>
<td>50</td>
</tr>
<tr>
<td>poolMinSize</td>
<td>25</td>
</tr>
<tr>
<td>repositoryClass</td>
<td>com.compositesw.server.repository.internal.MySQLRepository</td>
</tr>
<tr>
<td>schemaCreateScript</td>
<td>C:\mysql_repo\composite_schema.sql</td>
</tr>
</tbody>
</table>
Export the current configurations into a property file (here, repo.properties), using the following command:

repo_util.bat -exportConfig > repo.properties (Windows)
repo_util.sh -exportConfig > repo.properties (UNIX)

Modify the property file to use proper Oracle configuration, as follows, without changing the values rendered in **bold** type.

```properties
# Composite server repository configuration
# Generated on ... at ... PM

# The values for databaseHost, databaseName, and databasePort should be included in the connectionUrl.
connectionUrl= jdbc:oracle:thin:@localhost:1521:orcl
databaseHost=localhost
databaseName=orcl
databasePassword=************
databasePort=1521

# The value for databaseCatalog should be empty.
databaseCatalog=

# The values for databaseSchema and databaseUser should be the same.
databaseSchema=composite
databaseUser=composite

driverClass=oracle.jdbc.driver.OracleDriver
driverClassPath=C:\oracle\ojdbc14.jar
driverName=Oracle 10g (Thin Driver)
driverType=Oracle
poolInitialSize=5
poolMaxSize=50
poolMinSize=25
```
**Configuring Composite Server for an Oracle Repository**

Chapter 8  Setting Up an Oracle Repository

```
repositoryClass=com.compositesw.server.repository.internal.
OracleRepository
schemaCreateScript=C:\oracle\composite_schema.sql
schemaDropScript=C:\oracle\composite_clean.sql
schemaInitializeScript=C:\oracle\composite_data.sql
```

For security purpose, you can leave the value for `databasePassword` as asterisks in the property file. Later on, you can supply the real password in a command line. See **Step 6**.

6. Update the repository configuration.
   Supply the real password in a command line as follows:
   ```
   repo_util.bat -updateConfig -configFile repo.properties -
   databasePassword password
   (on Windows)
   repo_util.sh -updateConfig -configFile repo.properties -
   databasePassword password  (on UNIX)
   ```

7. After the repository database configuration has been updated, restart Composite Server.

8. Verify that the repository database is running on the right Oracle repository database, as follows:
   8.1 Run `repo_util` command with `-listConfig` option.
   8.2 Open `cs_server.log` in the `logs` directory of Composite installation directory. You should see server information similar to the following:
   ```
   ```

To change the repository to Oracle (using the OCI driver) after installing CIS

1. Stop Composite Server, if it is running.
2. To list the current repository configuration, run `repo_util` with the following option:

```
```
The following is the display (on Windows) of a **sample configuration** for a MySQL repository:

**Repository Database Configuration:**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>connectionUrl</td>
<td>jdbc:mysql://localhost:3306/cs030801?continueBatchOnError=false&amp;useUnicode=true&amp;characterEncoding=utf8&amp;clobberStreamingResults=true&amp;useUnreadableInput=true</td>
</tr>
<tr>
<td>databaseCatalog</td>
<td>[not set]</td>
</tr>
<tr>
<td>databaseHost</td>
<td>localhost</td>
</tr>
<tr>
<td>databaseName</td>
<td>______</td>
</tr>
<tr>
<td>databasePassword</td>
<td>[not shown]</td>
</tr>
<tr>
<td>databasePort</td>
<td>3306</td>
</tr>
<tr>
<td>databaseSchemas</td>
<td>[not set]</td>
</tr>
<tr>
<td>databaseUser</td>
<td>composite</td>
</tr>
<tr>
<td>driverClass</td>
<td>com.mysql.jdbc.Driver</td>
</tr>
<tr>
<td>driverClassPath</td>
<td>C:\mysql-connector-java-5.1_10_1-bin.jar</td>
</tr>
<tr>
<td>driverName</td>
<td>MySQL 5.1</td>
</tr>
<tr>
<td>driverType</td>
<td>MySql</td>
</tr>
<tr>
<td>poolInitialSize</td>
<td>5</td>
</tr>
<tr>
<td>poolMaxSize</td>
<td>50</td>
</tr>
<tr>
<td>poolMinSize</td>
<td>25</td>
</tr>
<tr>
<td>repositoryClass</td>
<td>com.compositesw.server.repository.internal.MySQLRepository</td>
</tr>
<tr>
<td>schemaCreatedScript</td>
<td>C:\mysql_repo\composite_schema.sql</td>
</tr>
<tr>
<td>schemaDropScript</td>
<td>C:\mysql_repo\composite_clean.sql</td>
</tr>
<tr>
<td>schemaInitializerScript</td>
<td>C:\mysql_repo\composite_data.sql</td>
</tr>
</tbody>
</table>

3. Export the current configurations into a property file (here, `repo.properties`), using the following command:

```
repo_util.bat -exportConfig > repo.properties (Windows)
```
repo_util.sh -exportConfig > repo.properties (UNIX)

4. Modify the property file to use proper Oracle configuration, as follows, without changing the values rendered in bold type.

   #
   # Composite server repository configuration
   # Generated on ... at ... PM

   #The values for databaseHost, databaseName, and databasePort should be included in the connectionUrl.
   connectionUrl=jdbc:oracle:oci:@localhost:1521:orcl
   databaseHost=localhost
   databaseName=orcl
   databasePassword=************
   databasePort=1521

   #The value for databaseCatalog should be empty.
   databaseCatalog=

   #The values for databaseSchema and databaseUser should be the same.
   databaseSchema=composite
   databaseUser=composite

   driverClass=oracle.jdbc.driver.OracleDriver
   driverClassPath=C:\oracle\ojdbc14.jar
   driverName=Oracle 10g [OCI Driver]
   driverType=Oracle_Type2
   poolInitialSize=5
   poolMaxSize=50
   poolMinSize=25
   repositoryClass=com.compositesw.server.repository.internal.
   OracleRepository
   schemaCreateScript=C:\\oracle\\composite_schema.sql
   schemaDropScript=C:\\oracle\\composite_clean.sql
   schemaInitializeScript=C:\\oracle\\composite_data.sql
For security purpose, you can leave the value for databasePassword as asterisks in the property file. Later on, you can supply the real password in a command line. See Step 6.

5. Update the repository configuration.
   Supply the real password in a command line as follows:
   
   repo_util.bat -updateConfig -configFile repo.properties -
   databasePassword password (on Windows)
   
   repo_util.sh -updateConfig -configFile repo.properties -
   databasePassword password (on UNIX)

6. After the repository database configuration has been updated, restart Composite Server.

7. Verify that the repository database is running on the right Oracle repository database, as follows:
   
   7.1 Run repo_util command with -listConfig option.
   
   7.2 Open cs_serverlog in the logs directory of Composite installation directory. You should see server information similar to the following:
   
   
   
Chapter 9

Setting Up a Sybase Repository

This chapter describes the steps to follow if you want to use a Sybase database as the Composite metadata repository.

The following topics are covered in this chapter:

- “System Requirements for Using Sybase with CIS” on page 281
- “Creating the Sybase Repository Database” on page 282
- “Configuring the Sybase System” on page 285
- “Configuring CIS for a Sybase Repository” on page 294
System Requirements for Using Sybase with CIS

This section describes the requirements for using Sybase as the database repository for CIS.

Sybase Version Support

The currently supported version of Sybase for use as a repository database is Sybase ASE 12.5.

Sybase Repository Configuration Requirements

There are three tasks you must perform to use a Sybase database as the CIS repository:

1. Create the Sybase repository database.
2. Configure the Sybase system to work with CIS.
3. Configure CIS to work with Sybase.

Each of these tasks is described in this chapter.
Creating the Sybase Repository Database

This section describes how to set up an external Sybase repository to work with Composite Server. It also points out the limitation on using a Sybase ASE 12.5 repository database.

1. Create a Sybase database as the Composite metadata repository.

   Here is the syntax to create a database in Sybase ASE 12.5. Substitute the items in italics with appropriate values.

   ```sql
   create database database_name
   [on {default | database_device} [= size]
   [, database_device [= size]]...]
   [log on database_device [= size ]
   [, database_device [= size]]...]
   [with {override | default_location = "pathname"}]
   [for {load | proxy_update}]
   ```

   For detailed information about the above syntax, refer to Sybase ASE 12.5 documentation.

   When creating the database, you should consider how much space should be allocated for Composite Server’s use. We recommend setting the database size to 250MB for a small size repository, 800MB for a medium size repository, and 2GB for a large size repository.

   The way to determine the database size is illustrated in this example:

   We introspect a Siebel system, which contains 1 catalog, 4 schemas, 3,941 tables with 146,560 columns, and 31 stored procedures with 124 parameters, as a data source into Composite Server. The total size of the Sybase database increases to 58MB. If the whole data source is published as a data service in Composite Server, the Sybase database increases to 160MB. Therefore, 250MB should be good enough for a small size repository.

2. To configure the database after creating it, run the following system procedures supplying appropriate values for the items in italics:
sp_dboption <database_name>, 'abort tran on log full', true
go

sp_dboption <database_name>, 'trunc log on chkpt', true
go

3. Increase the size of the tempdb database to be about 20–25% of the main database using ALTER DATABASE command.

4. Create a user to log into the newly created database, supplying appropriate values for the items in italics.

4.1 Syntax for adding a new account to log into ASE 12.5:

```
sp_addlogin loginame, password [, defdb]
                [, deflanguage [, fullname]]
```

4.2 Syntax for adding the created login to a specific database so that the newly created user can access the database:

```
sp_adduser login_name [, name_in_db [, group_name]]
```

### Limitation on Using a Sybase ASE 12.5 Repository Database

Indexes are created in Composite Server’s system tables in order to enhance performance of querying these tables. These indexes consist of metadata ID-s and metadata names. By default, Sybase ASE 12.5 has page size of 4K so it only allows each index to have a maximum size of 1250 bytes. Therefore, we have to limit the length of the metadata names.

For example, there is an index on the system’s columns table, consisting of DATASOURCE_ID, ORDINAL_POSITION, COLUMN_ID, CATALOG_NAME, SCHEMA_NAME, and TABLE_NAME. Suppose we set the type of the name columns to be UNIVARCHAR (200). Each UNIVARCHAR character requires two bytes of storage; three of these name fields take up 600 bytes (3 * 200 * 2 bytes = 1200 bytes). Including the bytes for DATASOURCE_ID, COLUMN_ID, and ORDINAL_POSITION, this index barely fits 1250 bytes. If no more columns are
added to the index, the total bytes in the index will exceed the maximum allowable size of an index. This index will not be created in ASE 12.5.

To have the indexes created successfully, each metadata name is defined to be UNIVARCHAR(200). We only allow metadata names to be at most of 200 characters. If the metadata name is longer than 200 characters, the name will be trimmed to 200 characters when it is persisted into Sybase repository.
Configuring the Sybase System

The default installation of Sybase ASE 12.5 is not configured for enterprise applications. For example, the tempdb size is 2MB. The maximum number of connections defaults to 25, and the default maximum network package size is only 512 bytes. If you use such configuration to run Composite Server, certain Sybase limits will be hit, causing the Sybase system to hang. If you are not sure of your ASE 12.5 configuration, ask your Sybase DBA about it.

In order to run Composite Server efficiently, Sybase ASE 12.5 needs to be configured appropriately.

To reconfigure ASE 12.5, you must have system administration privileges so you can execute a set of system stored procedures.

Configuring Memory and Cache in Sybase ASE 12.5

1. Run the following system procedures in Sybase ASE 12.5:

   ```
   sp_configure 'max memory', 128000
   go
   
   sp_configure 'lock shared memory', 1
   go
   
   sp_cacheconfig 'default data cache', '128M'
   go
   
   sp_cacheconfig 'procedure cache', '16M'
   go
   
   sp_cacheconfig 'cache01', '80M'
   go
   ```

2. Restart Sybase ASE 12.5 after these configuration parameters are applied.
Chapter 9  Setting Up a Sybase Repository

Configuring Processing Limits in Sybase ASE 12.5

1. Run the following system procedures in Sybase ASE 12.5.
   
   ```
   sp_configure 'number of user connections', 256
   go
   
   sp_configure 'number of worker processes', 100
   go
   
   sp_configure 'max parallel degree', 3
   go
   
   sp_configure 'max scan parallel degree', 3
   go
   
   sp_configure 'number of locks', 100000
   go
   
   sp_configure 'number of open objects', 50000
   go
   
   sp_configure 'number of open databases', 32
   go
   
   sp_configure 'number of devices', 32
   go
   ```

2. Restart Sybase ASE 12.5 after these configuration parameters are applied.

Configuring Network Parameters in Sybase ASE 12.5

1. Run the following system procedures in Sybase ASE 12.5.
   
   ```
   sp_configure 'additional network memory', 8192
   go
   
   sp_configure 'max network packet size', 4096
   go
   
   sp_configure 'default network packet size', 2048
   go
   ```
sp_configure 'heap memory per user', 4096
  go

2. Restart Sybase ASE 12.5 after these configuration parameters are applied.

**Configuring the Character Set in Sybase ASE 12.5**

In order for the multi-byte character set to persist correctly in the Sybase repository, you need to configure the Sybase server to use the utf-8 character set. The following steps describe how to change the character set to be utf-8.

1. Open Sybase’s Server configuration tool.
2. Choose Configure Adaptive Server.

3. Select the repository Sybase server (as shown in the above sample screen) and log into that server.
4. In the Configure Adaptive Server window, click the Language button.

In the above sample screen, the character set is set to cp850. To change the character set to utf-8, you need to make sure that the utf-8 character set is installed. If UTF-8 is not already installed, you need to add it.
5. To add the utf-8 character set, click the Add/Remove button in the Character Set group in the section Change Options.
6. Select Unicode 3.1 UTF-8 Character Set in the Available character set section, and click Add.
7. When Unicode 3.1 UTF-8 Character Set is added to the section Selected, click OK to accept the selection.

8. In the Language Options window, choose Set Default button in the Character Set group in the section Change Options. This command opens the Change Default Character Set window.
9. Make sure that Unicode 3.1 UTF-8 Character Set is selected, and click OK.

10. Click Save to make the UTF-8 character set to be the default. The Save command requires a server restart. So, make sure that the server is not running any critical tasks, and restart the server.
Configuring CIS for a Sybase Repository

After installing Composite, you can use the command line program `repo_util` to list the configurations of the current repository database or modify the configuration for the existing repository database or change the repository database.

The `repo_util` program (`repo_util.bat` for Windows; `repo_util.sh` for UNIX) is available in the `bin` directory of Composite installation directory.

**To change the repository to Sybase ASE 12.5 after installing CIS**

1. Stop Composite Server, if it is running.
2. Do one of the following to remove the repository dependency on the MySQL repository from the Composite Server:
   2.1 Find `sc.exe` and execute this line in the Windows Command Prompt:
      ```
      sc.exe config SERVICE_NAME depend= ""
      Where `SERVICE_NAME` is "Composite Server Repository 4.6.0". Or...
      2.2 Edit the registry so that the value of the following key is an empty string:
      
      HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\SERVICE_NAME
      \DependOnService
      
      Where `SERVICE_NAME` is "Composite Server Repository 4.6.0".
   3. List the current repository configuration, run `repo_util` with the following option:
      ```
      repo_util.bat -listConfig (Windows)
      repo_util.sh -listConfig (UNIX)
      ```
      The following is the display of a sample configuration for a MySQL repository:
      ```
      Repository Database Configuration:
      Property Name          Value
      -------------------------------------------
      ```
Chapter 9  Setting Up a Sybase Repository

4. Export the current configurations to a property file (here, repo.properties), using the following command:

   repo_util.bat -exportConfig > repo.properties (Windows)
   repo_util.sh -exportConfig > repo.properties (UNIX)

5. Modify the property file to use a Sybase ASE 12.5 repository, as follows, without changing the values rendered in bold type.

   #
   # Composite server repository configuration
   # Generated on user.composite.com at Mar 15, 2006 2:44:03 PM
   #
   # connectionUrl=jDBC://sybase\:Tds\://localhost\:5000/pubs
   # databaseCatalog=otherdatabase

4. Export the current configurations to a property file (here, repo.properties), using the following command:

   repo_util.bat -exportConfig > repo.properties (Windows)
   repo_util.sh -exportConfig > repo.properties (UNIX)

5. Modify the property file to use a Sybase ASE 12.5 repository, as follows, without changing the values rendered in bold type.

   #
   # Composite server repository configuration
   # Generated on user.composite.com at Mar 15, 2006 2:44:03 PM
   #
   # connectionUrl=jDBC://sybase\:Tds\://localhost\:5000/pubs
   # databaseCatalog=otherdatabase
databaseHost=otherhost
databaseName=otherdatabase
databasePassword=************
databasePort=4100
databaseSchema=schemaname
databaseUser=otherlogin
driverClass=net.sourceforge.jtds.jdbc.Driver
driverClassPath=C:\jTDS.jar;C:\jconn3.jar;
driverName=Sybase
driverType=Sybase
poolInitialSize=5
poolMaxSize=50
poolMinSize=25
repositoryClass=com.compositesw.server.repository.internal.
SybaseRepository
schemaCreateScript=C:\\dev\\projects\\pyrex\\conf\\sybase\\
composite_schema.sql
schemaDropScript=C:\\dev\\projects\\pyrex\\conf\\sybase\\
composite_clean.sql
schemaInitializeScript=C:\\dev\\projects\\pyrex\\conf\\
\sybase\\
composite_data.sql

For security purpose, you can leave the value for databasePassword as asterisks in the property file. Later on, you can supply the real password in a command line. See Step 6.

6. Update the repository configuration.
   Supply the real password in a command line as follows:
   
   repo_util.bat -updateConfig -configFile repo.properties -
   databasePassword password (Windows)

   repo_util.sh -updateConfig -configFile repo.properties -
   databasePassword password (UNIX)

7. After the repository database configuration has been updated, restart Composite Server.
8. Verify that the repository database is running on the right Sybase repository database, as follows:

8.1 Run `repo_util` command with `-listConfig` option.

8.2 Open `cs_server.log` in the `logs` directory of Composite installation directory. You should see server information similar to the following:

```
INFO 2006-03-15 16:07:37.189 -0800 RepositoryImpl - Using Sybase database on host localhost:4100
INFO 2006-03-15 16:07:45.621 -0800 RepositoryImpl - GC deleted 0 objects in 8416 ms.
INFO 2006-03-15 16:08:40.079 -0800 SybaseRepository - Sybase database has total size of 1000.0 MB
INFO 2006-03-15 16:08:40.079 -0800 SybaseRepository - The total amount of space used by data and indexes in Sybase database is 163790 KB
```
Chapter 10

Setting Up a MySQL Repository

This chapter describes the steps to follow if you want to use an external repository database as the Composite metadata repository.

Topics covered in this chapter:

- “System Requirements for Using MySQL with CIS” on page 299
- “Configuring a MySQL Repository Database” on page 300
- “Configuring Composite Server for a MySQL Repository Database” on page 301
Chapter 10  Setting Up a MySQL Repository

System Requirements for Using MySQL with CIS

This section describes the requirements for using MySQL as the database repository for CIS.

MySQL Version Support

The currently supported version of Sybase for use as a repository database is MySQL 4.1.

MySQL Repository Size Recommendations

Composite recommends the following sizes for the database repository:

<table>
<thead>
<tr>
<th>Repository Type</th>
<th>Allocate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small-sized repository database</td>
<td>250MB</td>
</tr>
<tr>
<td>Medium-sized repository database</td>
<td>800MB</td>
</tr>
<tr>
<td>Large-sized repository database</td>
<td>2000MB (or 2GB)</td>
</tr>
</tbody>
</table>

MySQL Repository Configuration Requirements

There are two tasks you must perform to use a MySQL database as the CIS repository:

1. Configure the MySQL repository database.
2. Configure CIS to work with MySQL.

Each of these tasks is described in this chapter.
## Configuring a MySQL Repository Database

This section describes how to set up an external MySQL repository to work with Composite Server.

**To configure an external MySQL repository database**

1. Set the following variables in the `my.ini` file that MySQL system uses for initialization:
   ```
   set-variable=max_connections=100
   set-variable=lower_case_table_names=1
   set-variable=max_allowed_packet=16M
   default-character-set=utf8
   ```
   If you modify the `my.ini` file to match the required settings, you need to restart the MySQL server for the new settings to be effective.

2. The program MySQL Administrator can be used to set/change MySQL’s startup variables.
   2.1 Enable Use concurrent inserts in MyISAM parameters.
   2.2 Enable Activate InnoDB in InnoDB parameters.
Configuring Composite Server for a MySQL Repository Database

After installing Composite, you can use the command line program `repo_util` to list the configurations of the current repository database or modify the configuration for the existing repository database or change the repository database.

The `repo_util` program (`repo_util.bat` for Windows; `repo_util.sh` for UNIX) is available in the bin directory of Composite installation directory.

To change the MySQL repository configuration after installing CIS

1. Stop Composite Server, if it is running.
2. List the current repository configuration, run `repo_util` with the following option:
   ```
   repo_util.bat -listConfig (Windows)
   repo_util.sh -listConfig (UNIX)
   ```

The following is the display of a sample configuration for a MySQL repository:

```
Repository Database Configuration:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>connectionUrl</td>
<td>jdbc:mysql://localhost:3306/cs030801?continueBatchOnErr</td>
</tr>
<tr>
<td></td>
<td>or=false&amp;useUnicode=true&amp;characterEncoding=utf8&amp;clobber</td>
</tr>
<tr>
<td></td>
<td>StreamingResults=true&amp;useReadAheadInput=true</td>
</tr>
<tr>
<td>databaseCatalog</td>
<td>[not set]</td>
</tr>
<tr>
<td>databaseHost</td>
<td>localhost</td>
</tr>
<tr>
<td>databaseName</td>
<td>cs040001</td>
</tr>
<tr>
<td>databasePassword</td>
<td>[not shown]</td>
</tr>
<tr>
<td>databaseHost</td>
<td>3306</td>
</tr>
<tr>
<td>databaseSchema</td>
<td>[not set]</td>
</tr>
<tr>
<td>databaseUser</td>
<td>composite</td>
</tr>
</tbody>
</table>
```
3. Export the current configurations into a property file (here, repo.properties), using the following command:
   repo_util.bat -exportConfig > repo.properties (Windows)
   repo_util.sh -exportConfig > repo.properties (UNIX)

4. Modify the property file to user proper MySQL configurations, as follows, without changing the values rendered in **bold** type.

```properties
# Composite server repository configuration
# Generated on user.composite.com at Mar 15, 2006 2:44:03 PM
#
driverClass=com.mysql.jdbc.Driver
driverClassPath=C:\mysql-connector-java-3_1_10_1-bin.jar
driverName=MySQL 4.1
driverType=MySql
poolInitialSize=5
poolMaxSize=50
poolMinSize=25
repositoryClass=com.compositesw.server.repository.internal.MySQLRepository
schemaCreateScript=C:\mysql_repo\composite_schema.sql
schemaDropScript=C:\mysql_repo\composite_clean.sql
schemaInitializeScript=C:\mysql_repo\composite_data.sql
connectionUrl=jdbc:mysql://otherhost:3306/otherdatabase
continueBatchOnError=false
useUnicode=true
characterEncoding=utf8
useReadAheadInput=true
clobberStreamingResults=true
databaseCatalog=databaseHost=otherhost
databaseName=otherdatabase
databasePassword=************
databasePort=3306
databaseSchema=databaseUser=otherlogin
driverClass=com.mysql.jdbc.Driver
```
Chapter 10  Setting Up a MySQL Repository

For security purpose, you can leave the value for databasePassword as asterisks in the property file. Later on, you can supply the real password in a command line. See Step 5.

5. Update the repository configuration.

Supply the real password in a command line as follows:

repo_util.bat -updateConfig -configFile repo.properties -databasePassword password (Windows)
repo_util.sh -updateConfig -configFile repo.properties -databasePassword password (UNIX)

6. After the repository database configuration has been updated, restart Composite Server.

7. Verify that the repository database is running on the right MySQL repository database, as follows:

7.1 Run repo_util command with -listConfig option.

7.2 Open cs_server.log in the logs directory of Composite installation directory. You should see server information similar to the following:

Appendix A

SNMP Traps

The Composite system supports SNMP v1 traps. This appendix provides a complete list of events and their corresponding SNMP traps. Composite Server generates traps for monitoring the events that occur in the server.

➡️ For an MIB definition of the SNMP traps supported in Composite, refer to the MIB file available in the product installation directory at:

<installation directory>/apps/server/CompositeSoftware-MIB.mib

See the section “Server Event Attributes” on page 188 in the chapter System Monitoring with the Manager for more information.
SNMP Log Settings in Composite Studio

You can modify SNMP log settings from the Configuration window in the Studio. You can open the Configuration window by selecting the Administration > Configuration menu option, and navigating to the SNMP folder, as shown in the next screen.
SNMP Details

The SNMP details in the tables below are grouped into these categories:

- Monitor and server events
- Requests
- Transactions
- Cached resources
- Triggers
- Data Sources
- Sessions
- Resources
- Storage

Table 12. SNMP Details for Monitor and Server Events

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name for the Event</th>
<th>Description</th>
</tr>
</thead>
</table>
| 10000   | csMonitorStart           | Variables: [ trapTime, trapServerHostName, trapServerPort ]  
Description: "This trap is generated when a Composite Information Server Monitor was started." |
| 10001   | csMonitorStop            | Variables: [ trapTime, trapServerHostName, trapServerPort ]  
Description: "This trap is generated when a Composite Information Server Monitor was stopped." |
### Table 12. SNMP Details for Monitor and Server Events

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name for the Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10002</td>
<td>csMonitorFail</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } Description: “This trap is generated when a Composite Information Server Monitor had a failure.”</td>
</tr>
<tr>
<td>10003</td>
<td>csServerStopUnplanned</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } Description: “This trap is generated when a Composite Information Server had an unplanned stop.”</td>
</tr>
<tr>
<td>10004</td>
<td>csServerStopPlanned</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } Description: “This trap is generated when a Composite Information Server had a planned stop.”</td>
</tr>
<tr>
<td>10005</td>
<td>csServerRestart</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } Description: “This trap is generated when a Composite Information Server was restarted.”</td>
</tr>
<tr>
<td>10006</td>
<td>csServerRestartFail</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } Description: “This trap is generated when a Composite Information Server had a restart failure.”</td>
</tr>
<tr>
<td>10007</td>
<td>csRepositoryUp</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } Description: “This trap is generated when a Composite Information Server Repository was started.”</td>
</tr>
<tr>
<td>10008</td>
<td>csRepositoryDown</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } Description: “This trap is generated when a Composite Information Server Repository was stopped.”</td>
</tr>
</tbody>
</table>
## SNMP Traps

### Server Events

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name for the Event</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20000   | csServerStart            | Variables: { trapTime, trapServerHostName, trapServerPort }  
|         |                          | Description: "This trap is generated when a Composite Information Server was started." |
| 20001   | csServerStop             | Variables: { trapTime, trapServerHostName, trapServerPort }  
|         |                          | Description: "This trap is generated when a Composite Information Server was stopped." |
| 20002   | csUserCreate             | Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapDomainName }  
|         |                          | Description: "This trap is generated when a user was created in a domain." |
| 20003   | csGroupCreate            | Variables: { trapTime, trapServerHostName, trapServerPort, trapGroupName, trapDomainName }  
|         |                          | Description: "This trap is generated when a group was created in a domain." |
| 20004   | csUserDelete             | Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapDomainName }  
|         |                          | Description: "This trap is generated when a user was deleted from a domain." |
| 20005   | csGroupDelete            | Variables: { trapTime, trapServerHostName, trapServerPort, trapGroupName, trapDomainName }  
|         |                          | Description: "This trap is generated when a group was deleted from a domain." |
### Table 12. SNMP Details for Monitor and Server Events

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name for the Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20006</td>
<td>csUserAddToGroup</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapUserDomainName, trapGroupName, trapGroupDomainName } &lt;br&gt; Description: &quot;This trap is generated when a user was added to a group.&quot;</td>
</tr>
<tr>
<td>20007</td>
<td>csUserRemoveFromGroup</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapUserDomainName, trapGroupName, trapGroupDomainName } &lt;br&gt; Description: &quot;This trap is generated when a user was removed from a group.&quot;</td>
</tr>
<tr>
<td>20008</td>
<td>csDomainCreate</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapDomainName } &lt;br&gt; Description: &quot;This trap is generated when a domain was created.&quot;</td>
</tr>
<tr>
<td>20009</td>
<td>csDomainDelete</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapDomainName } &lt;br&gt; Description: &quot;This trap is generated when a domain was deleted.&quot;</td>
</tr>
<tr>
<td>20010</td>
<td>csUserPasswordModify</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapDomainName } &lt;br&gt; Description: &quot;This trap is generated when a user password was modified.&quot;</td>
</tr>
</tbody>
</table>
### Table 13. SNMP Details for Requests

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20100   | csRequestStart        | Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapOptionalRequestParameter1, trapOptionalRequestParameter2, trapOptionalRequestParameter3, trapOptionalRequestParameter4 }  
|         |                       | Description: "This trap is generated when a request was started."      |
| 20101   | csRequestWait         | Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapTransactionId, trapSessionId }  
|         |                       | Description: "This trap is generated when a request was waiting to run." |
| 20102   | csRequestEnd          | Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapTransactionId, trapSessionId }  
|         |                       | Description: "This trap is generated when a request was completed."     |
| 20103   | csRequestFail         | Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapOptionalRequestParameter1, trapOptionalRequestParameter2, trapOptionalRequestParameter3 }  
|         |                       | Description: "This trap is generated when a request has failed."        |
### Table 13. SNMP Details for Requests

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20104</td>
<td>csRequestCancel</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapTransactionId, trapSessionId } Description: “This trap is generated when a request was cancelled.”</td>
</tr>
<tr>
<td>20105</td>
<td>csRequestWaitQueueThresholdPass</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapTransactionId, trapSessionId } Description: “This trap is generated when a request passed the wait queue threshold.”</td>
</tr>
<tr>
<td>20106</td>
<td>csRequestWaitQueueThresholdReset</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapTransactionId, trapSessionId } Description: “This trap is generated when a request reset the wait queue threshold.”</td>
</tr>
<tr>
<td>20107</td>
<td>csPreparedStatementSuccess</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapRequestId, trapTransactionId, trapOptionalRequestParameter1, trapOptionalRequestParameter2 } Description: “This trap is generated when a prepared statement was successfully executed.”</td>
</tr>
<tr>
<td>20108</td>
<td>csPreparedStatementFail</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapTransactionId, trapSqlQuery, trapOptionalRequestParameter1, trapOptionalRequestParameter2 } Description: “This trap is generated when a prepared statement has failed during execution.”</td>
</tr>
</tbody>
</table>
## Table 14. SNMP Details for Transactions

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Variables:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20200</td>
<td>csTransactionStart</td>
<td>{ trapTime, trapServerHostName, trapServerPort, trapTransactionId, trapSessionId }</td>
<td>&quot;This trap is generated when a transaction was started.&quot;</td>
</tr>
<tr>
<td>20201</td>
<td>csTransactionCommit</td>
<td>{ trapTime, trapServerHostName, trapServerPort, trapTransactionId, trapSessionId }</td>
<td>&quot;This trap is generated when a transaction was committed.&quot;</td>
</tr>
<tr>
<td>20202</td>
<td>csTransactionFail</td>
<td>{ trapTime, trapServerHostName, trapServerPort, trapTransactionId, trapMessage, trapStackTrace, trapSessionId }</td>
<td>&quot;This trap is generated when a transaction has failed.&quot;</td>
</tr>
<tr>
<td>20203</td>
<td>csTransactionRollBack</td>
<td>{ trapTime, trapServerHostName, trapServerPort, trapTransactionId, trapSessionId }</td>
<td>&quot;This trap is generated when a transaction was rolled back.&quot;</td>
</tr>
<tr>
<td>20204</td>
<td>csTransactionCompensate</td>
<td>{ trapTime, trapServerHostName, trapServerPort, trapTransactionId, trapMessage, trapSessionId }</td>
<td>&quot;This trap is generated when a transaction was compensated for.&quot;</td>
</tr>
</tbody>
</table>
### Table 15. SNMP Details for Cached Resources

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20300</td>
<td>csCacheEnable</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapCacheName }</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description: &quot;This trap is generated when a cache was enabled.&quot;</td>
</tr>
<tr>
<td>20301</td>
<td>csCacheDisable</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapCacheName }</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description: &quot;This trap is generated when a cache was disabled.&quot;</td>
</tr>
<tr>
<td>20302</td>
<td>csCacheClear</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapCacheName, trapCacheParameters }</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description: &quot;This trap is generated when a cache was cleared.&quot;</td>
</tr>
<tr>
<td>20303</td>
<td>csCacheRefreshStart</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapCacheName, trapCacheParameters }</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description: &quot;This trap is generated when a cache refresh was started.&quot;</td>
</tr>
<tr>
<td>20304</td>
<td>csCacheRefreshEnd</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapCacheName, trapCacheParameters }</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description: &quot;This trap is generated when a cache refresh was completed.&quot;</td>
</tr>
<tr>
<td>20305</td>
<td>csCacheRefreshFail</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapCacheName, trapCacheParameters, trapOptionalMessage }</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description: &quot;This trap is generated when a cache refresh has failed.&quot;</td>
</tr>
</tbody>
</table>
### Table 16. SNMP Details for Triggers

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20400   | csTriggerStart  | Variables: [ trapTime, trapServerHostName, trapServerPort, trapTriggerName, trapTriggerType, trapTriggerAction ]  
          |                  | Description: “This trap is generated when a trigger was started.”         |
| 20401   | csTriggerEnd    | Variables: [ trapTime, trapServerHostName, trapServerPort, trapTriggerName, trapTriggerType, trapTriggerAction ]  
          |                  | Description: “This trap is generated when a trigger was completed.”        |
| 20402   | csTriggerFail   | Variables: [ trapTime, trapServerHostName, trapServerPort, trapTriggerName, trapTriggerType, trapTriggerAction, trapOptionalMessage ]  
          |                  | Description: “This trap is generated when a trigger has failed.”           |

### Table 17. SNMP Details for Data Sources

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20500   | csDataSourceOn  | Variables: [ trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType ]  
          |                  | Description: “This trap is generated when a data source is enabled.”       |
| 20501   | csDataSourceOff | Variables: [ trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType ]  
          |                  | Description: “This trap is generated when a data source is disabled.”      |
### SNMP Details for Data Sources

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20502   | csDataSourceUp        | Variables: [trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType]  
Description: “This trap is generated when a data source was started.” |
| 20503   | csDataSourceDown      | Variables: [trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType]  
Description: “This trap is generated when a data source was stopped.” |
| 20504   | csDataSourceModify    | Variables: [trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType]  
Description: “This trap is generated when a data source was modified.” |
| 20505   | csIntrospectStart     | Variables: [trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType]  
Description: “This trap is generated when a data source introspection was started.” |
| 20506   | csIntrospectEnd       | Variables: [trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType, trapDataSourceReport]  
Description: “This trap is generated when a data source introspection was completed.” |
| 20507   | csIntrospectCancel    | Variables: [trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType]  
Description: “This trap is generated when a data source introspection was cancelled.” |
## Appendix A  SNMP Traps

### Table 17. SNMP Details for Data Sources

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20508   | csIntrospectFail       | Variables: [ trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType, trapMessage ]  
|         |                         | Description: “This trap is generated when a data source introspection has failed.”                                                          |
| 20509   | csTestStart             | Variables: [ trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType ]                                      |
|         |                         | Description: “This trap is generated when a data source test was started.”                                                                 |
| 20510   | csTestSuccess           | Variables: [ trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType ]                                      |
|         |                         | Description: “This trap is generated when a data source test was successful.”                                                               |
| 20511   | csTestFail              | Variables: [ trapTime, trapServerHostName, trapServerPort, trapDataSourceName, trapDataSourceType ]                                      |
|         |                         | Description: “This trap is generated when a data source test has failed.”                                                                    |
| 20512   | csConnPoolSizeIncrease  | Variables: [ trapTime, trapServerHostName, trapServerPort, trapConnectionPoolId ]                                                           |
|         |                         | Description: “This trap is generated when the size of a connection pool has increased.”                                                      |
| 20513   | csConnPoolSizeDecrease  | Variables: [ trapTime, trapServerHostName, trapServerPort, trapConnectionPoolId ]                                                           |
|         |                         | Description: “This trap is generated when the size of a connection pool has decreased.”                                                      |
Table 17. SNMP Details for Data Sources

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20514</td>
<td>csConnCheckOut</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapConnectionPoolId } Description: &quot;This trap is generated when a connection was checked out a connection pool.&quot;</td>
</tr>
<tr>
<td>20515</td>
<td>csConnCheckIn</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapConnectionPoolId } Description: &quot;This trap is generated when a connection was checked in a connection pool.&quot;</td>
</tr>
<tr>
<td>20516</td>
<td>csConnInvalid</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapConnectionPoolId } Description: &quot;This trap is generated when a connection pool had an invalid connection.&quot;</td>
</tr>
<tr>
<td>20517</td>
<td>csConnFail</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapConnectionPoolId } Description: &quot;This trap is generated when a connection pool had a failed connection.&quot;</td>
</tr>
<tr>
<td>20518</td>
<td>csConnPoolExhaust</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapConnectionPoolId } Description: &quot;This trap is generated when a connection pool has exhausted its connections.&quot;</td>
</tr>
<tr>
<td>20519</td>
<td>csStatisticsProcessingStartProcess</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapDataSourcePath } Description: &quot;This trap is generated when a data source started the statistics processing process.&quot;</td>
</tr>
<tr>
<td>20520</td>
<td>csStatisticsProcessingComplete</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapDataSourcePath } Description: &quot;This trap is generated when a data source completed the statistics processing process.&quot;</td>
</tr>
</tbody>
</table>
### Table 17. SNMP Details for Data Sources

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20521</td>
<td>csStatisticsProcessingCompletePartial</td>
<td>This event/message is deprecated. Statistics processing with ID # is partially completed.</td>
</tr>
</tbody>
</table>
| 20522   | csStatisticsProcessingFailed     | Variables: [ trapTime, trapServerHostName, trapServerPort, trapDataSourcePath, trapMessage ]  
Description: "This trap is generated when a data source failed to complete the statistics processing process." |
| 20523   | csStatisticsProcessingUpdate     | This event/message is deprecated. Statistics processing with ID # updated the information. |

### Table 18. SNMP Details for Sessions

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20700   | csSessionLoginFail | Variables: [ trapTime, trapServerHostName, trapServerPort, trapUserName, trapDomainName ]  
Description: "This trap is generated when a session login has failed for a user." |
| 20701   | csSessionStart   | Variables: [ trapTime, trapServerHostName, trapServerPort, trapSessionId, trapUserName, trapDomainName ]  
Description: "This trap is generated when a session was started for a user." |
| 20702   | csSessionEnd    | Variables: [ trapTime, trapServerHostName, trapServerPort, trapSessionId, trapUserName, trapDomainName ]  
Description: "This trap is generated when a session was ended for a user." |
### Table 18. SNMP Details for Sessions

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20703</td>
<td>csSessionTerminate</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapSessionId, trapUserName, trapDomainName } Description: &quot;This trap is generated when a session was terminated for a user.&quot;</td>
</tr>
<tr>
<td>20705</td>
<td>csSessionMaxConnectionsExhaust</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapDomainName, trapHostId, trapLocalHostName, trapLocalHostIP } Description: &quot;This trap is generated when a session creation request was denied for a user.&quot;</td>
</tr>
</tbody>
</table>

### Table 19. SNMP Details for Resources

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20800</td>
<td>csResourceCreate</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapResourceName, trapDataSourcePath, trapResourceType } Description: &quot;This trap is generated when a resource was created.&quot;</td>
</tr>
<tr>
<td>20801</td>
<td>csResourceDelete</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapResourceName, trapDataSourcePath, trapResourceType } Description: &quot;This trap is generated when a resource was deleted.&quot;</td>
</tr>
<tr>
<td>20802</td>
<td>csStatisticsResourceProcessingStartProcess</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort, trapResourcePath } Description: &quot;This trap is generated when a resource started the statistics processing process.&quot;</td>
</tr>
<tr>
<td>SNMP ID</td>
<td>Short Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 20803   | csStatisticsResourceProcessingComplete     | Variables: { trapTime, trapServerHostName, trapServerPort, trapResourcePath }  
Description: “This trap is generated when a resource completed the statistics processing process.”   |
| 20804   | csStatisticsResourceProcessingFailed       | Variables: { trapTime, trapServerHostName, trapServerPort, trapResourcePath, trapMessage }  
Description: “This trap is generated when a resource failed to complete the statistics processing process.”   |
| 20805   | csResourceLock                             | Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapDomainName, trapLockTime, trapResourcePath, trapResourceType, trapResourceSubType }  
Description: “This trap is generated when a resource was locked.”  
Only the top-most parent node is reported as locked.   |
| 20806   | csResourceUnlock                           | Variables: { trapTime, trapServerHostName, trapServerPort, trapUserName, trapDomainName, trapUnlockTime, trapResourcePath, trapResourceType, trapResourceSubType, trapComment }  
Description: “This trap is generated when a resource was unlocked.”  
Only the top-most parent node is reported as unlocked.   |
### Table 20. SNMP Details for Storage

<table>
<thead>
<tr>
<th>SNMP ID</th>
<th>Short Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>21000</td>
<td>csStorageLowWarning</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } &lt;br&gt; Description: &quot;This trap is generated when a storage low warning has occurred on a machine.&quot;</td>
</tr>
<tr>
<td>21001</td>
<td>csStorageLowCritical</td>
<td>Variables: { trapTime, trapServerHostName, trapServerPort } &lt;br&gt; Description: &quot;This trap is generated when a storage low critical event has occurred on a machine.&quot;</td>
</tr>
</tbody>
</table>
Index

A
Access
Privilege Cache 136
Access (Hits/Accesses)
Manager Server Overview 136
Active Cluster
using LDAP 75
Active Requests
data sources 150
Active Server Requests 129
admin
group, composite domain 58
user 61
admin privileges
obtaining 65
administration
cache
changing schedule 145
enabling, changing 145
cache, clear 138
Cached Resources
Change Enabling button 140
Last Access 141
Last Fail Duration 143
Last Fail End 141
Last Refresh End 141
Allocated Pool Size
data sources 150
anonymous 61
Apply the change recursively, check box 69

B
backup_export 208
backup_import 208
buttons
enabling 114
Bytes summary
data sources 149

C
cache
changing schedule 145
enabling, changing 145
cache, clear 138
Cached Resources
Change Enabling button 140
Last Access 141
Last Fail Duration 143
Last Fail End 141
Last Refresh End 141
D

Last Success Duration 143
Last Success End 143
Owner 141
Owner domain 143
Path 143
Refresh Cache button 140
Status 140
Storage Used 141
Total Accesses 143
Total Failures 143
Total Successes 143
Type 141
Variant 141
CACHED RESOURCES page 139
CACHED RESOURCES table 140
cached views
refreshing 146
Capacity (Entries/Max)
Manager Server Overview 137
Change Enabling button 182
Changing a user’s password (or setting explicit user rights) 67
changing ownership 68
changing password 67
Changing your own password in Studio 67
CIS ports 128
Clear Repository Cache 138
composite 220
Composite Data Service log 198
composite domain
built-in groups 58
built-in users, privileges 61
group
adding 59
adding user 65
removing 60
user
adding 63
group membership 65
removing 64
Composite JDBC

driver, new, installing 17
Composite service files, removing 264
configuration settings
triggers 180
connection URL
JDBC
driver 8
Connection URL Pattern, field 19
contact information for Composite x
contents, of this book vii
conventions in this manual x
customer support x

D

data source
ODBC, adding 21
Data Source log 198
Data Sources
Active Requests 151
Schedule Test 153
Test All Now 152
data sources
drivers 8
editing 19
removing 19
Data Sources console 148
data update time interval 113
database repository
Oracle size recommendations 299
DB2 v7, DB2 v8, JDBC driver 10
DB2 v8 (type 2 or type 4) JDBC driver 10
DB2 z/OS, JDBC driver 10
DB2 z/OS v8 JDBC driver 10
digital certificate 6
documentation conventions x
documentation set ix
Driver Class Name 18
driverConfig, running 29
drivers
data sources 8
DSN, creating with driverConfig 29
dynamic domain
administration 101
enabling 101
group 103
add user 106
login 100
user 105
add 105
dynamic users
resources available 103

E
enabling buttons 114
End Sessions 169
environment variables
setting on UNIX and Linux 27
EVENT LOG table 190
events
and logs 194
exporting/importing
full server 208
resources
programs 208
Externalization 242
Import 259
pkg_export -pkgdir option 240
Externalized Directory
import 259

F
federated queries
single login 100
filter rules 117
Free Unused Memory 201

G
group
removing from domain 59
group privileges
managing 71
group rights templates 58

H
Hits
Privilege Cache Hits 136
HTTP base port 128

I
I/O Log graphs 197
Import
pkg_import 247
importing
rules 218, 257
importing/exporting
full server 208
indexes
with Sybase 283
information about rows 115
Informix 9.x JDBC driver 10
Informix, JDBC driver 10
Input Graph 197
install_services 223
installation log files 194

J
Java Key Store 6
Java Key Store (JKS) 6
Java keystore digital certificate
configuring 7
<table>
<thead>
<tr>
<th>N</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>memory, used</td>
<td>129, 134</td>
</tr>
<tr>
<td>metadata</td>
<td>exporting/importing programs 208</td>
</tr>
<tr>
<td>metadata names</td>
<td>limitation with Sybase 283</td>
</tr>
<tr>
<td>monitor</td>
<td>starting/stopping/restoring 220</td>
</tr>
<tr>
<td>monitor log files</td>
<td>196</td>
</tr>
<tr>
<td>MySQL repository database</td>
<td>300</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>cached resources 140</td>
</tr>
<tr>
<td>data sources</td>
<td>149</td>
</tr>
<tr>
<td>navigating rows</td>
<td>118</td>
</tr>
<tr>
<td>Netezza JDBC</td>
<td>driver 11</td>
</tr>
<tr>
<td>Netezza, installation of</td>
<td>driver 11</td>
</tr>
<tr>
<td>New Driver Information window</td>
<td>18</td>
</tr>
<tr>
<td>new privileges</td>
<td>when take effect 65</td>
</tr>
<tr>
<td>nobody user</td>
<td>68</td>
</tr>
<tr>
<td>nobody, user</td>
<td>61</td>
</tr>
<tr>
<td>nohup, for Telnet session</td>
<td>221</td>
</tr>
<tr>
<td>nohup, usage</td>
<td>220</td>
</tr>
<tr>
<td>number of rows displayed</td>
<td>118</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
<th>ODBC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composite driver</td>
<td>using on UNIX and Linux 27</td>
</tr>
<tr>
<td>using on Windows</td>
<td>21</td>
</tr>
<tr>
<td>data sources, adding</td>
<td>21</td>
</tr>
<tr>
<td>Oracle repository</td>
<td>size recommendations 299</td>
</tr>
<tr>
<td>Oracle repository database</td>
<td>271</td>
</tr>
<tr>
<td>Output Graph</td>
<td>197</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th>Package Export to a directory 240</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package Import</td>
<td>259</td>
</tr>
<tr>
<td>package import</td>
<td>247</td>
</tr>
<tr>
<td>page refresh rate</td>
<td>113</td>
</tr>
<tr>
<td>paging</td>
<td>44</td>
</tr>
<tr>
<td>pass-through login</td>
<td>100</td>
</tr>
<tr>
<td>performance profile, list</td>
<td>269</td>
</tr>
<tr>
<td>pkg_export</td>
<td>233, 242, 247</td>
</tr>
<tr>
<td>-pkgdir</td>
<td>232</td>
</tr>
<tr>
<td>-pkgfile</td>
<td>232</td>
</tr>
<tr>
<td>pkg_export, -pkgfile</td>
<td>232</td>
</tr>
<tr>
<td>pkg_import</td>
<td>247</td>
</tr>
<tr>
<td>usage</td>
<td>248, 259, 260</td>
</tr>
<tr>
<td>pkg_import-pkgdir</td>
<td>259</td>
</tr>
<tr>
<td>-pkgdir</td>
<td>240</td>
</tr>
<tr>
<td>Pool Size</td>
<td>data sources 150</td>
</tr>
<tr>
<td>Pool Utilization</td>
<td>data sources 150</td>
</tr>
<tr>
<td>privileges</td>
<td>changing 65</td>
</tr>
<tr>
<td>managing</td>
<td>71</td>
</tr>
<tr>
<td>Purge Completed Sessions</td>
<td>169</td>
</tr>
<tr>
<td>Purge Completed Transactions</td>
<td>176</td>
</tr>
<tr>
<td>purge frequency requests</td>
<td>159</td>
</tr>
<tr>
<td>sessions</td>
<td>168, 175</td>
</tr>
</tbody>
</table>

| Q | QUICK LINKS panel 131 |

<table>
<thead>
<tr>
<th>R</th>
<th>refresh rate 113</th>
</tr>
</thead>
<tbody>
<tr>
<td>refreshing</td>
<td>cached views 146</td>
</tr>
</tbody>
</table>
Remove an LDAP group 91
remove_services 264
Removing Users from the Composite Domain 64
repo_util 265
repo_util, usage syntax 265
Repository Cache 135, 136
repository database
changing 265
MySQL 300
Oracle 271
restart, automatically on UNIX 223
Sybase 282
Sybase version 281
Requests
Cache 166
Clear Plan Caches 159
Purge Completed Requests 160
Session Type 164
Waiting Requests 159, 169
Waiting Requests Threshold 159
requests
data source, total 130
purge period 159
requests
server, active 129
Requests console 157
Requests summary
data sources 149
REQUESTS table 160
Resource Lock
SNMP event description 321
resources
changing ownership 68
dynamic users 103
exporting/importing
programs 208
repository
starting/stopping/restarting 222
re-start server and repository, automatically on UNIX 223
row information 115
row navigation 118
row selection 114
rows
  number displayed 118
rules for table filters 117

secured JDBC/ODBC 6
security
  Java Key Store 6
server
  back-up
    from command line 208
  exporting/importing 208
  licensing 3
  performance profile, list 269
  restart, automatically on UNIX 223
  running as foreground process 221
  starting/stopping/restarting 220
  stopping and starting on Windows 222
SERVER INFO panel 128
server log files 196
Server Name 128, 133
Server Overview
  base port 133
  Clear Repository Cache 138
  Maximum Event Entries 135
  Maximum Viewable Events 134
  Privilege Cache 135, 136, 137
  Repository Cache 137
  Requests - active and total 136
  Server Name 133
  Sessions - active and total number 135
  Status 133
  Stop 138
  Total Data Source Requests 136
  Total Memory Used 134
  User Cache 137
Server Overview console 132
T

SERVER STATUS panel 130
server_util 269
Session Type
requests 161
Sessions 129
sessions
purge period 168, 175
Sessions console 167
SESSIONS table 169
Show Query Plan button 166
Show Row Details icon 115
sizes
Oracle repository 299
SNMP v1 traps 305
SQL Server 2000 JDBC driver 11
SQL Server 2000, JDBC driver 11
SQL Server 2005 JDBC driver 11
SQL Server 2005, JDBC driver 11
SSL communication 6
SSL management page 7
Status
data sources 150
server 133
Status summary
data sources 148
Studio log files 196
support for customers x
Sybase ASE 12.5 281
Sybase limitations 283
Sybase repository database 282
system
events and logs 194
Manager
using 121
monitoring 109
user 61

T

table filter rules 117
technical support  x
Teradata JDBC driver 12
terminate a session 169
TestAllDataSources trigger 181
timing
changes to users  67
Total Data Source Requests 130
Total Memory Used 129, 134
Total Requests
data sources 150
trailing spaces, setting 52
Transactions 130
Studio Manager 179
TRANSACTIIONS page 174
Triggers console 184
TRIGGERS page 180
Type
data source 150

uninstallation log files 194
UNIX
log files 194
upgrading page data 113
User Cache 135, 136
user nobody 68
user privileges
managing 73
user rights profile changes 67
users
adding
composite domain 63
group 65
membership, group 65
removing
composite domain 64
V
viewing LDAP groups  91

W
Windows
log files  194

X
X.509 digital certificate  6